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ASG Support Numbers

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during normal
business hours and emergency support during non-business hours. To expedite response time,
please follow these procedures.

Please have this information ready:

. Product name, version number, and release number
J List of any fixes currently applied
. Any alphanumeric error codes or messages written precisely or displayed

. A description of the specific steps that immediately preceded the problem

o The severity code (ASG Support uses an escalated severity system to prioritize service to
our clients. The severity codes and their meanings are listed below.)

. Verify whether you received an ASG Service Pack for this product. It may include
information to help you resolve questions regarding installation of this ASG product. The
Service Pack instructions are in a text file on the distribution media included with the
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem.

2 Leave a detailed message including your name and phone number. A Support representative
will be paged and will return your call as soon as possible.

3 Please have the information described above ready for when you are contacted by the Support
representative.

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response
Time
1 Production down, Within 30 minutes

critical situation
2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours
work-around solution

4 "How-to" questions and enhancement Within 4 hours
requests

ASG provides software products that run in a number of third-party vendor environments. Support
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor
discontinues support for a hardware and/or software product, ASG cannot be held responsible for
problems arising from the use of that unsupported version.



Business Hours Support

Your Location

Phone

Fax

E-mail

United States and
Canada

Australia
England
France
Germany

Singapore

All other countries:

800.354.3578

61.2.9460.0411
44.1727.736305
33.141.028590
49.89.45716.222
65.332.2922

1.941.435.2200

941.263.2883

61.2.9460.0280
44.1727.812018
33.141.028589
49.89.45716.400
65.337.7228

Non-Business Hours - Emergency Support

Your Location

Phone

Your Location

support@asg.com

support.au@asg.com
support.uk@asg.com
support.fr@asg.com

support.de@asg.com

support.sg@asg.com

support@asg.com

Phone

United States and
Canada

Asia
Australia
Denmark
France
Germany
Hong Kong
Ireland
Israel/Bezeq
Japan/IDC

800.354.3578

65.332.2922
0011.800.9932.5536
00.800.9932.5536
00.800.3354.3578
00.800.3354.3578
001.800.9932.5536
00.800.9932.5536
014.800.9932.5536
0061.800.9932.5536

Japan/Telecom
Netherlands
New Zealand
Singapore
South Korea
Sweden/Telia
Switzerland
Thailand

United Kingdom

All other countries

0041.800.9932.5536
00.800.3354.3578
00.800.9932.5536
001.800.3354.3578
001.800.9932.5536
009.800.9932.5536
00.800.9932.5536
001.800.9932.5536
00.800.3354.3578

1.941.435.2200



ASG Web Site

Visit http://www.asg.com, ASG’s World Wide Web site.

Submit all product and documentation suggestions to ASG’s product management team at
http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at (941)
263-3692. Please include your name, company, work phone, e-mail ID, and the name of the ASG
product you are using. For documentation suggestions include the publication number located on
the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp
http://www.asg.com
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Preface

This ASG-Alliance User’s Guide instructs you in the use of ASG-Alliance (herein called
Alliance). Alliance is the ASG-Existing Systems Workbench component that provides
you with complete application-wide understanding, documentation, impact analysis, and
change request assessment to help you effectively manage and maintain existing
applications. Alliance allows you to quickly and accurately perform application analysis
tasks. It is an accurate tool you can use to assess the resources required for application
changes along with the impact of proposed system changes and failures.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical

support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

. Chapter 1, "Overview: The Alliance Process," reviews the concepts of Alliance.

. Chapter 2, "Getting Started," describes how to initiate a session and validate user
options.

. Chapter 3, "Discovering the Nature of the Application," gives instructions on how
to use the Query and Search facilities and describes synonym and homonym
relationships.

. Chapter 4, "Using the Query Facility," provides instructions on how to perform
queries and searches.

. Chapter 5, "Determining Impacted Components," describes the relational
assessment process, hierarchical relationships, referential symbols and default

information display options, and instructions on generating both summary and
detailed impact analyses.

. Chapter 6, "Modifying the Impact Analysis," discusses the impact generate options,
and gives instructions on how to generate impact options and work with impact
lists.




ASG-Alliance User’s Guide

Related Publications

vi

The documentation library for ASG-Alliance consists of these publications (where nn
represents the product version number):

o ASG-Application Definition and Analysis User’s Guide (ALL0200-nn) which
provides information on defining, analyzing, and refining the application definition.

. ASG-Alliance Installation Guide (ALX0300-nn) which provides information about
installing ASG-Alliance.

o ASG-Alliance User’s Guide (ALX0200-nn) which provides information on the use
of ASG-Alliance.

. ASG-Center Installation Guide (CNX0300-nn) which contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-Existing Systems Workbench suite of products.

Note:

To obtain a specific version of a publication, contact the ASG Service Desk.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

HI ASG-Insight for Program Understanding |

HI ASG-Estimate for Resource Estimation |

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
-TSO
-CICs

ASG-Center - IMS

- ASM

- APS

- PLI

-TCA

- DB2 Stored Procedure

N H ASG-SmartDoc for Program Documentation |
Application

Knowledge
Repository (AKR)

%| ASG-Recap for Portfolio Analysis |

HI ASG-Alliance for Application Understanding |

%I ASG-Encore |

HI ASG-AutoChange |

€} ASG-Bridge |

vii
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viii

This table contains the name and description of each ESW component:

ESW Product

ASG-Alliance

Herein Called

Alliance

Description

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.
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ESW Product Herein Called  Description

ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

X
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page xi for more information about
using ESW.
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Product Name Shortcut  ESW Pull-down Options
Alliance AL Understand » Application
AutoChange CcC Change P Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Re-engineer) EN Re-engineer » Program
Estimate ES Measure P ASG-Estimate
Insight (Understand) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Document) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartTest ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly or through the main ESW screen. As a result, you might see different
fields, values, action bar options, and pull-down options on a screen or pop-up depending
on how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed. Access to these integrated products requires only that they be installed and
executed in the same libraries.

xi
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Examples

Example 1. Figure 2 shows the Encore Primary screen that displays when you access
Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

AEG-Encare
CoHHand ===
etttk e e Wbtk
Aotk debookk dobolelolk ebototck
eddoth eddotk dehdettck  tedetokk Hefok
oot oot debtsok etttk Hepok
Hefototok
etk

Copykight Allen Swsteds Graup, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Uizit the ASG Zupport Web fite at www.asg.cod

Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 « ESW Encore Primary Screen

File UView Edtract Generate Search Logic List Options Help

ASE-EIN - Prograd Re—engineering

CoHHand ===
Aottt Hetebbt bbb Aottt
Aettsick desteik etttk etetotek:
Aottt Aottt Hebetebbt bbbk Hebek
Aottt Aottt debebbebk bbbk Hebek
Atk
Aotk

Copyright Allen Systeds Group, Inc., an unpublished wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensess.
Visit the ASE Support Web Zite at wuw,asg.cod

Xii
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Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays
when you access SmartTest through ESW.

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4. This field is automatically customized to contain the ESW products
you have installed on your system.

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc
Options) is available on the File - Analyze Submit screen if the SmartDoc product is
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 « File - Analyze Submit Screen

File - Analyze SUbHiT
CorAdand ===

E - Edit JCL 2 - EUbHIit JCL

CoMpile and link JoL (PDE or sequential):
Data set nane 'USER1Z2.REL.CGHNTL{VIAPCOBC)

Analyze features [v-M]i
REG—EMartTests ¥ Extended Analy=isl M

AKR data set naWe 'USER1Z2, GEMERAL.AKR’
AKR prograd nade [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y<H] o« v o« v o o o o T [¥ if needad by features)
Link l1oad Hodule reusable® [Y-M] T

Figure S« File - Analyze Submit Screen (Accessed through ESW)

File - Analwze ZubHit
CoHHand ===

E - Edit JCL ¥ - EubMiT JOL 0 - A%E-EnartDoc Options

CoHpile and link JCL [PDS or sequentiall:
Data sef nade 'USER1Z2.REL.CNTLIHTEST)

Analyze features [Y-M]:
AEG-In=sights T AEG-EHartTestl I Exdtended Analwsi=l N
AEG-ERarthoc: N AEG-Encores N

AKR data =set naHe 'UZERL1Z.GEMERAL.AKR’

AKR prograd nade [if owverriding PROGRAA-I0]

Analyze options:

CoHpile? (YNl « o o« o &« & & & & T [ if needed by features)
Link l1oad Hodule reusable® [veM] T [ASG-5HartTest
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Publication Conventions

Xiv

ASG uses these conventions in technical publications:

Convention Represents

ALL CAPITALS

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Initial Capitals on Each Word

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

lowercase italic

Information that you provide according to your

monospace particular situation. For example, you would replace
f1ilename with the actual name of the file.
Monospace Characters you must type exactly as they are shown.

Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Vertical Separator Bar (| )
with underline

Options available with the default value underlined
(e.g. YIN).




Overview: The Alliance Process

This chapter presents an overview of Alliance in these sections:

About Alliance 1
Step 1 - Assessing Your Task 4
Defining Your Requirements 4
Step 2 - Defining the Application 4
Step 3 - Analyzing and Refining 5
Step 4 - Discovering the Nature of the Application 8
Step 5 - Running Queries or Using the Query Facility 10
Step 6 - Determining Impacted Components 11
Step 7 - Evaluating Components 13
Step 8 - Using Impact Analysis Results to Implement Change Request 14

About Alliance

Alliance assesses the impact of change upon your application and gives you accurate
information to help you determine the resources required. With Alliance, you have an
automated, interactive tool you can use to analyze and understand the nature and
relationships of application components.

[
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These are some of the benefits of using Alliance for your maintenance requirements:

Increased expediency. Increased expediency in modifying your application. After
you define and analyze the application, Alliance enables you to spend less time manually
determining the scope of a maintenance task.

Saved resources. Alliance saves resources in helping you determine how large the
requirement is. You no longer need to deploy an entire team to assess the task at hand.

Reduced errors. The potential of human error is reduced. With impact analysis results
generated by Alliance, you work from reliable data. As a result, the possibility of a
system failure when the change is rolled into a production environment is minimized.

Increased application information. The application information analysis results
Alliance provides gives you valuable maintenance tools for the application life cycle.
Reuse this base of information to expedite future change requests.

Enhanced understanding of application components. The analysis information
generated by Alliance, based on your application definition, provides a complete
understanding of the components that comprise your applications and the nature of the
relationships between those components.

The Alliance process is relatively simple. Nevertheless, ASG recommends you use the
default options until you can anticipate the result of changing those values. Altering
default settings can make these procedures unnecessarily time- and resource-intensive.

As illustrated in Figure 6 on page 3, you can outline the process in eight steps. These
guidelines facilitate your understanding of Alliance. This publication gives detailed
instructions on performing each step in subsequent chapters, referenced under each
heading. The ASG-Application Definition and Analysis User’s Guide discusses the first
three steps in the Alliance process in full detail.




Figure 6 « Alliance Process Out

line
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Step 1 - Assessing Your Task

At this stage, define the assigned task and determine the affected applications and
components.

Defining Your Requirements

Identify the change and impact upon the application involved. For example, you can
determine what components of the Manufacturing application are affected by Euro
conversion processing, and use that information to develop a project plan for conversion.

For step-by-step instructions, see the ASG-Application Definition and Analysis User’s
Guide.

Gathering Information About Related Application Components

Begin gathering the information needed to define the application to Alliance. This is an
iterative process. Record information about the application components and organize this
information using a series of worksheets. Copy and fill out the series of worksheets as
needed to begin the application definition process. See the ASG-Application Definition
and Analysis User’s Guide for more information.

For step-by-step instructions, see the ASG-Application Definition and Analysis User’s
Guide.

Step 2 - Defining the Application

At this stage, you create the initial application definition. First, allocate repository space
for data storage. This is called the Application Knowledge Repository (AKR). Then,
define the information gathered about the application to Alliance. This collection of
information establishes the application boundaries. Alliance identifies the components
you have targeted for assessment and generates the impact results within these
boundaries.

Allocating Your AKR

The AKR is the repository for all of the information used by the ESW family of
components. The ESW provides you with both online and batch utilities for managing the
AKR. You can allocate a new AKR, or use an existing one. Each AKR can contain
multiple applications, or you can allocate separate AKRs for each application.
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An application is a group of programs and associated components that accomplishes a
particular function. You can group all of the applications used by a business unit within
an AKR. For example, typical applications within an accounting AKR could include
Accounts Payable, Accounts Receivable, General Ledger, Fixed Assets, Inventory, and
Purchasing. You might need to allocate an AKR for each major business unit in your
company (for example, manufacturing, accounting, sales) for management convenience.

When the AKR is allocated, start defining your application to Alliance.

For step-by-step instructions, see "Allocating the AKR" on page 195.

Establishing Application Boundaries

To establish the application boundaries, build an inventory of related programs and
associated component definitions, called an application definition. From this inventory,
Alliance executes the analysis needed to understand the components that make up the
application and the relationships between application components. You can create a new
application definition or open an existing one, since application definitions are reusable.
You can also import an application definition from text files.

When you create the application definition within the AKR, specify the libraries and
members Alliance includes in its application analysis (Program Source, Load Module,
JCL, CICS, and IMS). You can also specify attributes for each library and member in the
definition. For example, add analysis parameters, copy libraries, procedure libraries,
macro libraries, and CA-IDMS information. If a library contains multiple categories of
members (for example, PROGRAM and INCLUDE members), you must define the
library separately for each category.

For step-by-step instructions, see the ASG-Application Definition and Analysis User’s
Guide.

Step 3 - Analyzing and Refining

At this stage, you analyze and refine the application definition. Building an application
definition is an iterative process. You run the analysis, review the results, make
modifications, and run the analysis again until you reach an accurate application
definition.

When the Alliance Application Analytical Engine (AAE) analyzes the items in the
application definition, it determines the application components and their relationships.
The AAE also generates information about the definition. The first part of this
information contains statistics and diagnostics about the components that were analyzed.
The second organizes the analyzed components into three types: dead, discovered, and
missing. You can use both sources to refine the application definition throughout the
iterative process of defining an application.
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With each analyze job, Alliance produces a summary report of analysis statistics and
diagnostic messages called the VIAARPT. This report helps you to understand how the
job ran, specifies the return code from the individual analysis of each member, and
identifies analysis errors (for example, you might forget to define a copy library or miss a
syntactic error). This file is temporary and is not stored in the AKR.

Alliance identifies discovered, missing, or dead application entities inside your
application. With each analyze job, you assess these components to determine their
validity. This verifies the accuracy of the collected data and allows you to discover
unaccounted aspects in the application.

Analyzing the Application

The analysis of your application is generated from the inventory of application
components specified in your application definition. Alliance performs three types of
analysis: a full analysis, an incremental analysis, and an auto analysis.The full analysis
analyzes every member in the application at one time, and may require a large amount of
resources. The incremental analysis analyzes only the members you select and is less
resource-intensive. The incremental analysis allows you to perform your application
analysis in phases to alleviate heavy resource demands. The auto-analysis is similar to an
incremental analysis except the analyzer selects the members that need to be analyzed.
This analysis selects the members that you did not analyze that either contain bad return
codes or that you modified since the last analysis. You must completely analyze an
application to obtain accurate results from an impact analysis. An analyze resource
estimate table is located in the ASG-Application Definition and Analysis User’s Guide.

Semantic linking is the last step in the application process, a process that determines how
the application components relate to each other. Semantic linking can be a
resource-intensive phase of the analyze job, and must be done before you can use the
AKR for impact assessment.

If you want to analyze a large application and lack the resources to run a full analysis,
disable the semantic linking option and perform an incremental analyses on sections of
your application while you refine your application definition. This is the analysis process
(the same as analyzing the entire application):

. Submit the selected components for analysis
. Review the results
. Modify the application definition

. Resubmit as necessary

After creating an accurate application definition and analyzing all the components in the
application, enable the semantic linking option and run an analysis.

For more information on application analysis, see the ASG-Application Definition and
Analysis User’s Guide.
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Resolving Analysis Errors

Occasionally, lack of CPU time, low space allocation, and other operating system
problems prevent the application analysis from completing. However, you can restart the
analysis after resolving the problem, unless you change Alliance’s default setting for
recovery.

With each analysis, Alliance produces the VIALOG, a log file of errors, and the
VIAARPT, a summary report of run-time statistics and diagnostic messages. Use these to
find out why an error occurred, where it occurred, and to help you determine a fix. Also,
you can look up explanations in the online help or see the detailed listing located in the
ASG-Application Definition and Analysis User’s Guide.

Note:
Semantic linking is a common cause of abend stemming from excessive CPU utilization.

For step-by-step instructions to resolve analysis errors, see the ASG-Application
Definition and Analysis User’s Guide.

Refine Definition

After you resolve all analysis errors, begin refining the application definition. First,
research the components the analysis detected as discovered, missing, or dead. Then,
rerun the application analysis, resolve errors, and research new dead, discovered, or
missing components until you understand and accept these components, or there are
none. A clean output ensures the accuracy of a Alliance impact assessment.

For step-by-step instructions, see the ASG-Application Definition and Analysis User’s
Guide.

Research Components Identified as Dead, Discovered, or Missing

The analytical engine produces three component lists to assist you in refining the
application definition: dead, discovered, and missing. To refine the application definition,
review each identified item to determine if any action should be taken. For example,
before resubmitting the definition for analysis, you might want to investigate whether
dead components are really dead, add discovered components to the definition, or
redefine or remove references to missing components.

Dead components are in the application definition, but appear unused by the other
components. You might need to search for and add a component that references the dead
component. Review the dead component list to determine if the components are used in
any other application. If the component is completely unused, you may want to remove it
from the system. However, delete unused components cautiously. Components that
appear dead may not actually be dead, and you should look for an item that might be
using them.
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Discovered components are components referenced in the application, but not included in
the application definition. For example, a load module execution in your JCL that is
missing from the application definition. Review the discovered components list and
determine if you need to add the discovered components and attributes.

Missing components were present at the time of the original definition, but can no longer
be found. Perhaps you renamed or deleted a library. Review the missing components list
to determine if they were renamed. If a component is renamed or deleted, remove the

reference to the old name. Add a renamed component to the definition with its new name.

After you refine the definition, resubmit the application for incremental analysis and
semantic linking. Then the application analysis is complete and you can build the list of
data items for an impact analysis.

For step-by-step instructions, see the ASG-Application Definition and Analysis User’s
Guide.

Step 4 - Discovering the Nature of the Application

At this stage, examine the application analysis results to become familiar with aspects of
the application that might be impacted by the change. Now that the process of defining
and analyzing the application components has guided you to an understanding of your
application as a whole, evaluate the results to identify the components within the
requirement parameters.

Alliance includes a Query facility that generates cross-reference reports and Search
facilities that sort out equivalent components. Queries and searches are optional, but ASG
recommends you use them. They narrow the selection criteria and help you understand
the entities and relationships you want the Impact facility to analyze.

Save all queries, searches, and impact analyses results for future use in one or more
sequential files, called worklists. After a worklist is open, information is saved
automatically when the display changes or the current activity ends, providing you with a
running record of your actions in a single location.
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Generating Cross-reference Reports

The Query facility facilitates your understanding of application components and
relationships. Run queries on the application analysis results to identify how the
components are related, and to determine what components to choose for impact
assessment.

Alliance provides a set of template queries that address common questions. Run these
queries to display system-level and program-level cross-reference results on the
application in standard views. Later, when you are closer to determining the starting
points for impact assessment, use the Alliance query language to customize these
template queries, or to create new ones to show specific relationships.

System cross-reference reports display the data at the application level, such as the
dataset name, the job name, and step name where the dataset is used. Program
cross-reference reports display program-specific (local) information, such as called and
calling program and copybooks in programs inside the application. You can save the
results of each query to a worklist to refer to while building the list of possible candidates
for impact analysis.

For step-by-step instructions, see "Generating Cross-reference Reports" on page 24.

Running Searches

The Alliance search features enable you to conduct application-wide searches from either
the Query or the Impact facility. Use the search function to locate specific entities and
data items matching the criteria strings you define. Save your results to a worklist to use
when you build the impact list.

The search feature is an important factor in refining the scope of your analysis. For
example, use the search function to detect synonyms (components that contain the same
data) to reduce the number of entities selected for analysis without diminishing the
accuracy of the results. Use homonyms (components with the same name) to help
identify entities that should be analyzed.

When identifying synonyms, Alliance evaluates assignments, parameters, renames and
redefinitions, parents and children, indirect and implied dependencies, and utilities. When
identifying homonyms, Alliance detects data items with the same name. Synonyms and
homonyms exist at both application and program (local) levels.

For step-by-step instructions, see "Running Searches" on page 30.
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Step 5 - Running Queries or Using the Query Facility

At this stage, identify the components that might be impacted by the change and submit
the list to the Alliance Impact facility. This list is called the impact entity list (or simply
impact list). The more narrow the scope of the analysis with a precise impact list, the
more accurate the information obtained for impact assessment.

To limit the impact analysis to relevant entities, build an impact list consisting of pairs of
entity kinds and unique names that match your defined selection criteria. The objective is
to build an impact list based on the understanding gained in "Step 4 - Discovering the
Nature of the Application" on page 8. Customize the Alliance standard queries to display
application information about specific entities you want included in the analysis. Then,
use the search feature to refine the entities included in the analysis.

After determining the combination of entity kinds and unique names to include in the
impact list, Alliance matches the impact list against the open application to derive a list of
components for impact analysis. The selections you make from this list, also known as
the selection list, are the starting point for the impact analysis evaluation of all
relationships. Selecting items for the base selection list is the first action of "Step 6 -

Determining Impacted Components" on page 11.

Performing Custom Queries

10

Based on the information gathered through standard queries and searches, the next step is
to uncover more details by modifying existing queries or creating new ones. For example,
you might want to look up specific entities and their relationships.

Construct custom queries using the syntax supported by Alliance. An Alliance query
consists of two definition blocks:

. The ENTITY_ RELATIONSHIP BLOCK — names the application entities (such as
programs, FDs, PROCs, JCL) included in the query and the relationships used in
the search for application information;

. The ATTRIBUTES BLOCK — enables you to select data to be included in the
query results and to format the display differently than the default format.

For step-by-step instructions, see "Performing Custom Queries" on page 45.
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Searching for Specific Entities

After extracting system and program cross-reference data from the application analysis
results, use the advanced search options to locate specific entities possibly impacted by
the change. You can conduct application-wide searches for specific entities, entity kinds,
and literal search strings from either the Impact or Query facility.

These searches enable you to track individual entities, entity groups, and the occurrence
and location of literal strings. These search results contribute to the field of entities to
determine the starting points for the impact list.

For step-by-step instructions, see "Searching for Specific Entities" on page 70.

Step 6 - Determining Impacted Components

At this stage, you generate the first round of impact analysis results, based upon the list of
items you select for impact assessment. The Alliance impact analysis automates the
research process necessary to investigate the impact of change on an application. It
evaluates the dataflow and logical and physical relationships to determine the impact of
changes on an application.

Alliance produces both summary and detailed impact analysis information. The summary
impact analysis identifies components impacted by the change. The detailed impact
analysis explains the summary analysis results and shows the physical, logical, and
dataflow relationships transversed. The summary and detailed analyses output appear in
the Impact Facility screen. You can save the results of each impact analysis to a worklist.

Like the application definition, impact analysis is an iterative process. For example, after
reviewing the components in the summary analysis, you might use the detailed impact
analysis to examine the impact relationship of each component. Evaluating the impact
results may lead you to change some settings for impact generate or display options, and
modify the base selection list. Then, run the impact analysis again.

Building List of Possible Targets

Build an impact list with unique entities that are affected by the change after you
determine the components of interest for the change request. Unless you want to include
all the entity kinds in your application in the impact list, you must define selection criteria
to limit the number of entities the impact analysis targets. To specify the selection
criteria, specify the full name of each impacted entity kind, or use text patterns to identify
entity groups.

11
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You can generate a new impact list each time you run the impact analysis on an
application, or you can save the impact list to a worklist for future use in this or other
impact analyses. After you specify an impact list, you can create the base selection list the
Impact facility uses to evaluate all relationships.

For step-by-step instructions, see "Building the List of Possible Targets (Impact List)" on

page 73.

Selecting Items to be Analyzed

After you specify the type of impact analysis (detailed or summary) the Impact facility
matches the entities in the impact list to those in the open application to create a list of
targets to select from. The components you select comprise the base selection list.

After you select entities for the impact analysis, specify the scope of the analysis by
defining impact generate options. These options control how the impact analysis
evaluates data flow and hierarchical relationships. If this is an initial impact analysis,
ASG recommends you use the defaults for these options. After you set the impact
generate options, start the impact assessment.

For step-by-step instructions, see "Selecting Items to be Analyzed" on page 80.

Determining Impacted Components and Relationships (Summary Impact

Analysis)

The summary impact analysis lists all of the components affected by the proposed
change. It also displays the summary information for each impacted entity kind and the
number of occurrences for each. From this information, you can determine the task size
and the resources needed for implementation. After you review the list of impacted
entities and the number of changes involved, expand the summary information through
detailed analysis to see how these impacted entities were found and what their
relationships to each other are.

For step-by-step instructions, see "Locating Impacted Components and Relationships

(Summary Impact Analysis)" on page 82.

Listing Relationships of Impacted Items (Detailed Impact Analysis)

12

The detailed impact analysis displays the paths taken to generate the summary analysis
results. The display is hierarchical, with each level representing an impact relationship
path to a new component. Follow the path of a component by expanding and collapsing
the display. You can also display the Detailed Information pop-up that contains data
about the component at the cursor location.

Alliance builds impact analysis by layering related components. The detailed analysis
shows what each layer is and why the layer was applied to the member of the base
selection list.
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Various information options control the information shown for each entity. The defaults
are name, entity kind, and containing component. You can change the detailed impact
options to display additional information to the right of the original entity in the Impact
Facility screen.

After you generate the impact analysis results, you can evaluate the impacted
components.

For step-by-step instructions, see "Listing the Relationships of Impacted Items (Detailed
Impact Analysis)" on page 84.

Step 7 - Evaluating Components

At this stage, evaluate any components in the impact analysis results that warrant further
investigation. This evaluation leads to these two choices:

. Determine if the hierarchical and data flow relationships traversed during impact
analysis need to be adjusted. Do this by changing the Impact Generate options.

. Alter the base selection list and/or the items in your impact list.

The second choice is more likely, as you should change the Impact Generate options
cautiously, since inappropriate use can cause inaccurate results and unnecessary use of
system resources.

Changing the Impact Generate Options

The impact generate options affect the way the impact analysis traverses the data flow
and the hierarchical component relationships. For example, you might decide to include
entities that the base selection member assigns value to or from, or to include data
movement and comparison within programs for statements other than direct moves (i.e.,
alternate assignments).

For step-by-step instructions, see "Changing Impact Generate Options" on page 100.

Refining the Base Selection List

In some cases, you may need to change the components of the base selection list in order
to include data that was not included in a previous analysis. For example, you might find
an item that is not needed in the impact assessment and decide to remove it from the base
selection list. Or, you might decide to add items to the impact list you did not initially
plan to analyze.

For step-by-step instructions, see "Refining the Base Selection List" on page 112.

13
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Rerunning the Impact Analysis

In the last step of this iterative process you rerun the impact analysis until you gather
enough data to proceed with the change. Rerun Alliance impact analysis after you
perform these tasks:

. Finish reviewing the results of the last impact analysis.
. Finish investigating the paths traversed by components related to the change.
. Are satisfied that the impact generate options or the base selection list require no

changes.

The results of the final iteration of this process shows all application components
impacted by the change.

For step-by-step instructions, see "Rerunning the Impact Analysis" on page 115.

Step 8 - Using Impact Analysis Results to Implement Change
Request

At this stage, begin organizing and implementing the change request. Prior to performing
any other action, save the impact analysis results from the final iteration of the process to
a worklist.

Assessing Project Size

Assessing project size is the first step. For this, the entity counts in the impact analysis
results provide an immediate indication of the size of the task. Of course, the capability of
the available resources and the complexity of the change request must also be given
consideration, but it is outside of the scope of this discussion.

Determining and Assign Resources

Next, resources need to be assigned to implement the change. You can break the worklist
up and distribute it to the assigned resources so that each has an exact list of the
components that they are responsible for changing.

Evaluating Individual Tasks

Prior to implementing the change, use Alliance to understand how each component
altered interacts with other application components. Execute a detailed impact analysis
against the individual components to show how each component is related to the
application components. Use the Query facility to reveal specific relationships of interest.
Additionally, you can use the Search facilities to further clarify the role of the component
being changed.

14
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This chapter discusses how to initiate Alliance and set user options, and consists of these

sections:
Section Page
Initiating a Session 15
Verifying User Options 16

Initiating a Session

Note:
The method you use to start ESW products depend upon your system configuration.

To start Alliance directly

Use the ISPF selection or CLIST to start Alliance directly, as indicated by your systems
administrator. After you activate the session, the Alliance Primary screen displays.

To use the ESW screen to start individual products

1 Initiate the ESW screen using the ISPF selection or CLIST, as indicated by your
systems administrator.

2 Select Understand P Application from the ESW Primary screen to start the product.

The ESW - Application Understanding or Alliance primary screen displays. During
the installation, ESW product options are customized for your site. If you are using
the product for the first time, you might want to perform the procedures in
following sections to ensure that installation defaults meet your needs.
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Verifying User Options

During installation, options that define the operating environment are set to default
values. These are the set options:

Product parameters that control Alarm settings and the use of confirmation pop-ups
Product allocation of DASD information for the log, list, and work files

Log and list file processing options

Script file allocations

PF key assignments

Product Parameters

16

The product parameters options specify alarm and confirmation settings.

To verify or change product parameter information

1

Select Options » Product parameters from the Alliance Primary screen and press
Enter. The Options - Product Parameters pop-up displays (see Figure 7).

Figure 7 « Options - Product Parameters Pop-up

Options - Product Parameters
Command ===

Specify parameter information.

Alarm . « +« « « . . ¥ES  (¥essMo)

Confirm submit . . WO i¥esfNo Confirmation displayed before Submit)
Confirm delete . . ¥YE: (¥essNo Confirmation displayed hefore Delete)
AMF %tats Required YEE® (YessMo If I[SPF Stats required for AMF)
Confirm save . . . ¥ES (¥Yess/Mo Sawve results to Work List)

Review the information and make any necessary changes.

Specify whether the Application Maintenance Facility (AMF) requires the ISPF
statistics (time datestamp) to determine if a source member was modified. Choose
NO to allow the AMF to use a potentially expensive calculation to determine if
members without ISPF statistics were modified.

See the ASG-Application Definition and Analysis User’s Guide for more details.

Press PF3 to save changes and exit the Options - Product Parameters pop-up.
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Product Allocations

Use product allocations options to specify the product allocations of DASD information
for the Log, List, and Work files.

Alliance only allocates the Log file if it encounters an internal error, such as an abend.
The Log file contains ESW error messages that you can use to facilitate the debugging
process. The List file contains printed output and is allocated when you issue a request to
print.

The analysis work file is the temporary AKR file that contains intermediate results while
an analyze job is running. This file should be as large as the space requirements for the
application itself. Use the other work file parameters for other temporary files allocated
during other processing.

To verify product allocation settings

1 Select Options » Product allocations from the Alliance Primary screen and press
Enter. The Options - Production Allocations pop-up displays (see Figure 8).

Figure 8 « Options - Product Allocations Pop-up

File Edit “iew Facility Options Help
Options - Product Allocations
Command ===

Specify allocation information.

Log File List File

Gereric unit . . . ZRTDA SVEDA [Group hame or unit address)
VYolume serial . . . SRTSO1 SRTEE1 [(Blank faor default wolume)

[ARalysis) Waork File Wark: File [Other]
Gereric unit . . 5rsDha STSDA [Group hame or unit address)
Volume serial . . . o oo [Blank for default wolume)
Space units o . . . CTLS CTLS [BLKS, TRES ar CTYLS)
Primary space . . . GOS@ 5 [Space units)
Secondary space . . GO1@ 5 [Space units)

Alternate node . .

2 Review the information and make any necessary changes.

3 Press PF3 to save changes and exit the Options - Product Allocations pop-up.

Processing Log and List Files

Use Log and List file processing options to specify the settings for processing the Log
and List files. The Options - Log/List Definition pop-up also defines printing or deletion
options.

Alliance only allocates the Log file if an internal error is encountered, such as an abend. It

contains ESW error messages that facilitate the debugging process. The List file contains
printed output and is allocated when you issue a print request.

17
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To verify or change the setting for processing

1 Select Options » Log/List from the Alliance Primary screen and press Enter. The
Options - Log/List Definition pop-up displays (see Figure 9).

Figure 9 « Options - Log/List Definition Pop-up

Options - Log-List Definition
CoHAand ===}

specify Log-List options. Then press PF key fob action.

nptions Log List
Process option . .« . . . . E FO
Prinary tracks | 1
Eecondary tracks . 2 5
Lines per page . . . . . . 56 56
Eyzout Class . . . w0 ow s * *

Process options: PE [print<keep], PO [print-delete], K, or O.

Tob statedent infordation:
<-UIALZZ  TOB [DEUTRE,253200],

e HEGCLASE=A
£ IMZERT '~ROUTE PRIMNT MODE.UZER' HERE IF MEEDED.
sk

PFd=Cu=stodi zed MaWes PF3=Proces= 1og file PFesProcess list file

2 Verify that the allocation and disposition choices conform to your site standards and
make necessary changes.

3 Enter the appropriate information in the Job statement information field if required
for printing the Log or List file.

4  Press PF3 to save changes and exit the Options - Log/List Definition
pop-up.

To customize the Log or List dataset name

Specify the K or PK process option, then you can customize the dataset where the log or
list file is allocated. By default, Alliance allocates the Log, and List files with this syntax:

USERID.ALNnnnnn . VIAXXXXX

where:
nnnnn is a sequential number from 00001 to 99999.
xxxxx 18 LOG for Log and LIST for List files.

If you specified a TSO prefix, the prefix appends to the beginning of the file name
allocated for the Log and List files.
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To define a dataset name

1

From the Options - Log/List Definition pop-up, press PF4 to display the
Options - Log/List Name Customization pop-up (see Figure 10).

Figure 10 « Options - Log/List Name Customization Pop-up

gptions - Lag-List MaHe CustoHdization
CoMHand ===

You can define a custonized name when wou choose option PR [print<kespl or
K [kespl by specifying Ulser]. Specifying Y(es] on ProWpt later lets wou
define a CUstod naHe as wou process each logslist file. Otherwise,
specify data set name and file Hode. Then press Enter.

options Log List
File MaHing « « « « « = = E E Ul=er] or Z[usted]
ProHpt later for DEN . . . Yles] ar Nlo)

The following are needad if U[ser) and Wio) are specified aboue

Log Data set naMe [2aq]
File Hode . . _ olvervritel or Alppend]

Li=t Data =zet nawWe [Zeq)
File Hode . . _ olverwrite] or Alppend]

Type U in the File Naming field for Log and/or List to indicate a user-defined dataset
name and press Enter.

If you specify N in the Prompt later for DSN field, you must enter a dataset name in
the corresponding Dataset name field, and specify Overwrite or Append in the File
Mode field.

If you specify Y in the Prompt later for DSN field, Alliance prompts you for the
dataset name during file processing. For example, if you specify Yes in the Prompt
later for DSN field for the Log file, the Log Name Customization pop-up displays

(see Figure 11).

Figure 11 » Log Name Customization Pop-up

Log Mame Custodization
CoMHand ===

The current log file's data set name iz shown below. To khave 3 CustoM
naHe, specify a new sequential data zet naWe. IFf it already edists, it
has to have LRECL=137 and RECFH=V'; and specify the file HOode. Then press
Enter.

current Data set nawe I '
Custod Data set nane
File Hode . . . _ ofverwrite]l or Alppend]
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Allocating Script Files

20

A script file automates an online process—a sequence of commands and screen
interactions. Typically, you use a script file for Batch processes, such as definition
changes or Batch queries.

During the installation, you specify default script files for the site. Script file allocation
options specify the default dataset names or the concatenation sequence for your session.

To display or change the script files

1 Select Options » Script file allocations from the Alliance Primary screen and press
Enter. The Options - Script File Allocations pop-up displays (see Figure 12).

Figure 12 » Options - Script File Allocations Pop-up

Options - Script File Allocations
Command ===>

R - Restore default Script allocations
Enter desired Script file concatenation.

Script file data set names:

2 Review the current default script file dataset names.

Note:

When initializing for defaults, the lines are filled from the bottom to allow
concatenation.

3  Enter the dataset names for the new script files in the Script file dataset names field,
if needed. The files are concatenated in the order entered.

4  Type R on the Command line and press Enter to restore the default.

5  Press PF3 to save any changes and to exit the Options - Script File Allocations
pop-up.



2 Getting Started

Assigning PF Keys

PF key assignment options specify PF key functions. Figure 13 shows the Options - PF
Key Definition pop-up with default settings. These default PF key assignments apply
only if no PF key assignments are listed in the screen or pop-up. Fixed PF key
assignments listed at the bottom of screens and pop-ups override these defaults.

Figure 13 » Options - PF Key Definition Pop-up with Defaults

Options - PF Key (B1-12) Definition
Command ===%

Press Enter to process changes andfor to display alternate keys.
Press PF3/15 (END) to exit.

Humber of PF keys: 12 Terminal type: 3278

PFE1 HELP
PFOZ SPLIT
PFE3 END
PFEd4 RETURN
PFES RFIND
PFOE RCHAMGE
PFET UP
PFEE DOWH
PFE3 SWAP
PF10 LEFT
PF11 RIGHT
PF12 CAMCEL

To verify the current PF key assignments

1 Select Options » PF keys from the Alliance Primary screen and press Enter. The
Options - PF Key Definition pop-up displays current PF key settings.

2 Type over the current setting to change the function of a PF key.

3 Press PF3 to save changes and exit the Options - PF Key Definition pop-up.
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Discovering the Nature of the Application

This chapter describes how to use the Query and Search facilities, discusses synonym and
homonym relationships, and contains these sections:

Section Page

Generating Cross-reference Reports 24
Running Searches 30
Saving and Printing Query/Search Results 41

As described in the overview, Alliance includes a Query facility that allows you to
generate cross-reference reports on the results of the application analysis. After you refine
the definition of the application, identify components that are possibly impacted by the
change. You can then use this information to specify selection criteria for the entities you
want the Impact facility to analyze.

Save the results of each query to one or more worklists so you can access the data when
building the list of possible candidates for the impact analysis. After you open a worklist,
Alliance automatically saves the information when either the display changes or the
current activity ends. This gives you a running record of your actions in a single location.

Alliance also provides Search facilities that identify components that contain the same
data, have the same name, or make use of literals. You can use this information to refine
the candidates for impact assessment. Use both the Impact and the Query facility to
perform searches.
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Generating Cross-reference Reports

Alliance provides a set of cross-reference reports, or template queries, that answer
commonly asked questions about the components in the applications. System
cross-reference reports provide information about system-level components in the
application (e.g., databases, jobs, and library members). Program cross-reference reports
provide information about programs and the components related to and contained within
programs [e.g., data items, records, and copymembers (includes)].

After you review the application components through these standard views and are closer
to determining the starting points for impact assessment, use Alliance’s query language to
customize these template queries or to create new ones that display specific relationships.
For step-by-step instructions, see "Using the Query Facility" on page 45.

Generating System Cross-Reference Reports

24

To generate a report with system cross-reference information

1 Select View » System Cross-Reference Information from the Alliance Primary
screen and press Enter. The System Cross-Reference pop-up displays.

These are the available system cross-reference reports:

Report Name Displays

CICS File cross-referenced by ¢ CICS file DD

Program . Program

CICS Map cross-referenced by ° CICS Maps
Program

. Mapsets
. Program names
DSN cross-referenced by Job y DSN

. DD

. STEP name

. JOB name

. PROC name

. PROC STEP

. PROC JOB name
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Report Name Displays

DSN cross-referenced by ¢ DSN
Copybook . Record

. Size

. Copybook
IMS DBD cross-referenced by ¢ IMS DBD
Segment . Segment

. Segment fields
IMS PSB cross-referenced by ¢ IMS PSB
Program .

Program name

Job cross-referenced by JCL
Library

JOB name
JCL Library name

Member name containing the JCL

Job cross-referenced by * JOB Library DSN
JOBLIB . JOB name
. JOB name

Job cross-referenced by Load
Module

JOB STEP name

Load Module name

If a PROC is executed:

PROC name
PROC STEP
PROC STEP Load Module

Member containing the job
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Report Name Displays

Job cross-referenced by . JOB name

STEPLIB «  JOB STEP name
. JOB STEP STEPLIB DSNs
If a PROC is executed:
. PROC name
. PROC STEP
. PROC STEP STEPLIB DSNs
Job cross-referenced by FD * JOB name

. JOB STEP name
. JOB STEP DD name
. FD name

. FD within the executed program
associated with the DD

. Records defined to the FD within the
executed program.

If a PROC is executed:

. PROC name

. PROC STEP name

. PROC STEP DD name

. FD within the executed Program
associated with the DD

. Records defined to the FD within the
executed program.

JOBCAT cross-referenced by Job  * JOBCAT DSN
. JOB name

Load Module cross-referenced by ~*  Load Modules name

CSECT . CSECT name, and optionally, the

CSECT Source Library name

. Source Library Member name

26
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Report Name Displays

Load Module cross-referenced by
Job

Load Module name

STEP name executing the Load
Module

JOB containing STEP executing the
Load Module

If the STEP executing the Load Module is
contained in a PROC, lists:

STEP executing the PROC

JOB containing the STEP that
executed the PROC

DD and DSN used by the STEP

PROC cross-referenced by Load ¢
Module

PROC name
STEP name

PROC Load Module executed in the
STEP

PROC Library where the PROC
resides.

STEPCAT cross-referenced by Job *

STEPCAT DSN
JOB using the STEPCAT
STEP name

Select one of the reports listed on the pop-up and press Enter.

Note:

il

For step-by-step instructions on saving and printing query information, see "Saving
and Printing Query/Search Results" on page 41.

Press PF3 to close the report and return to the previous screen.
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Generating Program Cross-reference Reports

28

To generate a report with program cross-reference information

1

Select View » Program Cross-Reference Information from the Alliance Primary
screen and press Enter. The Program Cross-Reference pop-up displays.

These are the available program cross-reference reports:

Report Name Displays

Called Program
cross-referenced by Caller

Called Program entry name

Called Program name, and
optionally, Calling Program name

Source Library name where Called
Program resides

Member name in Source Library

Caller Program
cross-referenced by Called

Calling Program name

Called Program entry name, and
optionally, Called Program name

Source Library name where Calling
Program resides

Member name in Source Library

CICS Transactions cross-referenced
by Program

Transaction name

Program name containing the
Transaction

Source Library where Program
resides

Member name in Source Library

Copybook cross-referenced
by Program

Copybook name

Name of Program using Copybook,
and optionally, the Member and
Library where Copybook resides
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Report Name Displays

Dataitem cross-referenced * Dataitem name

by Program +  Program name containing Dataitem

definition

. Source Library where Program
resides

. Member name containing the

Program
FD name cross-referenced FD name using the Record
by Record . Record name
. Dataitem names in Record
. Program name containing FD
Program cross-referenced *  Program name
by CICS Transaction . CICS Transaction executing the
Program
Program cross-referenced «  Program name
by File . FD name within Program
. DD name associated with the FD in
the execution JCL
. DSN associated to the DD in the
execution JCL
Program cross-referenced *  Program name
by Copybook . Copybook used by Program
. Program Source Library name
. Member name of Program in Source
Library
Program cross-referenced *  Program name
by Dataitem . Dataname

. Copybook containing the Dataitem
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2 Select a report listed on the pop-up and press Enter.

Note:

For step-by-step instructions on saving and printing query information, see "Saving
and Printing Query/Search Results" on page 41.

3 Press PF3 to close the report and return to the previous screen.

Running Searches

The Alliance search function familiarizes you with the application components possibly
impacted by the change. You can conduct application-wide searches from either the
Query or the Impact facility to isolate the specific components that match the criteria you
define. Save all of the search results to a worklist in order to have the data available when
you determine the list of components that might be impacted by the change.

Searches help you to determine the components to use for impact analysis. To reduce the
number of entities selected for impact analysis without affecting the accuracy of the
change assessment, identify synonyms (components that contain the same data) before
submitting the list of impacted items for analysis. Identify homonyms (components with
the same name) to find components with the same use.

To find additional items requiring impact analysis, identify components that use literals
related to the change request. Run searches to narrow the focus of your understanding of
the application to the components surrounding the change request. For step-by-step
instructions, see "Searching for Specific Entities" on page 70.

Understanding Synonym Relationships

30

In identifying synonyms, Alliance evaluates these relationships:

. Assignments . Implied dependencies
. Parameters . Indirect dependencies
. Renames and redefinitions . Utilities

. Parents and children

Synonyms and homonyms exist at both application and program (local or global) levels.
The same relationships occur at each level and you can specify just local or both local and
global levels for each search. Application level synonyms expand the scope of the search
to the entire application. Use program level synonyms to limit the search to a single
program. This eliminates components outside the selected program from the results. The
results reference globally-visible components that have a synonym relationship within the
program.
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Figure 14 illustrates application and program level synonyms.

Figure 14 « Application and Program Level Synonyms

PGM1 PGM2
FD XYZ. DD1 DD2 FD XYZ.

SELECTS | [~~SELECTS DD2
o1C. 012.

05 A1 PIC X(2). 05 A1 PIC X(2).

05 A2 PIC X (2). | DSN=ABC.XYN.DSN | 05 A2 PIC X (2).
01A  PICX(@). 01Y  PICX(4).
778 PIC X(4). 77Z  PICX().
MOVE A TOB. READ XYZ.
MOVE B TOC. MOVE ZTO Y.
WRITE C. MOVE Y TO X.

Application Level Scope
Program Scope for PGM1 Program Scope for PGM2

o O
oy /%

-

Local Synonyms for A of PGM1 Application Level Synonyms for A of PGM1
B B
C C
Local synonyms will not include Zz
the connection from C to Z, I

because it is outside the scope
of PGM1.

For example, if A is the Employee Name field and B the 401K Participant field, and the
data in B comes from A, A and B are synonyms. The synonym relationship is
independent of the direction of the data movement between them.

Control how Alliance calculates synonyms by specifying options to the application
analytical engine before you submit the application definition for analysis. For
step-by-step instructions on changing analyze options, see the ASG-Application
Definition and Analysis User’s Guide.
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Assignments

32

When Alliance finds a one component directly assigning data to another it defines those

components as synonyms.

Figure 15 illustrates a synonym relationship by assignment.

Figure 15 « Synonyms - Assignment

MOVEATOB

/N

A and B have a direct relationship, A and B are Synonyms.

Alliance recognizes these statements as data movement between components:

NATURAL | COBOL PL/T CICS IDMS IMS SQL

ACCEPT ACCEPT ALLOCATE | SEND MAP |ACCEPT |INSERT |FETCH

COMPRESS |MOVE ASSIGN RECEIVE END GET UPDATE
CORRES- MAP TRANS-
PONDING ACTION

GET MOVE DECLARE |WRITE WRITE REPLACE

GET SAME |READ DELETE READ FIND

GETTRANS- |REWRITE |LOCATE READPREV |OBTAIN

ACTION

DATA

INPUT WRITE READ READNEXT |GET

REINPUT SORT RETURN REWRITE

SEPARATE |MERGE REWRITE

MOVE RETURN | WRITE

MOVE ALL |RELEASE

READ

READ

WORK FILE

WRITE
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Parameters
Alliance recognizes actual and formal parameters as synonyms.
Figure 16 illustrates a synonym relationship by parameters.
Figure 16 » Synonyms - Parameters
PGM1 PGM2
CALL PGM2 USING(A) PROCEDMRE DIVISION
A
) \ USING
Actual Parameter =z
Formal Parameter
A and B refer to the same data, A and B are Synonyms.
File I/0

Notice that you make the connection from the DD selected within the program to a DD
defined within the execution method (e.g., a JCL job) by understanding the load module
referenced in the execution method. The load module is affiliated to the program source
code and the selected DD within the program is associated to the DD within the execution
method.

To make this Synonym relationship you must first properly define the load module for the
source to the application and define the method of executing the load module to the
application inventory (e.g., the execution JCL).

Figure 17 illustrates a synonym relationship by affiliation.

Figure 17 « Synonym Relationship by Affiliation

DSN - XYZ.EMPLOYEE.DATAFILE

/ AN

DD - EMPDATA DD - EMPDATA
FD-OUTFILE |€ > FD - INFILE

OUTFILE and INFILE
refer to the same data,
OUTFILE and INFILE are synonyms.
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Renames and Redefinitions

When component A is renamed or redefined as component B, the two components share
the same data and are synonyms. Figure 18 illustrates a synonym relationship by
rename/redefinition.

Figure 18 » Synonyms - Renames and Redefinitions

01 A PIC X(6). —

- 01 B REDEFINES A.
05 B1 PIC X(3).
05 B2 PIC X(3).

—

A and B will share the same data, A and B are synonyms.

Parents and Children

In a hierarchical data structure, you can define parent and child components as synonyms
when the data they contain overlaps exactly. For example, if A is the parent and B is the
only child of A, A and B are synonyms.

Figure 19 illustrates a synonym relationship by hierarchical definition.

Figure 19 « Synonyms - Parent/child Hierarchy

01A.
05B.

E C1PIC X(3).
10 C2 PIC X(3).

A and B refer to the same data, A and B are Synonyms.

Y
A

Indirect Dependencies

When you define two components as synonyms, the synonyms of one become the
synonyms of the other. For instance, when A and B are defined as synonyms, all
synonyms of A become indirectly synonyms of B.
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3 Discovering the Nature of the Application

Figure 20 illustrates a synonym relationship by indirect dependency.

Figure 20 « Synonyms - Indirect Dependencies

MOVEATOB
MOVEBTO C

Working from the previous example, a direct synonyms relationship
exists between A and B. The second statement creates a direct
synonyms relationship between B and C.

MOVEATOB
MOVEB TO C

The relationship between A and B, and B and C causes an indirect
dependency between A and C, through B.

When two components are identified as synonyms, synonyms of one become synonyms
of the other. These relationships are indirect dependencies regardless of the direction of
the assignment chain. When A and B are defined as synonyms, all synonyms of B
become indirect synonyms of A.

Figure 21 illustrates a multiple level synonym relationship by indirect dependency,
regardless of the direction of the relationship.

Figure 21  Indirect Dependencies - Multiple Levels

MOVEATOB /\/—\/\
MOVEBTOC
MOVE CTO D

MOVE E TO D

C, D and E have an indirect relationship to A.

A, B, C, D and E are synonyms of each other. Note, E is indirectly
related to A regardless of the direction of the data flow.
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Implied Dependencies

36

When two components are identified as synonyms, and each component has hierarchical
children, the children of each component are checked for size and offset to determine if
they are synonyms of the other component’s children. When A and B are defined as
synonyms, Al is checked against B1, A2 is checked against B2, and so on. For example,
each child of A is compared to the children of B for size and offset to determine if the
compared items should be detected as synonyms of each other.

Figure 22 illustrates synonym relationships by implied dependency.

Figure 22 » Implied Synonyms from Hierarchical Children

01 A.
05A1 PIC X.
05A2 PIC X(2).
05A3 PIC X.

01 B.
05 B1
05 B2
05 B3
05 B4

A1 size: 1
offset: 0
A2 size: 2
offset: 1
A3 size: 1
offset: 3

PIC X.

PIC X

PIC X.
PIC X.

¥\

MOVEATOB ° °

Aand B
are synonyms

A1 and B1 B1 size: 1
are synonyms offset: 0
A2 and B2 B2 size: 1
are NOT offset: 1
synonyms
A3 and B4 B4 size: 1
are synonyms offset: 3
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Utilities

When an input file passes data to an output file through a utility program, the files are
considered equivalent and are identified as synonyms.

This table lists the utilities Alliance supports and the names of their input and output files.
Field rearrangement by the utilities is not supported.

Utility DD for Input File DD for Output File
ICEMAN SORTIN SORTOUT, SORTOFnn
IDCAMS (all) (all)

IEBCOPY SYSUTn SYSUTn

IEBGENER SYSUTn SYSUTn

IERRCO00 SORTIN SORTOUT, SORTOFnn
IGHRCO00 SORTIN SORTOUT, SORTOFnn
SORT/MERGE SORTIN SORTOUT, SORTOFnn
SYNCSORT SORTIN SORTOUT, SORTOFnn

Searching for Application Level Synonyms

Perform searches from both the Impact and the Query facility. You can access these
facilities from the Facility pull-down on the Alliance Primary screen.

To search for application-level synonyms

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

2 Select Search » Synonyms and press Enter.

3 Select Data Item Synonyms » Application-level synonyms and press Enter.
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In the Dataitem field of the Synonym Criteria pop-up, choose one of these actions:

. To only list data items with an exact name, type the complete name of the data
item.

. To list data items that have a pattern in their name, type a text pattern.
. To list all data items in the application, leave the asterisk (*).

Note:
ASG recommends that you not list all synonym, as it is time intensive.

Press Enter to initiate the search for data items that match the criteria you defined.

The Synonym Selection pop-up displays showing the list of data items. Specify the
data items for which Alliance identifies synonyms.

Type any non-blank character in the selection column beside the data items you want
to select and press PF4 (Synonyms) to initiate the search for synonyms.

The Synonym View screen opens displaying the list of synonyms Alliance
identified. The data items you selected are highlighted and their synonyms are listed
below each one. Use the standard ISPF scroll keys to display the qualification
information for each synonym identified.

Note:

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 41.

Press PF3 and then Enter to exit the Synonym View pop-up without saving the
search results.
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Searching for Program Level Synonyms

Program-level (or local) searches identify synonyms within a selected program.

To search for program-level synonyms

1

10

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search » Synonyms and press Enter.
Select Data Item Synonyms » Program-level synonyms and press Enter.

Type any character in the selection column beside the program displayed in the
Synonym - Program Selection pop-up and press Enter.
In the Dataitem field of the Synonym Criteria pop-up, choose one of these actions:

. To only list data items with an exact name, type the complete name of the data
item.

. To list data items that have a pattern in their name, type a text pattern.

. To list all data items in the application, leave the asterisk (*).
Press Enter to initiate the search for data items that match the criteria you defined.

The Synonym Selection pop-up displays showing the list of data items. Specify the
data items for which Alliance identifies synonyms.

Type any non-blank character in the selection column beside the data items you want
to select and press PF4 (Synonyms) to initiate the search for synonyms.

The Synonym View screen opens displaying the list of synonyms Alliance
identified. The data items you selected are highlighted with their synonyms listed
below them. Use the standard ISPF scroll keys to display the qualification
information for each synonym identified.

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 41.

Press PF3 and then Enter to exit the Synonym View pop-up without saving the
search results.
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Searching for Homonyms

Alliance defines homonyms as data elements that have identical names across an
application. Data elements with identical names usually are used with similar intent.
Identifying them enables you to ensure thoroughness in implementing change requests.
You can use this information to accomplish data rationalization tasks as well. Because
data elements that come from the same copybook (include) have the same name, Bridge
provides an option to remove them from the homonym output.

To search for homonyms

1

40

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search » Homonyms and press Enter.

In the Name field of the Homonym Criteria pop-up, you can:

. Type the complete name of the data item to list only data items with that exact
name.

. Type a text pattern to list data items that have that pattern in their name, as
well as the number of definitions for that dataname.

. Leave the asterisk (*) to list all data items in the application. This is a time

intensive procedure and is not recommended by ASG.

Type any non-blank character in the selection column beside the Include Copybook
Items field if you want Alliance to count items in copybooks as homonyms when the
copybook appears in more than one program.

Press Enter to initiate the search for data items that match the criteria you defined.

The Homonym Selection pop-up opens with the list of data items. Now, specify the
data items for which Alliance identifies homonym:s.

Type any character in the selection column beside the data items you want to select
and press PF4 (Homonyms) to initiate the search for homonyms.
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The Homonym View screen opens with the list of homonyms Alliance identified.
Each dataname definition is listed with this information:

. Homonym name . Program name
. Definition level of the dataname e Qualification for the dataname

. Defined picture of the dataname

Use the standard ISPF scroll keys to display the qualification information for each
homonym identified.

For step-by-step instructions on saving and printing search information, see Saving
and Printing Query/Search Results.

Press PF3 and then Enter to exit the Homonym View pop-up without saving the
search results.

Saving and Printing Query/Search Results

To save search results information to a new worklist

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Choose Worklist » New Worklist and press Enter. The New Worklist pop-up
displays.

Type a unique name and description. You may also provide an optional dataset
name. Press Enter.

If you do not provide a dataset name, the Impact or Query Facility screen returns
with the name of the new worklist displayed in the message area. For example:

<userid>.ALNnnnnn.VIAWKLST
where:
<userid> isyour TSO user ID or prefix.

nnnnn is a sequential number assigned by Alliance
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To save search results to an existing worklist

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Worklist » Open Worklist and press Enter. The Open Worklist pop-up
displays.

Type any character in the selection column beside the name of the worklist you want
to edit and press Enter.

To edit an existing worklist

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Worklist P Edit worklist and press Enter. The Open Worklist pop-up displays.

Type any character in the selection column beside the name of the worklist you want
to edit and press PF4. The worklist displays on your default editor screen.

If SmartEdit is installed at your site, the SmartEdit editor is accessed. Otherwise the
ISPF editor is accessed.

Select File P Save to save your changes.

Select File P Exit to return to the original screen.
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To print search results

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select File P Print current results and press Enter.
The search results are copied to a Alliance list file.

Select Options » Log/list and press Enter. The Options - Log/list Definition pop-up
displays.

Type either PK (Print/Keep) or PD (Print/Delete) option for the list file.

Press PF6 to close and process the list file.
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Using the Query Facility

This chapter describes how to perform queries and searches, and contains these sections:

Section Page

Performing Custom Queries 45
Understanding Query Language Syntax 46
The ATTRIBUTES BLOCK 50
The SELECTION BLOCK 6l
Using Queries 63

To refine the information collected so far, determine the selection criteria in order to
locate the unique entity kinds and names that constitute the impact list. The more narrow
the scope of the analysis, the more accurate the information that is obtained for the impact
assessment.

Use the Alliance query language to either customize the template queries or to create new
template queries to display application information about the entities that are included in
the analysis. You can also run new searches to locate entities impacted by the change.

Performing Custom Queries

To locate specific entities in your application and their relationships with other entities,
either modify the existing queries or create new queries using the syntax supported by
Alliance. In either case, begin by using your system editor to create a file that contains the
query source. Then, either modify or specify the source as needed and define the new
query to Alliance. Execute the query to conclude this process.
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Understanding Query Language Syntax

The structure of a Alliance query consists of three definition blocks:

Definition Block Description

ENTITY _RELATIONSHIP Use to name the application entities (such as programs,

BLOCK FDs, PROCs, JCL) you want to include in the query and
the relationships you want to use in the search for
application information.

ATTRIBUTES BLOCK Use to select data to be included in the query results and
to format the display differently than the default format.

SELECTION BLOCK Use to allow AND/OR logic between attributes or
entities, and allows grouping of elements with the Select
statement.

Query Structure Example

Figure 23 shows an example of a query structure that displays all FDs used in all
programs.

Figure 23 « Query Structure Example

000001 ENTITY RELATIONSHIP BLOCK
000002 *

000003 FD IN PROGRAM

000004 *

000005 ATTRIBUTES BLOCK

000006 *

000007 FD

000008 WIDTH 12

000009 BLANK WHEN REPEATED
000010 SORT DESCENDING
000011 BREAK INSERT BLANK LINE
000012 *

000013 PROGRAM

000014 WIDTH 12

000015 BLANK WHEN REPEATED
000016 SORT DESCENDING
000017 BREAK INSERT PAGE
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Query Results Example

Figure 24 shows the results of the query structure specified in Figure 23 on page 46. This
table shows the specified formatting instructions:

Structural Element Description

WIDTH n User-defined column widths

BREAK INSERT BLANK A blank line is inserted between each change in the FD
LINE name

BREAK INSERT PAGE A page break is inserted for each change in the program
name

SORT DESCENDING Result is sorted in descending order on both the FD and
the program

Figure 24 « Query Results Example

Name : EXQUERY1 - EXAMPLE QUERY 1
FD PROGRAM

R R R R R R R R R R TOP OF DATA khkkhkhkkkhkhkhkkhkkkkkkkkkkkhkkkkkk

MASTERIN VIAIDEMO
MASTER-RPT VIAIDEMO
——————————————————————————————————————————————————————— |Page break|
DAILY TOTALS VIAIDEM1

R R R R R R R R R R BOTTOM OF DATA khkkhkhkhkhkhkhkhkhkkkkkkkkkkkkkkkk

Query Syntax Rules

These are the query syntax rules:

. The first two keywords in the query definition must be ENTITY_RELATIONSHIP
BLOCK in capital letters.

. Query statements can start anywhere on the line.
. Multiple statements are allowed in a single line.

. Comment lines, identified with a period (.) or asterisk (*) placed in column 1, can
be located anywhere in the query definition.
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For readability, start each phrase on a new line and use comment lines to separate major
sections. Figure 25 illustrates these syntax rules.

Figure 25 « Query Language Syntax - ENTITY_RELATIONSHIP BLOCK Example

000001 .This is a comment line
ENTITY RELATIONSHIP BLOCK
000003
000004 entityl relationshipl entity2
000005 entity2 relationship2 entity3
000006
000007
000008 entityN relationshipN entityN+1

The ENTITY_RELATIONSHIP BLOCK

48

Use the Entity Relationship block to specify the chain of entities to be displayed. Entities
linked by relationships are also specified in the Entity Relationship block. The valid links
are specified in "Valid Entities and Relationships." on page 117. Internally, this block
specifies the analysis data from the AKR that Alliance uses to derive the query results.

If the ENTITY RELATIONSHIP BLOCK specifies, for example:
FD IN PROGRAM

then the default query results show all FDs that occur in all PROGRAMSs. The display is
formatted as seen here:

FD PROGRAM

On the other hand, if the ENTITY RELATIONSHIP BLOCK specifies, for example:

FD IN PROGRAM
PROGRAM IN MEMBER

then the query results show all FDs that occur in all programs and the LIBRARY
MEMBERS containing the PROGRAMs. The display is formatted as seen here:

FD PROGRAM MEMBER

With each additional entity specified, Alliance adds a new column with default entity
titles and field widths to the display.

In the example above, you might be inclined to change the display to show all FDs and
the library MEMBERS containing FDs by using the statement FD IN MEMBER, but this
is not a valid entity-relationship combination.



Note:

4 Using the Query Facility

To prevent the display of PROGRAM when the column width of PROGRAM is set to
zero, use the ATTRIBUTES BLOCK statement. For more information, see "The
ATTRIBUTES BLOCK" on page 50.

These are the ENTITY _RELATIONSHIP BLOCK syntax rules:

The first entity specified in the ENTITY_RELATIONSHIP BLOCK is called the root
entity for the query (for example, entityl in Query language syntax -
ENTITY RELATIONSHIP BLOCK example). This is any valid application entity.

All remaining links must begin by naming an entity that is specified in a previous
line. Otherwise, the syntax does not form a valid entity.

You can perform these tasks:

Specify a continuous search path through the application information by repeating
an entity that occurred at the end of the preceding line. For example, entity2 in the
Query Language Syntax - ENTITY_ RELATIONSHIP BLOCK Example displays
at the end of the first line and the beginning of the second. Entity1 is related to
entity2, entity2 is related to entity3, and so on. This forms the continuous search
path.

Begin a new search path through the application information by repeating the first
entity that occurs in one line on several subsequent lines. To ensure correct
interpretation, ASG recommends that you change the format of the output to
delineate the paths. Figure 26 and Figure 27 on page 50 show a query result with
multiple paths.

Figure 26 » Example of Multiple Paths in a Query

000005

000001 ENTITY RELATIONSHIP BLOCK
000002 COPYMEMBER IN PROGRAM

000003 COPYMEMBER IN MEMBER

000004 MEMBER IN LIBRARY

000006 ATTRIBUTES BLOCK

000007 COPYMEMBER

000008 ON CHANGE INSERT BLANK LINE
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The ENTITY_RELATIONSHIP BLOCK syntax shown in Figure 27 specifies a report
showing all COPYMEMBERSs and the PROGRAMs using them. In addition, this query
requests the listing of all library MEMBERSs containing the COPYMEMBER and the
LIBRARY(s) containing those MEMBERs.

Figure 27 « Query Results Showing Multiple Paths Example

Name: VIABQCPS - Copybook / Program cross-reference

COPYMEMBER PROGRAM MEMBER LIBRARY

COPY0005 VIAIO40 n/a n/a <==COPYMEMBER IN PRORAM

COPYO0005 n/a COPYO00005 ASG.VIA.SOURCE <==COPYMEMBER IN MEMBER
MEMBER IN LIBRARY

COPYO0010 VIAIO40 n/a

COPYO0010 n/a ASG.VIA.SOURCE

For example:

. The COPYMEMBER is IN the PROGRAM and also IN the library MEMBER.

. The library MEMBER s IN the LIBRARY.

. The PROGRAM is not IN the MEMBER or IN the LIBRARY.

. The MEMBER and LIBRARY columns are for the COPYMEMBER and not for
the PROGRAM.

To avoid ambiguity in the presentation of unrelated results, the display shows separate
output on different lines with one line for the COPYMEMBER IN PROGRAM
relationship, and one line for the COPYMEMBER IN MEMBER and the MEMBER IN
LIBRARY relationship. The letters n/a are displayed where there is no relationship.

The ATTRIBUTES BLOCK
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After entities and their relationships are defined through the ENTITY_RELATIONSHIP
BLOCK, the ATTRIBUTES BLOCK lets you perform these tasks:

. Specify attributes of entities and actions on attributes.
. Apply selection criteria to the generated results.
. Modify the format of the results.

. Request additional information for specific entities.
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The ATTRIBUTES BLOCK and all of its statements are optional. Specify attributes for
any, all, or none of the entities named in the ENTITY RELATIONSHIP BLOCK. Figure 28
is an example of the ATTRIBUTES BLOCK.

Figure 28 « Query Language Syntax - ATTRIBUTES BLOCK Example

ENTITY RELATIONSHIP BLOCK
PROGRAM HAS DATA
ATTRIBUTES BLOCK
PROGRAM
SORT DESCENDING
BLANK WHEN REPEATED
DATAITEM
SORT ASCENDING
BLANK WHEN REPEATED
TITLE "DATA NAMES"
WIDTH 35

These are the ATTRIBUTES BLOCK syntax rules:
. Keywords can be placed anywhere on the line.
. Multiple statements are allowed in a single line.

. The first item in the ATTRIBUTES BLOCK must be an entity named in the
ENTITY_RELATIONSHIP BLOCK. Any number of attributes statements can follow
this entity name. All statements apply to this entity until another entity is named.

. Optional keywords within each statement are shown between braces ({and}).

. The vertical bar (|) denotes an OR condition, indicating that only one of the
keywords can be selected.

For readability, each statement should be indented and separated. These are the valid
attributes and actions for the ATTRIBUTES BLOCK:

. SELECT
. TITLE

. WIDTH
. SORT

. FORMAT BLANK WHEN REPEATED
. BREAK ON CHANGE INSERT

. POSITION

. DATAITEM entity attributes

. DSN entity attributes

. LANGUAGE entity attribute
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SELECT

52

The SELECT attribute selects or discards data from the query result producing a subset of
the data from the AKR. The SELECT clause is followed by the condition including an
operator and selection criterion. Depending on the entity ATTRIBUTE, you might enclose
the selection criterion in quotes.

You may specify multiple selection criteria for an entity kind. When you specify more
that one selection criterion, each is joined by a conjoint, AND or OR.

This is the syntax of the SELECT clause:
SELECT <entity> WHEN <attribute> <operator> <value>
where:

entityis PROGRAM, DATAITEM, etc.
attributeis NAME, SIZE, PICTURE, etc.

The WHEN keyword is optional. Parentheses are not allowed. Use an asterisk (*) as a
wildcard in the 'text' string to specify any characters, for example:

'"ABC*' Indicates any name beginning with ABC.
'"*ABC'  Indicates any name ending with ABC.

'*ABC* ' Indicates any name containing ABC.

As the query retrieves data during its execution, the entity value is compared to the string,
and then either selected or discarded, depending on the operator. You may enter only one
select statement for each entity. If you specify, for example:

RECORD
SELECT WHEN EQ "*MASTER*" AND NE "PAY-MASTER"

then only RECORD entities that contain the text "M ASTER" anywhere in their name and
that are not named "PAY-MASTER" are included in the query result.



TITLE

WIDTH

4 Using the Query Facility

SELECT criteria are evaluated sequentially, by order of appearance. Every SELECT
criterion is evaluated. When all SELECT criteria have been evaluated, the data selection
indicator is tested to determine whether the data should be included in the results. Use
multiple SELECT criteria carefully to ensure that the results contain the data you expect.
If you specify, for example:

RECORD
SELECT WHEN EQ "*MASTER*" AND NE "PAY-MASTER"
OR EQ "*TRANSACTION*" AND NE "HOLD-TRANS*"

then the query result includes:

. RECORD entities that contain "MASTER" anywhere in their name and are
not named “PAY-MASTER”

. RECORD entities that contain “TRANSACTION” anywhere in their name
and whose name does not begin with “HOLD-TRANS”

The TITLE attribute changes the column title. The default column title is the entity kind
name exactly as it is specified in the ENTITY_RELATIONSHIP BLOCK (including
capitalization). For example, use this attribute to change the FD entity title to File
Description. The title itself can be any text and must be enclosed in either single or
double quotes, provided that the ending quote matches the starting quote. This feature
enables you to embed quotes in the title, as in "Job’s PROC".

The WIDTH attribute changes the width of the column. The default width is wide enough
to prevent truncation. You must specify a positive numeric integer for the column width.
If the WIDTH attribute specifies, for example:

WIDTH 10
then the column width for the entity is 10 characters.
To hide a column, you specify a width of zero (0). Although this prevents entities from

being displayed, they are still required in the query syntax to define the search path for
the retrieval of application data from the AKR.
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For example, you could modify the query defined in Figure 26 on page 49 to include a
WIDTH 0 statement for the entity MEMBER, as shown in Figure 29.

Figure 29 « Example of WIDTH 0 Attribute in a Query

000001 ENTITY RELATIONSHIP BLOCK
000002 COPYMEMBER IN PROGRAM
000003 COPYMEMBER IN MEMBER
000004 MEMBER IN LIBRARY
000005

000006 ATTRIBUTES BLOCK

000007 COPYMEMBER

000008 ON CHANGE INSERT BLANK LINE
000009

000010 MEMBER

000011 WIDTH O

Figure 30 shows the result of the modified query.

Figure 30 « Example of Query Results Showing WIDTH 0

Name: VIABQCPS - Copybook / Program cross-reference
COPYMEMBER PROGRAM LIBRARY

COPY0005 VIAIO40 n/a

COPYO0005 n/a ASG.VIA.SOURCE

COPYO0010 VIAIO40 n/a

COPY0010 n/a ASG.VIA.SOURCE

SORT

The SORT attribute enables you to sequence the query result in ascending or descending
order. You may choose a different sort order for each entity in the result.

This statement must be used for any entity that has a BREAK or a FORMAT BLANK
WHEN REPEATED attribute specified.

FORMAT BLANK WHEN REPEATED

The FORMAT BLANK WHEN REPEATED attribute causes blanks to print in the place
of the text value of an entity if that text is the same as the preceding line. This statement is
used to enhance the readability of the output. The FORMAT keyword is optional, but you
must specify the SORT attribute.
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BREAK ON CHANGE INSERT

POSITION

The BREAK ON CHANGE INSERT attribute causes a blank line or a page break to be
inserted between two lines in the query result when the value of an entity changes on two
consecutive lines. Use this statement to enhance the readability of the output.

On the screen, a page break is denoted by a line of dashes (- - -). For printed reports, a
physical page break occurs. The BREAK keyword is optional.

The POSITION attribute is used to place one column of the output before or after another.
This statement does not affect the sequence in what data is retrieved. Specify the target
position either by name or by column number.

For example, if the only selected entities are FD and PROGRAM, you could specify the
FD attribute "POSITION AFTER PROGRAM" or "POSITION AS 2" to display the
PROGRAM column first. Specifying the FD attribute "POSITION BEFORE
PROGRAM" is unnecessary because that is the default order. To position a column after
a dataitem attribute such as LEVEL, specify "POSITION AFTER DATAITEM:
LEVEL".

DATAITEM Entity Attributes

Include extended entity attributes in the ATTRIBUTES BLOCK for the entity kind
DATAITEM. These entity attributes provide additional columns in the query result to
display more information about a data item entity besides its default NAME attribute.

In addition to DATAITEM attributes, the CRUD attributes (Create, Read, Update, and
Delete) are now valid on these entities: FD, DD, IDMS record, DB2 table, IMS segment.

Include multiple entity attributes in a query, as shown in Figure 31. The entity
ATTRIBUTE keyword is required for each attribute included in the query. All attributes
can be used with entity attributes.

Figure 31 « Example of Multiple Entity Attributes in a Query

000026 ATTRIBUTES BLOCK

000027 DATAITEM

000028 TITLE "DATA ITEM"
000029 SORT ASCENDING
000030 FORMAT BLANK WHEN REPEATED
000031 ATTRIBUTE REF
000032 ATTRIBUTE SIZE
000033 ATTRIBUTE LEVEL
000034 ATTRIBUTE OFFSET
000035 ATTRIBUTE POSITION
000036 ATTRIBUTE REDEFINES
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Valid entity attributes are listed below in alphabetical order. Figure 32 on page 58 and
Figure 33 on page 58 show an example of a query where these attributes are used.

Attribute SELECT Clause
Name Description Must Specify
ARITH Use to specify if a data item is part of an ~ Positive number or zero,
arithmetic statement. not enclosed in quotes
COND Use to specify if a data item is part of a Positive number or zero,
conditional statement. not enclosed in quotes
CREATE Use to specify if a data item is part of a "Y' or 'N'
Create activity, as defined by ESW.
DELETE Use to specify if a data item is part of a "Y' or 'N'
Delete activity, as defined by ESW.
LANGUAGE Use to specify the language that generates COBOL, PL/I, ASM,
the entity kind. See "LANGUAGE Entity Natural
Attribute" on page 60 for more details.
LEVEL Use to indicate a level number of the data  Positive number or zero,
item, as coded in source module. not enclosed in quotes
MOD Use to indicate the number of Positive number or zero,
modifications of data item, as defined by  not enclosed in quotes
ESW. This includes occurrences of the
dataname where its value is being tested or
used.
OCCURS Use to specify if a data item is the subject Positive number not
of, or is subordinate to the subject of an enclosed in quotes
OCCURS clause. The resulting display
shows the number of occurrences, as
specified in the OCCURS clause. A blank
or zero result indicates that the data item
has no associated OCCURS clause.
OFFSET Use to indicate the distance (in bytes) from Positive number or zero,

the start of the record to the data item entity
(that is, how many bytes in the record
precede the data item).

not enclosed in quotes
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Name

Description

4 Using the Query Facility

SELECT Clause
Must Specify

PICTURE Use to lists the PICTURE clause of the data  Alphanumeric character
item. The PICTURE column does not enclosed in quotes
identify packed fields. In order to
determine whether field is packed, use
entity attribute SIZE in conjunction with
PICTURE.

POSITION Use to indicate the first byte of the data Positive number, not
item relative to the owning record (that is, enclosed in quotes
the position of the first byte of the data
item).

READ Use to specify if the data item is part of a "Y' or 'N'

Read activity, as defined by ESW.

REDEFINES  Use to list the object of a REDEFINES Alphanumeric character
clause or a data item that is subordinate to enclosed in quotes
the object of a REDEFINES clause.

REF Use to indicate the number of references to  Positive number or zero,
the data item, as defined by ESW. This not enclosed in quotes
includes occurrences of the dataname
where its value is being tested or used.

SIZE Use to list length (in bytes) of the data item Positive number or zero,
field. not enclosed in quotes

UPDATE Use to specify if the data item is part ofan 'Y' or 'N'

Update activity, as defined by ESW.

USE Use to indicate the number of uses of the  Positive number, not
data item, as defined by ESW. This enclosed in quotes
includes occurrences of the dataname
where its value is being tested or used.

VALUE Use to list the content of a VALUE clause Alphanumeric character

for the data item.

enclosed in quotes

You can include these in the statement, MOVE A TO B:

USE and REF with data item A

MOD and REF with data item B
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You can include these in the statement, IF A = B:

USE, REF and COND with data item A

USE, REF and COND with data item B

In Figure 32, the query includes the entity attributes LEVEL, SIZE, PICTURE, and
REDEFINES. Note that the entity attribute REDEFINES uses the WIDTH attribute.

Figure 32 « Example of DATAITEM Entity Attributes in a Query

ENTITY RELATHIPSHIP BLOCK
DATAITEM DEFINED-IN PROGRAM

ATTRIBUTES BLOCK
DATAITEM
TITLE "Data item"
SORT ASCENDING
FORMAT BLANK WHEN REPEATED
ATTRIBUTE LEVEL
ATTRIBUTE SIZE
ATTRIBUTE PICTURE
ATTRIBUTE REDEFINES
WIDTH 15

PROGRAM
TITLE "PROGRAM"
SORT ASCENDING
FORMAT BLANK WHEN REPEATED

Figure 33 shows the result of the modified query.

Figure 33 « Example of Query Results with DATAITEM Entity Attributes

Query Facility Rl -0MLYY
Command ===r o Scroll ===r C5R
Mame: DTHMATTR - SAMPLE QUERY TO SHOW ATT 1 of 71
3
Data item Lewel size picture = redefines
CCWS-C-1 o1 119
CCWS-C-2 o1 120
CCWS-E-1 o1 120
CCWS-E-2 o1 1aE
CCWS-E-2-2 o2 43
CCME-E-3 o1 120
CCWS-E-4 o1 =10
CCWS-E-4-1 o2 3 HER
CCWS-E-4-2 o2 3 HER
CCME-H-1 o1 120
CCW5-H-2 o1 120
CCWS-H-3 o1 120
CCWS - PG - 10 a1 S H(3)
Cr-18%a 0] 20 COMPUTED -A
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DSN Entity Attributes

For the entity kind DSN, include extended entity attributes in the ATTRIBUTES BLOCK
to provide information about a dataset name entity, in addition to its default attribute

NAME.

4 Using the Query Facility

The entity attribute DISPOSITION specifies the characteristics of a DSN, as established in
the JCL member of reference. The SELECT clause for the DISPOSITION attribute must

contain ‘NEW’, ‘OLD’, ‘MOD?”, or ‘SHR’. The DISPOSITION entity attribute is valid for
DSN only.

Figure 34 is an example of the syntax for a query containing a DSN entity with the
DISPOSITION attribute.

Figure 34 « Example of a DSN Entity with the DISPOSITION Attribute in a Query

000001
000002
000003
000004
000005
000006

ENTITY RELATIONSHIP BLOCK
DSN IN DD
ATTRIBUTES BLOCK
DSN
TITLE ’'DATASET NAME’
ATTRIBUTE DISPOSITION
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Figure 35 shows an example of the results of a query containing a DSN entity with the
DISPOSITION attribute.

Figure 35 « Example of query results with a DSN entity and the DISPOSITION attribute

Query Facility REBET-AL
Command ===r _ Scroll ===r C5R
Mame:  DSHWDRISF - A SAMPLE QUERY TO SHOW DSH WITH DISP 1 of 44
DATASET MAME disposition DD
DEY.LOADLIE SHR: STEFLIE
LEY. FTAP SHR FTAF
DEY.CDS. MOHITOR SHR: COMOHRAN
DEY. INPUT. TOCDS SHR COPATRIN
DEY.CDS. VLD TREHS HEW COPYRAOUT
DEY. LOADLIE SHR STEFLIE
DEV.FTAP SHR: FTAF
DEY. C'S. REFREHCE SHR TEXTREF
DEY.CDS. MOMHITOR SHR: COMONRAN
DEY. CDS. VLD TRHS SHR COPATRIN
DEV. CD'S. COCHUREF HEW COCHOREF
DEY.CDS. BACSFILE HEW BACSTAPE
DEY.LOADLIE SHR: STEFLIE
DEY. CLS. REFREHCE SHR TEXTREF

LANGUAGE Entity Attribute

The entity attribute LANGUAGE causes the display of the language that generated the
entity kind. The languages include COBOL, PL/I, Assembler, and NATURAL. The
LANGUAGE attribute is valid for these entities:

. PROGRAM/PROCEDURE/FUNCTION e RECORD/STRUCTURE/DSECT
J ENTRY J DATAITEM
. FD/FILEVAR/DCB . CSECT

Figure 36 shows a query that includes the entity attribute LANGUAGE.

Figure 36 « Example of the LANGUAGE Attribute in a Query

goaaal ENTITY_RELATIONSHIF EBLOCK
QREEEZ FROGRAM HAS DATAITEM
QA2

oaEaa4 ATTRIBUTES BLOCK

Qoaaas DATARITEM WIDTH 12

QRAEEE ATTRIEBUTE LANGUAGE WIDTH & TITLE "LAMG"
QEAAAT ATTRIBUTE SIZE WIDTH 4

QaAAES ATTRIBUTE OFFSET WIDTH 4 TITLE "0OFST"
oaaaas ATTRIEUTE CREATE WIDTH 1 TITLE "C"
gEaa1E ATTRIEBUTE READ WIDTH 1 TITLE "R"
QEEE11 ATTRIBUTE UPDATE WIDTH 1 TITLE "U"
oaEaa12 ATTRIBUTE DELETE WIDTH 1 TITLE "D"
ooaaLs ATTRIEBUTE POSITIOM WIDTH 3 TITLE "POS"
QEEE 14 ATTRIEBUTE LEWEL WIDTH 3 TITLE "LWL"
oaEaa1s ATTRIBUTE OCCURS WIDTH 2

QaEAA1E ATTRIBUTE PICTURE WIDTH 1@

ooaaLy ATTRIEBUTE YALUE WIDTH 3
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Figure 37 shows the results of a query that includes the entity attribute LANGUAGE.

Figure 37 « Example of Query Results with the LANGUAGE Attribute

Query Facility AEBBEY -AL
Command === Scroll ===r CER
Mame:  PGMWLANG - A SAMFLE QUERT TO SHOW PROGRAM WITH LAM 1 of 200...
FROGRAM CATAITEM LAMG  SIZE OFST C R U [ POS LYL URS PICTURE VYALLE
Cha3A334  BACS-DATE COEOL E BHHHHN 1 a1
ChOZA334  BACS-DD COBOL 2 BHHHH 1 083 93
C0AZA334  BACS-MM COBOL 2 ZHHHHN 2 0F 99
ChO3A334  BACS-TT COEOL 2 4 HHHHN 5 0F 33
ChA3A384 BACS-DATE-x=x COBOL 4 BHHHHN 1 81
ChAZA334  BACS-DATE-XE COBOL 3 IHHHHN 2 03 HEE
ChAZA334  HEXT-BACS-DA COBOL 4 BHHHHN 1 a3 902
C0O3A334  WA-ACCUMULAT COEOL 13 BHHHHN 1 a1
ChA3A3E34  WA-HO-0F-WOR COBOL 3 BHHHHN 1 83 2303) +0
C0AZA334  WA-POUT-REC- COBOL 3 THHHH 4 @©5 59(5) +0
C0AZA334  WA-POUT-REC- COBOL e EHHHHN 7T 0F S905) +0
C0O3A334  WA-POUT-CASH COEOL -] SHHHH 10 B35 5309)v393 4@
cha3A3e3d4  WD-DTYMAMIC-C COBOL =] BHHHHN 1 a1

o] BHHHHN 1

ChoZA334  DATES COBOL Qs ®ig 'SEME

The SELECTION BLOCK

After you define the selection criteria in the ATTRIBUTES BLOCK, the SELECTION
BLOCK lets you append additional syntax to a SELECT clause, enhancing query
capabilities to allow:

. AND/OR logic between attributes
. AND/OR logic between entities

. Grouping of elements with parentheses ‘( and )’

The SELECTION BLOCK and all of its statements are optional. Specify attributes for any,
all, or none of the entities named in the ENTITY RELATIONSHIP BLOCK.
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Figure 38 is an example of the SELECTION BLOCK.

Figure 38 * Query Language Syntax - SELECTION BLOCK Example

ENTITY RELATIONSHIP BLOCK
PROGRAM HAS DATAITEM
ATTRIBUTES BLOCK
PROGRAM
SORT ASCENDING
DATAITEM
SORT ASCENDING
BLANK WHEN REPEATED
TITLE "DATA NAMES"

WIDTH 35
SELECTION BLOCK
SELECT DATA ITEM WHEN (NAME = '*YEAR*') AND
(SIZE > 1)
SELECT PROGRAM WHEN (NAME = 'ABC*')

These are the SELECTION BLOCK syntax rules:

. The first item in the SELECTION BLOCK must be an entity named in the
ENTITY RELATIONSHIP BLOCK. Any number of attributes statements can
follow this entity name. All statements apply to this entity until another entity is
named.

. Optional keywords within each statement are shown between braces ({and}).

. The vertical bar (|) denotes an OR condition, indicating that you can select only one
of the keywords.

. Keywords can be placed anywhere on the line.
. Multiple statements are allowed in a single line.

. For readability, each keyword should be indented and separated.
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Using Queries

Qualifying Entities in Queries

When an entity is used multiple times within a query, you must qualify it to ensure that
the desired search path is created. For example, in a query designed to display
program-calling chains, you need to specify the programs and the entries that they call.
Then, the query contains the program containing the called entry and any entries that
program calls. Repeat this process until the calling chain is exhausted.

In Figure 39, the query contains two references to the entity PROGRAM. The second
reference to PROGRAM must be qualified by ENTRY to correctly inform the query
processor that ENTRIES called by the second reference to program are to be generated.

If the PROGRAM name was not qualified in this line, it would be unclear whether
PROGRAM refers to the calling program or the called program. Without qualification,
the first occurrence of PROGRAM is assumed.

Figure 39 « Example of Qualified Entity Names in a Query

PG CALLS ENTRY

PGM CALLS

This is the code for this query:

ENTITY_RELATIOHSHIP
PROGEAM CALLS ENTEY
ENTRY IN PROGRAM
ENTRY .PROGRAM CALLS
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Aliasing Entities in Queries

64

Some queries require additional entity qualification. For example, extensive entity name
qualification is necessary to provide the complete search path for the query in order for it
to trace the flow of CALLs from program to subprogram on many levels.

Figure 40 shows an example of extensive entity qualification in the
ENTITY RELATIONSHIP BLOCK of a query.

Figure 40 « Example of Extensive Entity Qualification in a Query

000001 ENTITY RELATIONSHIP BLOCK

000002 =*

000003 PROGRAM CALLS ENTRY

000004 PROGRAM.ENTRY IN PROGRAM

000005 PROGRAM.ENTRY .PROGRAM CALLS ENTRY

000006 PROGRAM.ENTRY .PROGRAM.ENTRY IN PROGRAM

000007 PROGRAM.ENTRY .PROGRAM.ENTRY.PROGRAM CALLS ENTRY
000008 PROGRAM.ENTRY . PROGRAM.ENTRY . PROGRAM.ENTRY IN PROGRAM

In this query, entity qualification quickly becomes difficult to follow. Entity aliasing
provides a way to simplify the entity qualification required to complete the query. To use
entity aliasing, specify any name in parentheses after the entity name. The name in the
parentheses becomes the alias for the entity immediately preceding the alias name,
including the complete qualification for the entity, as shown in Figure 41.

Figure 41 « Example of Entity Aliasing in the ENTITY_RELATIONSHIP BLOCK of a Query

000100 ENTITY RELATIONSHIP BLOCK

000200 =*

000300 PROGRAM CALLS ENTRY

000400 PROGRAM.ENTRY (PROG-ENT-1) IN PROGRAM

000500 (PROG-ENT-1) . PROGRAM CALLS ENTRY
000600 (PROG-ENT-1) PROGRAM.ENTRY (PROG-ENT-2) IN PROGRAM
000700 (PROG-ENT-2) PROGRAM CALLS ENTRY

In this example:

. prog—-ent-1 becomes the alias for PROGRAM.ENTRY.

. prog-ent-2 becomes the alias for (prog-ent-1).PROGRAM.ENTRY, that is,
PROGRAM.ENTRY.PROGRAM.ENTRY.

In both cases, Alliance interprets the actual query statement as if it contains the
substituted name.
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Use entity aliasing in the ATTRIBUTES BLOCK with the same properties that you used in
the ENTITY_RELATIONSHIP BLOCK. Figure 42 shows an example of a query with entity
aliasing in the ATTRIBUTES BLOCK.

Figure 42 « Example of Entity Aliasing in the ATTRIBUTES BLOCK of a Query

000001 ATTRIBUTES BLOCK
000002 =*

000003 PROGRAM

000004 TITTLE 'A calls'
000005 SORT ASCENDING
000006 WIDTH 10

000007 PROGRAM

000008 TITLE "Start Pgm"
000009 SORT ASCENDING
000010 (prog-ent-1)

000011 WIDTH O

000012 (prog-ent-1) . PROGRAM
000013 TITLE "A calls"
000014 WIDTH 10

For an alphabetical listing of all entities recognized by Alliance, see "Valid Entities and
Relationships" on page 117.

Creating Custom Queries

Whether you are modifying standard queries, editing an open query, or creating a brand
new query, you follow the same basic procedures to generate custom queries.

To create a custom query
1 Create a new query language source file (see page 68).
2  Define the query to Alliance (see page 68).

3 Execute the query (see page 69).

65



ASG-Alliance User’s Guide

Creating New Query Language Source Files

To modify standard queries or to construct entirely new displays, create new files
containing the query language source needed to produce the display. These files define
the displays that appear when you make a selection from the System Cross-reference
Information View pull-down.

These are the system cross-reference source files:

File Name Report Name

VIABQCDD CICS File cross-referenced by Program
VIABQMAP CICS Map cross-referenced by Program
VIABQDSC DSN cross-referenced by Copybook
VIABQDSN DSN cross-referenced by Job

VIABQDSG IMS DBD cross-referenced by Segment
VIABQSEG IMS PSB cross-referenced by Program
VIABQIJBS Job cross-referenced by JCL Library
VIABQJBL Job cross-referenced by JOBLIB
VIABQLMO Job cross-referenced by Load Module
VIABQSTL Job cross-referenced by STEPLIB
VIABQREC Job cross-referenced by FD

VIABQIJBC JOBCAT cross-referenced by Job
VIABQLMP Load Module cross-referenced by CSECT
VIABQLMD Load Module cross-referenced by Job
VIABQPRC PROC cross-referenced by Load Module
VIABQSTC STEPCAT cross-referenced by Job
VIABQDBF Natural database cross-referenced by Adabas EDT
VIABQDFF Adabas FDT cross-referenced by FDT field
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File Name Report Name

VIABQDDM

Natural database cross-referenced by Natural DDm

VIABQDMF

Natural DDm cross-referenced by DDM field

These are the program cross-reference source files:

File Name

Report Name

VIABQCLD Called Program cross-referenced by Caller
VIABQCLS Caller Program cross-referenced by Called
VIABQTRN CICS Transactions cross-referenced by Program
VIABQCPS Copybook cross-referenced by Program

JCL INCLUDE:sS cross-referenced by JCL
VIABQDAT Dataitem cross-referenced by Program
VIABQFD FD name cross-referenced by Record
VIABQPTR Program cross-referenced by CICS Transaction
VIABQFIL Program cross-referenced by File
VIABQCPY Program cross-referenced by Copybook

JCLs cross-referenced by JCL INCLUDESs
VIABQDCP Program cross-referenced by Dataitem
VIABQPDM Program cross-referenced by Natural DDM
VIABQWKF Program cross-referenced by Natural Workfile

To modify a template query source file

1 Locate the name of the member containing one of the standard queries.

The files containing the query language source are installed in this dataset:

<ASG>.<CENTER>.CNTL

where ASG and Center are defined by the installer at your site.
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Use your system editor to modify the source file as needed. For query language
syntax information, see "Understanding Query Language Syntax" on page 46.

To preserve the original source file unchanged, save the changed file under a new
member name. Otherwise, the changed version replaces the original query source.

To edit an existing query source file while the query results are displayed

1

5

Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

Select Edit » Query and press Enter. The system editor screen displays showing the
query source file.

Modify the source file definition as needed.

Use the ISPF CREATE command to create a new member in the same or a different
dataset.

Use the ISPF CANCEL command to avoid modifying the original query source.

To create a new query source file

1

2

Open your system editor.
Create a source file.

The file must be sequential or a member of a PDS, and contain 80-byte fixed length
records.

Use the information in "Understanding Query Language Syntax" on page 46 to
specify the contents of the file.

Save the file under a new member name in the default dataset
(ASG.CENTER.CNTL) or in a different one.

Defining a Query to Alliance

After you create a new query language source file, you must define the query to Alliance.

To define the new query

1 Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

2 Select Facility » Query and press Enter.

3  Select File » New query and press Enter.
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On the New Query pop-up, type the name, description, and dataset name of the file
containing the query in the appropriate fields. If the dataset is a PDS, include the
member name in the dataset name.

Note:
If you enter a dataset member that does not exist, you receive a Member Not
Found message. To create the member, press PF4 to display a blank query editor
screen .

To edit the query, press PF4. To immediately generate results, press PF5.
Press PF3 to record and open the query.

Press PF12 to cancel the request.

Executing a Custom Query

Generate query results from the Query facility after you create a new source file and
define the query to Alliance.

1

For step-by-step instructions on saving and printing query information, see "Saving and
Printing Query/Search Results" on page 41.

To execute the query when the query is not open

1

Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

Select File » Open query and press Enter.

Type any character in the selection area to the left of the query name on the
Open query pop-up and press Enter.

Press PF5 to generate the query. The Query Facility screen displays the query results.

Note:

The message QUERY OPEN FAILED displays if a syntax error is encountered.
Press PF1 to display more information about the error.

Press PF3 to close the query and return to the previous screen.
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To execute the query when the query is already open

1 Select Facility » Query from the Alliance Primary screen and press Enter. The Query
Facility screen displays.

2 Select File » Open query and press Enter. Select a query from the list displayed on
the Open Query screen.

3 Select Generate » Query Results and press Enter. The Query Facility screen displays
the results of the query.

Note:

The message QUERY OPEN FAILED displays if a syntax error is encountered.
Press PF1 to display more information about the error.

4  Press PF3 to close the query and return to the previous screen.

Local Synonym Query

The query facility in Alliance enables you to query program-level local synonyms using
the LOCALSYNONYM relationship. Issue the Entity-Relationship DATAITEM
LOCALSYNONYM DATAITEM within your query to have Alliance generate local
synonyms in the given program. The relationship SYNONYM continues to work as
before. This generates global synonyms across an application.

Searching for Specific Entities

70

As the information collected brings you closer to building a list of possible targets, use
more involved search options to focus on specific entities that might be impacted by the
change. Besides the identification of synonyms and homonyms, use the search function to
conduct application-wide searches for the location of specific entities, entity kinds, and
literal strings. Run searches from either the Impact or the Query facility. For step-by-step
instructions on synonym/homonym identification, see "Running Searches" on page 30.

To search for specific entities

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

2 Select Search » Entities and press Enter.
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3 In the text field of the Search Entities Selection Criteria pop-up, choose an action:

. To only list entities with an exact name (a maximum of 40 characters), type
the complete name of the entity.

. To list all entities that match a pattern, type the partial name of the entity
using wildcards (*).
4  Select one or more entity kinds.
5  Press Enter to initiate the search for entities that match the criteria you defined.

The Search pop-up displays with the list of entities.

6  Type any character in the selection column beside the entities you want to select and
press PF4 to initiate the search.

The Search View screen displays with the list of entities Alliance identified. Each
entity definition is listed with this information:

. Entity name
. Entity kind

. Qualification for the entity name

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 41.

7  Toexitthe Search View pop-up without saving the search results, press PF3 and then
Enter.

Figure 43 shows an example of entity search results in the Search View screen.

Figure 43 « Example of Entity Search Results

File Edit Wiew Worklizt oOptions Help
Fearch Uiew DEZT269
Connand ===z _ ECroll ===k CER
1 of 17E
HEE
ZEARCH REZULTE
Baze Target HE
Requested Entities o DATAITEH
Nane kind Qualification
A-CHILD1 DATAITEH A-PARENT OF A-RECORD OF HOVEL OF VIR0
A-CGHILD:2 DATAITEH A-PARENT OF A-RECORD OF HOUEL OF UIAS0
A-DATE DATAITEH HOVEL OF UIASOFT.CUST.COEOL[DE2726%9)
A-FHRENT DATAITER A-RECORD OF HOVEL OF DIASOFT.CUST.COBOD
A-RECORD ODATAITEH HOVEL OF UIASOFT.CUST.COEOL[DE2726%9)
E-DATAITEH ODATAITEH HOVEL OF UIASOFT.CUST.COBOL[DE2726%)
E-DATE DATAITEH HOVEL OF UIASOFT.CUST.COBOL[DE2726%)
C-DATAITERH DATAITEH HOUEL OF UIASOFT .CUST.COBOL[DE2T269)
C-DATE DATAITEH HOVEL OF UIASOFT.CUST.COEOL[DE2726%9)
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To search for literal strings

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Or

Select Facility » Query from the Alliance Primary screen and press Enter. The
Query Facility screen displays.

Select Search P Literals and press Enter.

In the text field of the Literal Criteria pop-up, type a text search pattern to list entities
having that pattern in their name (a maximum of 38 characters).

Press Enter to initiate the search for entities that match the criteria you defined. The
Literal Selection pop-up displays with the list of entities.

Type any character in the selection column beside the entities you want to select and
press PF4 to initiate the search. The Literals View screen displays with the list of
entities Alliance identified. Each literal is listed with this information:

. Literal name

. Location of use

For step-by-step instructions on saving and printing search information, see "Saving
and Printing Query/Search Results" on page 41.

To exit the Literals View pop-up without saving the search results, press PF3 and
then Enter.

Figure 44 shows an example of entity search results in the Literals View screen.

Figure 44 « Example of Literal Search Results

File Eait Uiew Worklist dptions Help

Literals View REBEY-AL
CoHnand ===k _ Foroll ===k GER
1 of &
FhE
Literal Zearch Rezults:
Literal Location of Uze
TOP OF DATA
+0E WIAALL 8. ABEEY « COEL [ CO1 S0P GH )
+108 VIAALL 8. ABEEY . COEOL [ COZEAPGH ]
+i2 VIAALL 8. ABEEY . COEOL [ GO BEFGH )
UIAALL®.ABEEY . COBOL [ COZOERGH ]
VIAAL1 8 .ABEEY . COBOL [ COOSARGH |
VIAAL1 8. ABEEY . COBOL [ 01 S0PGH)
VIAAL1®.ABBEY . COBOL [ COLSAPGH )
+1223 VIAALL®.ABEEY . COBIL[COL1aFGH ]

EOTTOH OF DATH
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Building the List of Possible Targets (Impact List)

When you have gathered enough cross-reference and synonym/homonym data, start the
impact analysis by building the impact list. An impact list consists of the unique entities
(names and kinds) from an application. Use the impact list to find potential impact
analysis targets when you generate an impact analysis. To build the impact list, define
selection criteria to which Alliance compares all of the entities in the application to
identify possible candidates. Figure 45 shows an example of the Impact Entity List
screen.

Figure 45 « Example of an Impact Entity List

File Eait UView Worklist oOptions Help

Literals Uiew AEEBEY-AL
CoHHand ===} _ FCPOll ===} CIR
1 of &
s
Literal Zearch Results:
Literal Location of Use
TOF OF DATHA
g UIAALL & .AEBEY . COBOL [CO1 S0P GH]
+1am UIAALL & .AEBEY . COBOL [CO2EAPGH]
12 UIAALL & .AEBEY . COBOL [CO1OEPGH]

UIAALL & .AEBEY . COBOL [CO2OERGH]
UIAALL & .ABBEY . COBOL [COBSAPGH]
UIAALL & .ABBEY . COBOL [CO1 S0P GH]
UIAALL & .ABBEY . COBOL [CO1SAPGH]
+1223 VIAALL B ABEEY . COBOL (CD118PGH)
EOTTOH OF DATAH

If you do not specify the impact list, Alliance submits all of the entity kinds in the
application for analysis. The impact list is the tool Alliance uses to derive the base
selection list, which is the starting point for the impact assessment. For a representation of
the impact analysis process, see Figure 45 on page 73. For step-by-step instructions on
starting the impact analysis and generating a base selection list, see "Selecting Items to be
Analyzed" on page 80.

You can save the impact list to a worklist for future use in either this or in other impact
analyses. Also, you can create an impact list from components in one application and use
it to select targets in other applications.

73



ASG-Alliance User’s Guide

To create an impact list

1 Select File » Open application from the Alliance Primary screen and press Enter. The
File - Open Application pop-up displays (see Figure 46).

Figure 46 * File - Open Application Pop-up

File - Open Application
Command ===*

Tupe AKR information and application name. Then press Enter.

Application Knowledge Repository (AKR):

Data set mame . . . ‘VIAUSERLAPPL.AKR’

fpplication name . . ABBEY¥-AL {blank or pattern for list)
¥olume serial . . . {if not cataloged)

Password . . . . . . {if password protected)

2 Type the AKR dataset name in the Dataset name field on the File - Open Application
pop-up.

3 If you know the name of the application you want to open, type the name in the
Application name field and press Enter. Otherwise, leave the field blank.

Or

To choose an application from the list, enter a text pattern and press Enter. The
File - AKR Application Director pop-up displays. Press Enter.

4  Select Facility » Impact and press Enter.

5  Select File » New impact list and press Enter.

6  Type a unique name and description for the impact list on the New Impact pop-up
and press PF4. The Impact Entity List pop-up displays. Since this is a new impact

list, there are no defined entities listed. Y ou can also use this pop-up to add and delete
entities.
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Press PF4 on the Impact Entity List pop-up. The Impact Entities Selection Criteria

screen displays (see Figure 47).

Figure 47 « Impact Entities Selection Criteria Screen

Impact Entities Selection Criteria
Command === Scroll ===* C5R

Textl #*
Entity kind {(Default = ALL]

ARERA

CATALOG
CICS-TRANSACTION
COLUMN
COPYMEMEERINCLUDE
Csh

CSECT

CURSOR

DATABASE
DATAITEM

DED

DD

DsH

PFE=5elect all PFE=Unselect all

On the Impact Entities Selection Criteria pop-up, choose an action:

Type the full name of an entity.
Or

Type a pattern for selection in the Text field.

Note:

If you enter a pattern and want to limit the entity kinds selected, specify one or more
entity kinds by entering any character in the selection column to the left of the

entity name.
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9  Press Enter. The Add Impact List Entity screen (see Figure 48) displays with the list
of entity names that matched the specifications entered on the Impact Entities
Selection Criteria pop-up. The list is scrollable.

Figure 48 « Add Impact List Entity Screen

Add Impact List Entity

Command ===* Scroll === LC5R
Select desired entries then press the Add keuy. 1 of 30853
Previously selected entries are marked with an asterisk.
Text: =*
Text Entity Kind
_ ‘CDhose’ ENTRY
_ ‘cpoesc’ EMTRY
_ ‘cbhion’ ENTRY
_ ‘cbioe’ EMTRY
_ 'CDhisn’ ENTRY
_ ‘CcDise’ EMTRY
_ ‘cbhzon’ ENTRY
_ ‘cbzoe’ EMTRY
_ ‘cbzoc’ ENTRY
_ ‘cbzop’ EMTRY

PFS=%elect all PFGE=Unselect all PFlO=Add

10 Type any character in the selection column beside the desired entity name. You can
select as many entities as needed.

11 When finished selecting entries, press PF10 to add the entries and return to the
Impact Entity List screen (see Figure 49).

Figure 49 « Impact Entity List Screen

Inpact Entity List
CoMHand ===k FCroll ===} CER

Press PF key for actions. Delete requires selection 1 of 2695
of entryls].

Current Sort Kewl MAHE

Entity Kind NaHe
_ PROGRAR-PROCEDOURE-FUNCTION «BRCE-DATE
_ PROGRAR-PROCEDURE-FUNCTION CDOSC-ERROR-CODES
_ PROGRAR-PROCEDOURE-FUNCTION DATEG-YY
_ PROGRAR-PROCEDURE-FUNCTION ME-DATES-TY
_ PROGRAH-PROCEDURE-FUMCTION ME-ETY
_ ENTRY ' CDAsE’
_ ENTRY e
_ ENTRY 'CcOieR’
_ ENTRY ':D1RE!
_ ENTRY 'CD1SE’

FFd=Rdd entity PF3=Delete entity FPF&=Change Zort
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To add entries, press PF4. To delete entries, select the entry and press Enter.
Press PF3 to return to the New Impact pop-up.
Press PF3 again to return to the Impact Facility screen.

Select File P Options to save or delete the impact list.

Or

Select Impact Facility » Edit to modify the option list. Use this impact list with any
open application.

Press Enter.
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Determining Impacted Components

This chapter describes the impact analysis and impacted componets, and contains these
sections:

Section Page

Selecting Items to be Analyzed 80
Locating Impacted Components and Relationships (Summary Impact 82
Analysis)

Listing the Relationships of Impacted Items (Detailed Impact Analysis) 84

As described in the overview, at this stage you identify and list the components that might
be impacted by the change and then submit the list to the Alliance Impact facility. To
assess the impact of change on the application, Alliance evaluates the flow of data and
hierarchical and entity relationships. Alliance uses the list of items you select for impact
assessment to derive a base selection list of components and to produce summary and
detailed analysis results.

The summary impact analysis identifies and locates the components impacted by the
change. The detailed impact analysis retraces the results of the summary analysis by
showing the path of each component included in those results to the members of the base
selection list. Based on your review of the first round of results, research any unknown
entity you discovered and then modify the initial parameters to rerun the analysis.
Step-by-step instructions on how to investigate the results of the impact analysis are
located in "Modifying the Impact Analysis" on page 99.

Save each round of results to a worklist. When the impact assessment is completed, you
might use these results as:

* A guide for the detailed investigation of individual programs, JCL, database
definitions, and other components

Input to ASG’s ESW or other editing tool to implement the required changes

. A scheduling tool to manage people and resources required to implement the
proposed changes
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Selecting Items to be Analyzed

80

As shown in Figure 50, Alliance automatically creates a base selection list from the
entities you select from the impact list during the first summary analysis. If a worklist is
open, the base selection list is saved to that worklist.

Figure 50 « The Impact Facility Process

Impact List

Analyzer

Selection

Synonyms,
Assignments,
Parents,
Children

Remove I "
Referential Rmpa;:
Answers esults

Base
Selection

(Generate
Pop-up)

To generate a base impact analysis

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select File » Open impact.

Or
Select File » New impact.
Press Enter

3 Select or enter impact name and press PF5 to display the Select Impact Generation
Entities screen.
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Start the impact analysis by selecting the items to be analyzed on the

Select Impact Generation Entities pop-up. The list of selected items is called the base
selection list (see Figure 51). Itis comprised of the occurrences of entities in the open
application that match the open impact list.

Figure 51 « Example of a Base Selection List

summary Impact - Select Impact Generation Entities

Command ===* Scroll ===* C5R
Eelect the items from which the impact list will 1 of 5435
e generated.

Text Entity Kind Qualification >
gy g S SR gy Sy Sy g g g g gy Sy g g Sy S S >
_ 'CDEsE’ ENTRY YIAAL1E, ABBEY.C
_ 'CDEsE’ ENTRY YIAAL1E, ABBEY.C
_ ‘'cpaesc! ENTRY YIAAL1E, ABBEY.C
_ ‘'cpaesc! ENTRY YIAAL1E, ABBEY.C
_ ‘'cpaesc! ENTRY YIAAL1E, ABBEY.C
_ ‘'cpaesc! ENTRY YIAAL1E, ABBEY.C
_ ‘'cpaesc! ENTRY YIAAL1E, ABBEY.C
_ ‘'cpaesc! ENTRY YIAAL1E, ABBEY.C
_ 'Chies’ ENTRY YIAAL1E, ABBEY.C
_ 'CDhimE’ ENTRY YIAAL1E, ABBEY.C
_ 'CDhimE’ ENTRY YIAAL1E, ABBEY.C
_ 'CDhimE’ ENTRY YIAAL1E, ABBEY.C

PFZ=0Options PFd=Generate PFS=Select all PFE=Hide entity kind

Use PF2 to review or designate the impact options to be applied to the impact
analysis.

Press PF4 to generate the impact analysis.

Review the analysis results, change base selection list, and refine impact options then
rerun the impact analysis.
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Locating Impacted Components and Relationships (Summary
Impact Analysis)

82

The summary analysis constitutes the first level of impact assessment results. After
selecting the items for the base selection list, specify the options that control how the
analysis is generated and execute the summary analysis. When finished reviewing the
summary analysis results, generate a detailed analysis to expand the information.

To generate a summary impact analysis

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select Generate » Summary and press Enter. The
Summary Impact - Select Impact Generation Entities pop-up displays all of the
occurrences of entities in the open application that match those in the open impact
list. The type of each entity is listed along with qualification information that
provides details on the occurrence location.

3 Type any character in the selection column beside the data items you want analyzed
and press Enter.

Or
Press PFS5 to select all of the entities.
4  Press PF2 to view or change the impact generate options (see Figure 52).

Figure 52 « Impact Generate Options Screen

Impact Generate Options
Command ===

select desired Impact Generate Options.
Include Base Selection in results
Include Copy Detaill in results

Base Impact Targets: Application Assignments

Targets Level Synonyms Ta Fram Alternates
#  Base Selection i _ _ _
# Parents of Base Selection £

Children of Base Selection

Expanded Impact Targets: Application Assignments

Targets Level Synonyms Ta Fram Alternates
£ Base Impact Targets £ _ _ _
£ Parents of Base Impact Targets £ _ _ _

Children of Base Impact Targets

PFd4=Restore ASG Default Ootions PFS=Detailed Ovotions
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These options control the type and format of the information displayed as the result
of impact analysis, as well as the components of the base selection list. If this is the
first time you have performed the impact analysis, ASG recommends that you use
the option defaults. Press PF4 to select default options.

Note:

For step-by-step instructions on modifying default impact generate options, see
"Specifying New Impact Generate Options" on page 110. Press PF3 to return to the
Summary Impact.

Press PF4 to generate the summary impact analysis. Analysis results display on the
Impact Facility screen (see Figure 53).

Save, append, and print the summary impact analysis results to a worklist.

Use the standard ISPF scroll keys to display the qualification information for each
entity identified.

Figure 53 « Impact Analysis Results - Impact Facility

File Edit ¥iew Search Generate Worklist Options Help

Impact Facility ABBEY-AL
Command ===% Scroll ===* L3R
Mame: ABBEY-AL - DATE IWPACT FOR TESTING 1 of 1229
ik
Impact Base Target List
Hame kind Parent
‘CDORSE’ ENTRY YIAALLA,. ABEEY.CO
'CDESE’ ENTRY YIAALL1A,. ABBEY.CO
'CDESCY EMTRY YIAALL1A,.ABBEY.CO

Impact Generation Options

Include Base Selection in results
Include Copy Detail in results

Base Impact Targets: Application Assignments
Targets Level Sunonums To Fram fAlternates
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Listing the Relationships of Impacted Items (Detailed Impact

Analysis)

84

Alliance builds the impact analysis by layering related components. The detailed analysis
shows what each layer in the summary analysis is and why the layer was applied to the
member of the base selection list. With detailed analysis, retrace all paths taken to
generate the summary analysis results.

Various information options control the information shown for each entity. The defaults
are name, entity kind, and containing component. Change the impact generate options to
modify the default display. After you have a base of summary and detailed analysis
results, look up unknown components to refine the input options and rerun the impact
analysis. For step-by-step instructions on modifying default impact generate options and
investigating unknown components, see "Modifying the Impact Analysis" on page 99.

Detailed impact analysis results are displayed hierarchically, with each level representing
an impact relationship path to a new component. When a single component is related to
several entities, these paths are represented at the same offset. The first component to the
left is the base selection entity. Figure 54 is an example of detailed analysis results.

Figure 54 « Example of Detailed Impact Analysis Results

File Edit Uiew Search Generate Worklist oOptions Help

Inpact Facility Appll
CoHnand ===k _ Ecroll ===} CER
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Understanding Detailed Analysis

Step 1

The impact generate options determine the types of relationships assessed. The order in
which the assessment is performed is constant.

The assessment process is described below.

Alliance identifies components hierarchically-related to base selection entities and makes
independent groups. Hierarchically-related entities are parents and children of the
application components you selected (see Figure 55).

Figure 55 ¢« Step 1 - Parents and Children of Base Selection Entities

Parents

1

Base Selection

Children
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Step 2

Alliance finds synonyms and local assignments (entities within the scope of the target
component that have direct and indirect data movement to and from one another) for each

group (see Figure 56).

Figure 56 » Step 2 - Synonyms and assignments

Application Level <:E> Parents
Synonyms

Application Level <}E{> Base SEEG@D
Synanyms

Application Level <:E> Children
Synonyms
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Step 3

Alliance groups accumulated components into a single base impact target group (see
Figure 57).

Figure 57 « Step 3 - Base Impact Targets

Application Level <}E{> Parents
Synonyms
f

porleston el (== [ B s
Synonyms

Y

Application Level <}E{> Children
Synonyms
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Step 4

Alliance creates the expanded impact target group by identifying the parents and children
and the local assignments of the base impact target group (see Figure 58).

Figure 58 ¢ Step 4 - Expanded Impact Targets

Application -
Level Synanyms <}E{> hssignments ToFrom

Basze Impact Targets

Aszignments To/From

Application W—ZKJE&
Lewvel Synonyms

Children

Application
Level Synonyms

A=z=igniments TafFram

Expanded Impact Targets
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Step 5

Alliance repeats steps 3 and 4 until no new component is discovered (see Figure 59).

Figure 59 » Step 5 - Example of Entity Relationships
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Hierarchical Relationships

Hierarchically-related components (parents and children) vary with the definition of the
entity. This table lists the parents and children of specific entity kinds recognized by

Alliance:

Entity Kind

CICS mapset

Parents

none

Children

CICS map, CICS map field

COBOL dataitem
including rename,

redefine and
88 level items

Containing group
components until level
01, 66 or 77 (i.e. up to
the record level)

All within the group name

IDMS area

IDMS subschema, IDMS
schema

IDMS logical record, IDMS
record, IDMS map

IDMS logical record

none

IDMS record

IDMS schema

none

IDMS subschema, IDMS area,
IDMS logical record, IDMS
record, IDMS map

IDMS subschema

IDMS schema

IDMS area, IDMS logical
record, IDMS record, IDMS
map

IMS DynAllocMacro  none DD, DSN

IMS segment none IMS segment

JCL job none JCL step, JCL DD

JCL INCLUDE none JCL step, JCL DD

JCL PROC none JCL step, JCL DD

JCL step none JCL DD

Segment none Segment

Senseg none Senseg

SQL column The owning Table or View  none

SQL database SQL Stogroup SQL tablespace, SQL table,

SQL view, SQL column
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Entity Kind Parents Children

SQL Stogroup none SQL database, SQL tablespace,
SQL table, SQL view, SQL
column

SQL table or view none SQL columns within the table
or view

All others none none

Referential Symbols

As the Application Analytical Engine (AAE) analyzes individual components within the
application, it encounters references to entities that are defined elsewhere. The AAE
marks each of these references to the entity in order to connect it to the definition of the
entity, and to the other references to the entity. These references are known as referential
symbols. The connecting process is the semantic linking phase of the analysis.

As the impact analysis traverses relationships (that is, parents, children, assignments,
synonyms, and entity relationships) to generate results, it uses referential symbols to step
from entity to entity in the relationship chains. Each referential symbol found during the
impact analysis is ultimately substituted by the appropriate definition symbol and
removed from the results.

Figure 60 illustrates the removal of referential symbols.

Figure 60 » Referential Symbol Removal

. PGM1.
This will be removed

from the resullts.

FILE CONTROL
\ SELECT EMPLOYEE ASSIGN TQEMPFILE.)

| Reference Symbol }

Entity: EMPFILE

Entity Kind: DD | Definition Symbol I—l

/ //IBATCHRUN JOB (XxX)...
This will be included

- I EXEC PGM=PGM1...
in the results. (/EMPFILE) DD DSN=ABC.EMPFILE...
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In cases when the definition symbol does not exist within the application, a single
referential symbol is kept in the results of the impact analysis, as shown in Figure 61.

Figure 61 » Referential Symbol Inclusion

This will NOT be
removed from the PGM1.
results since there is
no definition symbol FILE CONTROL
to include. \ SELECT EMPLOYEE ASSIGN TQEMPFILE,
|
Entity: EMPFILE | Referenoel Symbol_|
Entity Kind: DD *
Definition Symbol
?
Execution JCL was not
defined to the
application.

Information Display Options
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You can control the display and type of the information shown in detailed impact analysis
results. The defaults for the display are connecting lines between related components and
an initial value of 4 for the number of levels shown. These are the defaults for the
information:

. Name
. Entity kind
. Containing component

. Connecting lines

Other options include:
. Containing component description
. Impact relationship

. Entity-relationship-entity information
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For a complete description of impact generate options, see "Changing Impact Generate
Options" on page 100. For step-by-step instructions on modifying default impact generate
options, see "Specifying New Impact Generate Options" on page 110.

Depending on the display options you select, you can view this information either to the
right of the components in the Impact Facility screen or in the Detailed Information
pop-up for the selected component. The information displayed pertains to the component
at the cursor location and the relationship it has to the component that caused it to appear
at its current position in the results.

Figure 62 describes cursor placement.

Figure 62 * Detailed Information Pop-up - Cursor Placement Description

File Edit Uiew 3Zearch Generate WMorklist Options Help

IHpact Facility Lppll
ComAand ===F _ scroll === CER
Hahe: iy Impact - Descrption 1 ':'fm‘}}}_
TOFr OF DATA
[Selection One)
|
+- [Related Component & ----- Place mursor here to report on component & and its

[ relationship to Selection One.
| +-[Eelated Component B)

[

[

| -[Belated Component C) ----- Place cursor here to report on component C and its
|

|

| relationship to Component 4.
- [Eelated Component [N

| |
| - [Eelated Component E] ----- Place mursor here to report on Component E and
its relathipshuip to Component D

93



ASG-Alliance User’s Guide

Figure 63 is an example of the Detailed Information pop-up.

Figure 63 * Detailed Information Pop-up - Description

File Edit Wiew =Zearch Generate Worklist Options Help
Inpact Facility kPl
CoHrHand ===X VIAINFO #Cpoll ===} CER
Hare: An Impact - Dercopton 1 of mn
[Selection - Cie) 27
|
+ (Beluted Comporerd A
I
| +-(Related Comporetd B)-------- The omwsor ame placed here.
I
i Detailed Infornation
EITITY ETHL : {Belated Comporwerdt B} { Chaadification
EHTITY ETHI : {Ertity End for Compotert B}
CONTAIMIH & COME OHENT : { Cordairivge Hame t | {Desaiption} ) { Qaalificatioe)
P ACT REL ATIONSHIP ¢ {Impact Reliticrehip

The detailed impact analysis retraces the results of the summary analysis by showing the
path of each component included in those results to the members of the base selection list.

To generate a detailed impact analysis

1
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Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate P Detailed and press Enter. The

Detailed Impact - Select Impact Generation Entities pop-up displays all of the
occurrences of entities in the open application that match in the open impact list. The
type of each entity is listed along with qualification information that provides details
on the occurrence location.

To select a data item for analysis, type any character in the column beside the data
item and press Enter.

Or

To select all entries, press PF5.

Press PF2 to view or change the impact generate options.
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These options control the type and format of the information that displays as the
result of the impact analysis, as well as the components of the base selection list. If
you are performing the impact analysis for the first time, ASG recommends you use
the defaults for these options.

Note:

For step-by-step instructions on modifying default impact generate options, see
"Specifying New Impact Generate Options" on page 110.

Press PF4 to generate the detailed impact analysis. Analysis results display on the
Impact Facility screen.

You can save, append, and print the detailed impact analysis results to a worklist.
Use the standard ISPF scroll keys to display the qualification information for each
entity identified.

Figure 64 shows an example of the information displayed on the Impact Facility
screen after you generate the detailed impact analysis.

Figure 64 « Example of Detailed Impact Analysis Results

File Edit Wiew 3Zearch Generate Worklist Options Help

Inpact Facility Aprll
CoHHand === WIAINFO gcrall ===} CER
Mare: An Impact - Dercoption 1 of mn
[Selectiom - Clrue ) e
|
+ [Related Comporwert 4,
[
| +-(Related Comporwnt B)-------- The omsor was placed et

Detailed InforHation
ENTITY EIND . {Related Component By { Qraalification
ENTITY EINT : { Bty Kind for Component B
CONTAINING COME ONENT : { Containing Hame } { {Description’ ) { (ualification)
IMPACT RELATIONSHIP  : {Impact Relstionshipt
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To expand or collapse a path on the Impact Facility screen

1

Select View » Zoom In

Or
Select View » Zoom Out.
Press Enter.

Choose one of these options:
. Place the cursor on the desired component and press Enter.
. Place the cursor on the desired component.

. Press PF6 to Zoom In or PF5 to Zoom Out.

To display the Detail Information pop-up on the Impact Facility screen

1
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Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select View » Details and press Enter.

Place the cursor on the desired component and press Enter
Or

Press PF4 to display the Detail Information pop-up.

Review the information. Use the standard ISPF scroll keys to display the
qualification information for each entity identified.

Press PF3 to close the pop-up when you are finished.
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Figure 65 shows an example of the Detail Information pop-up.

Figure 65 ¢ Detailed Information Pop-up - Example

File Edit Yiew Search Generate Worklist 0Options Help

Impact Facility ELM-PLIEAT
Command ===% scroll ===* CER
Mame: ELMIMSS - MEW IMPACT LIST FOR ELMIMS 1 of 19
?RT - Detailed Information
- >
I_ . Name » CHECKE_DATA OF PRIMT_CHECK OF PRMTCHE OF PRHTCHE
I Entity Kind ! RECORDJDSECT/STRUCTURE, DATAITEM
Containing Component: PRMTCHEK OF PRHTCHE OF PRMTCHE OF YIAEXW TESTPL
are Impact Re Tationship @ (E-R)DATA ITEM DATE IS IN RECORD CHECK_DA&TA
i

|D- - - PAYROLL (RECORD/DSECT/STRUCTLRE, DATAITEM) PRMTCHK
I | - - - PAYFILE (FO/FILEVAR DCS, DATAITEM) PRHMTCHE

I I - - - +PAYFILE (D) JOB2ICL

I .- P.TY_DATE (DATAITEM) PROCESS

| - - - PAYROLL (RECORDJDSECT /STRUCTURE, DATAITEM) PROCESS

To view the Direct Path to an Impact result
1 Select View » Zoom Direct Path and press Enter.

2 Place the cursor on the desired component and press Enter. Alliance collapses all
lines except the detailed impact answers that show the path to the selected line.
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Modifying the Impact Analysis

This chapter describes the impact generate options, and gives instructions on how to
generate impact options and work with impact lists in these sections:

Section Page

Changing Impact Generate Options 100
Specifying New Impact Generate Options 110
Refining the Base Selection List 112
Rerunning the Impact Analysis 115

As described in the overview, at this stage you generate the first round of impact analysis
results, based upon the list of items you select for impact assessment. You can modify
impact generate options, change the base selection list, and execute new impact analysis
to retrace unknown components in the analysis results. Refine impact analysis parameters
and eliminate unknown components to limit the impact assessment to entities germane to
the change. Then, use these results to determine what actions need to be taken and
whether the current flow of data between components is redirected.
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Changing Impact Generate Options

100

Impact generate options affect how the impact analysis traverses the data flow as well as
the hierarchical relationships of the components. Using this new information, you might
modify the composition of the base selection list to include application components you
did not initially plan to analyze, such as application-level synonyms and local
assignments.

You might also include additional hierarchical relationships to the results, depending on
the nature of the application and the task at hand. Use the Impact Generate Options
pop-up to specify parents and children of the selected targets, as well as application-level
synonyms and assignment synonyms of parents and children. Figure 66 shows the Impact
Generate Options screen with ESW defaults marked with a slash (/).

Figure 66 * Impact Generate Options Screen

Impact Generate Options
Command ===%

Select desired Impact Generate Options.
Include Base Selection in results
Include Copy Detail in results

Base Impact Targets: Application Assighments

Targets Lewvel Synonuyms To From Alternates
/  Base Selection / _ _ _
/ Parents of Base Selection £

Children of Base Selection

Expanded Impact Targets: Application Assignments

Targets Level Synonyms To Fram Alternates
/  Base Impact Targets /! _ _ _
/  Parents of Base Impact Targets /! _ _ _

Children of Base Impact Targets

PFd4=Restore ASG Default Ovotions PFS=Detailed Ootions

The options on the Impact Generate Options pop-up are available for these two groups:

o "Step 3 - Base Impact Targets" on page 87

. "Step 4 - Expanded Impact Targets" on page 88.

For a description of the impact analysis relationship assessment process, see
"Understanding Detailed Analysis" on page 85.

The Impact Generate Options pop-up also provides access to the detailed impact analysis
options that control the display of connecting lines, the number of levels displayed when
the data is collapsed, and the amount of information with each entity.

For a description of the options available for detailed analysis, see "Detailed Impact
Generate Options" on page 106.

For step-by-step instructions on modifying Impact Generate Options, see "Specifying
New Impact Generate Options" on page 110.




6 Modifying the Impact Analysis

Base Impact Targets Options

Base impact targets options consist of three levels: base selection, parents of base
selection, and children of base selection.

Base Selection

The base selection refers to the entities chosen from the Select Impact Generation Entities
pop-up (see "Selecting Items to be Analyzed" on page 80). The Base Selection option is a
ESW default that cannot be deleted. These are the options available for base selection:

Option Description

Application-level Includes application level synonyms of the selected entities in
synonyms the analysis.

Activates the Assignments To and Assignments From options.
ESW default for Base Selection.

Assignments to Includes entities that the selected entities assign value to in the
analysis.

For example, if A is the selected entity; A assigns value to B; B
is included in the analysis.

Assignments from Includes entities that the selected entities are assigned value
from in the analysis.

For example, if A is the selected entity; A is assigned value from
B; B is included in the analysis.

Assignments Includes data movement and comparisons within programs for
alternate statements other than direct moves in the analysis.

Statements that make up this relationship are those where the
data in a variable alters the value of another variable, or where
one data item is compared to another.

Local or global synonyms calculations are not affected.

All languages and language levels supported by Alliance can
use this feature.
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Parents of Base Selection

Parents of base selection refers to the parents of entities chosen from the Select Impact
Generation Entities pop-up. The Parents of Base Selection option is a ESW default. These
are the options available for parents of base selection:

Option Description

Application-level Includes application level synonyms of the parents of the
synonyms selected entities in the analysis.

Activates the Assignments To and Assignments From options.

ESW default for Parents of Base Selection.

Assignments to Includes entities that the parents of the selected entities assign
value to in the analysis.

For example, if A is the selected entity; B is the parent of A, and
B assigns value to C; C is included in the analysis.

Assignments from Includes entities that the parents of the selected entities are
assigned value from in the analysis.

For example, if A is the selected entity; B is the parent of A, and
B is assigned value from C, C is included in the analysis.

Assignments Includes data movement and comparisons within programs for
alternate statements other than direct moves in the analysis.

Statements that make up this relationship are those where the
data in a variable alters the value of another variable, or where
one data item is compared to another.

Local or global synonyms calculations are not affected.

Alllanguages and language levels supported by Alliance can use
this feature.
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Children of Base Selection

Children of base selection refers to the children of entities chosen from the Select Impact
Generation Entities pop-up. If you select this option, all entities that are children of the
selected entities are included in the analysis. These are the options available for children
of base selection:

Option Description

Application-level Includes application level synonyms of the children of the
synonyms selected entities in the analysis.

Activates the Assignments To and Assignments From options.

Assignments to Includes entities that the children of the selected entities assign
value to in the analysis.

For example, if A is the selected entity; B is the child of A, and
B assigns value to C; C is included in the analysis.

Assignments from Includes entities that the children of the selected entities are
assigned value from in the analysis.

For example, if A is the selected entity; B is the child of A, and
B is assigned value from C, C is included in the analysis.

Assignments Includes data movement and comparisons within programs for
alternate statements other than direct moves in the analysis.

Statements that make up this relationship are those where the
data in a variable alters the value of another variable, or where
one data item is compared to another.

Local or global synonyms calculations are not affected.

Alllanguages and language levels supported by Alliance can use
this feature.
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Expanded Impact Targets Options

Expanded Impact Targets options include all entities selected for analysis as a result of
the options set under Base Impact Target options. All base impact targets go into any
expanded impact targets option. Expanded impact targets options consist of three levels:
base impact targets, parents of impact targets, and children of impact targets.

Base Impact Targets

Base impact targets are the entities selected for analysis as a result of the options set for
the base selections. The Base Impact Targets option is a ESW default that cannot be
deleted. These are the options available for base impact targets:

Option Description

Application-level  Includes application level synonyms of the base impact targets in
synonyms the analysis

Activates the Assignments To and Assignments From options

ESW defaults for Base Impact Targets

Assignments to Includes entities that the base impact targets assign value to in the
analysis

Assignments from Includes entities that the base impact targets are assigned value
from in the analysis

Assignments Includes data movement and comparisons within programs for
alternate statements other than direct moves in the analysis

Statements that make up this relationship are those where the data
in a variable alters the value of another variable, or where one data
item is compared to another

Local or global synonyms calculations are not affected

All languages and language levels supported by Alliance can use
this feature
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Parents of Base Impact Targets

Parents of base impact targets refers to the parents of all entities selected for analysis
under that option. These are the options available for parents of base impact targets:

Option Description

Application-level  Includes application level synonyms of the parents of the base
synonyms impact targets in the analysis

Activates the Assignments To and Assignments From options

ESW default for Parents of Base Impact Targets

Assignments to Includes entities that the parents of the base impact targets assign
value to in the analysis

Assignments from Includes entities that the parents of the base impact targets are
assigned value from in the analysis

Assignments Includes data movement and comparisons within programs for
alternate statements other than direct moves in the analysis

Statements that make up this relationship are those where the data
in a variable alters the value of another variable, or where one data
item is compared to another

Local or global synonyms calculations are not affected

All languages and language levels supported by Alliance can use
this feature

Children of Base Impact Targets

Children of base impact targets refers to the children of all entities selected for analysis
under that option. The options available for children of base impact targets are listed
below. These are the options available for children of base impact targets:

Option Description

Application-level Includes application level synonyms of the children of the base
synonyms impact targets in the analysis

Activates the Assignments To and Assignments From options

Assignments to  Includes entities that the children of the base impact targets assign
value to in the analysis.

105



ASG-Alliance User’s Guide

Assignments Includes entities that the children of the base impact targets are
from assigned value from in the analysis

Assignments Includes data movement and comparisons within programs for
alternate statements other than direct moves in the analysis

Statements that make up this relationship are those where the data in
a variable alters the value of another variable, or where one data item
is compared to another.

Local or global synonyms calculations are not affected

All languages and language levels supported by Alliance can use
this feature

Detailed Impact Generate Options
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The Detailed Impact Generate Options pop-up contains options that control the display of
connecting lines, the number of levels initially displayed on the Impact Facility screen for

detailed analysi

s, and the amount of information shown with each entity. Figure 67 shows

the Detailed Impact Generate Options pop-up with ESW defaults marked with a slash (/).

Figure 67 » Detailed Impact Generate Options Pop-up
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Display Options

These are the options available to control the display of information for detailed impact
analysis:

Option Description

Draw connecting  Controls the display of the connecting lines drawn from component
lines to related component

ESW default for display options

Initial number of  Controls the number of levels shown upon initial display of the
levels to display ~ Detailed Impact Analysis results

The number of levels specified must be between 1 and
2,147,483,647 (MAXINT). The default value is 4

This option is ignored if Display all levels is selected.

Display all levels  Forces all levels of impact relationship to be drawn on initial display
The ESW default is to disable this option

Note:
The Summary Impact results does not necessarily match the
Detailed Impact results if you do not turn on the "Display all
levels" detailed impact option.

Information Display Options

The options available to control the information displayed on the Impact Facility screen
for each entity in detailed impact analysis results are listed below. These are the default
information options:

. Name

. Entity Kind

. Containing Component

. Containing Component Description
. Impact Relationship

. Entity-Relationship-Entity Information
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Note:
To view data for disabled information options in the Impact Facility screen, display the
Detail Information pop-up for each component.

Option Description

Name Includes the name of the component. The ESW default is
enabled.

Entity Kind Includes the entity kind of the component as recognized by
Alliance.

A component can be defined as more than one entity kind. For
example, (DATAITEM, RECORD).

ESW default is enabled.
Containing Includes the name of the component in the application where the
Component entity was found.
ESW default is enabled.
Containing Specifies the type of the containing component. These are the
Component possible types:
Description ASM CICS-BMS CICS-CDS
CICS-FCT CICS-PCT CICS-PPT
COBOL IMS-MFS IMS-DBD
IMS-DFSMDA IMS-PSB JCL
LOADMOD PL/
Note:

The value of UNKNOWN is displayed when the containing
component is a dataset and its language type cannot be isolated.

Impact Relationship  Includes the nature of the impact relationship. Possible
relationships are listed on the next page.

ESW default is disabled.
Entity-Relationship-  Includes the specific relationship when the components are
Entity Information related because of an entity-relationship-entity connection.
ESW default is disabled.
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These are the possible impact relationships displayed when the Impact Relationship
option is enabled:

Relationship Name Description

CALL TO {PGM} Related items are used as actual and formal
parameters in a CALL statement

{I/O ACTIVITY} [TO/FROM] Related items are used in an I/O activity to the

THE SAME FILE LOCATION same file location. The nature of the activity
displays when possible. /O ACTIVITY: READ,
CREATE, UPDATE, DELETE

{I/O ACTIVITY} [TO/FROM] The related items are used in an I/O activity to the

THE SAME DATA BASE same database component. The nature of the

COMPONENT activity displays when possible. I/O ACTIVITY:
READ, CREATE, UPDATE, DELETE

DEFINITION Related items refer to the same information by
definition, for example A REDEFINES B

{Instruction} [TO/FROM] {Related Related items are linked by an instructed data
Component} flow. For example on a program level, if data was
moved from one item to the other

These are the instructions for
causing data movement:

COBOL ACCEPT, MOVE, MOVE CORRESPONDING

I/O OPERATIONS READ, REWRITE, WRITE, SORT, MERGE,
RETURN, RELEASE

IDMS ACCEPT, END TRANSACTION WRITE,
FIND,OBTAIN, GET

SQL FETCH, UPDATE

IMS INSERT, GET, REPLACE

CICS SEND MAP, RECEIVE MAP, WRITE, READ,

READPREV, READNEXT, REWRITE

ENTITY RELATIONSHIP Related items are found in an
entity-relationship-entity connection

[PARENT/CHILD] Related items are connected because a parent or
child has an impact relationship
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Figure 68 shows the format of the data shown on the Impact Facility screen. If you
disable any of the information options, the information is removed from the pattern and
the remaining information stays in the same sequence. Use the Detail Information pop-up
for each component to view the data.

Figure 68 * Information Options Format

{name} {(entity kind)} {OF containing component{ (description)}} {- impact
relationship{ (entity-relationship-entity) }}
Containing Impact
Name Component Relationship
I I | |
+- PAYFILE (FD) OF PGM2 (COBOL) - ENTITY RELATIONSHIP (RECORD USEDBY FD)
| | | I
Entity Kind Containing Entity-Relationship-Entity
Component
Description

Specifying New Impact Generate Options

To change impact generate options

1 Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

2 Select Generate » Summary and press Enter.

Note:
If you have already generated impact analysis results without an open worklist, a
warning message displays telling you to either open or create a worklist, or confirm
that you do not want to save the current data.

3  To display the Impact Generate Options pop-up, press PF2 on the
Select Impact Generation Entities pop-up.

4  Toselectan option in the Targets column, type any character to the left of the option.
Select Application Level Synonyms options by typing any character beneath that
column, next to the appropriate target level. Select Assignments by typing any
character in the To, From, or Alternates column.

For information about base and expanded impact targets options, see "Base Impact
Targets Options" on page 101 and "Expanded Impact Targets Options" on page 104.

5  When you have finished selecting options, press PF3 to return to the Select Impact
Generation Entities pop-up.
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To reset default impact generate options

1

4

5

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate » Summary and press Enter.

On the Select Impact Generation Entities pop-up, press PF2 to display the Impact
Generate Options pop-up.

Press PF4 to restore the defaults.

Press PF3 to return to the Select Impact Generation Entities pop-up.

To change detailed impact generate options

1

6

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate P Detailed and press Enter.

On the Select Impact Generation Entities pop-up, press PF2 to display the Impact
Generate Options pop-up.

Press PF5 to display the Detailed Impact Generate Options pop-up.

Specify the desired options and press PF3 to return to the Impact Generate Options
pop-up.

Press PF3 again to return to the Select Impact Generation Entities pop-up.

To reset default detailed impact generate options

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate P Detailed and press Enter.

On the Select Impact Generation Entities pop-up, press PF2 to display the Impact
Generate Options pop-up.

Press PF5 to display the Detailed Impact Generate Options pop-up.
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5

6

7

Press PF4 to restore the defaults.
Press PF3 to return to the Impact Generate Options pop-up.

Press PF3 again to return to the Select Impact Generation Entities pop-up.

Refining the Base Selection List

Modify the composition of the base selection list to recover data not found in previous
analyses. Depending on the situation, you can perform these tasks:

Revise the impact list from where the base selection list is derived.

Rebuild the base selection list you specify in the Select Impact Generation Entities
pop-up.

Revise impact generate options that determine the base and expanded impact
targets.

Revising an Impact List
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To modify an existing impact list (open)

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Choose Edit » Impact list and press Enter.The Impact Entity List pop-up displays
with the list of previously defined impact list entities.

To modify an existing impact list (closed)

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select File » Open impact list and press Enter.

In the Open Impact List pop-up, type any character in the selection column to the left
of the impact list you want to modify and press Enter.

Press PF4 (Edit). The Impact Entity List pop-up displays with the list of previously
defined impact list entities.
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To add components to an open impact list

1

6

7

From the Impact Entity List pop-up, press PF4 (Add). The Impact Entities Selection
Criteria pop-up displays.

Type the full name of an entity kind.
Or
Type a pattern for selection in the Text field.

Note:

If you enter a pattern and want to limit the entity kinds selected, specify one or more
entity kinds by typing any character in the selection column to the left of the entity
name.

Press Enter. The Add Impact List Entity pop-up displays (Figure 48 on page 76) with
the list of entity names that matched the text entered on the Impact Entities Selection
Criteria pop-up. The list is scrollable.

Type any character in the selection column beside the desired entity name. Select as
many entities as needed.

When finished selecting entries, press PF10 to add the entries and return to the
Impact Entity List pop-up.

Press PF3 to return to the Open Impact List pop-up.

Press PF3 again to return to the Impact Facility screen.

To remove components from an open impact list

1

On the Impact Entity List pop-up, select the entities you want to remove by typing
any character in the selection column to the left of the entity name.

Press PF5 (Delete).

Caution! The deletion takes place instantly, without a confirmation message
allowing you to cancel.

Press PF3 to return to the Impact Facility screen.
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To save the updated impact list

1

Select File P Save impact list from the Impact Facility screen and press Enter. The
message [impact list name] HAS BEEN SAVED TO IMPACT
DEFINITION displays to confirm that the original impact list updated with the new
information.

Or

Select File P Save impact list and press Enter to preserve the original impact list and
store the impact list under a new name.

The Save Impact As pop-up displays with the name and description of the original
impact list

Type the name and description of the new impact list in the Name and Description
fields and press Enter.

The Impact Facility screen returns with the message [impact 1ist name]
HAS BEEN SAVED TO IMPACT DEFINITION to confirm the creation of the
new impact list.

Rebuilding the Base Selection List
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To rebuild the base selection list

1

Select Facility » Impact from the Alliance Primary screen and press Enter. The
Impact Facility screen displays.

Select Generate » Summary and press Enter. The

Summary Impact - Select Impact Generation Entities pop-up displays all
occurrences of entities in the open application that match in the open impact list. The
type of each entity is listed along with qualification information that provides details
on the occurrence location.

To specify the new entity names to be analyzed, type any character in the selection
column beside the data items you want to select.

Or

To select all entities, press PF5.

Proceed with the analysis.

For step-by-step instructions on generating summary and detailed analysis results,
see "Locating Impacted Components and Relationships (Summary Impact

Analysis)" on page 82 and "Listing the Relationships of Impacted Items (Detailed
Impact Analysis)" on page 84.




6 Modifying the Impact Analysis

Rerunning the Impact Analysis

As described in the overview, the final stage in the refining process is rerunning the
impact analysis. Rerun the impact analysis in an iterative manner until you get the results
you need to proceed with a change request implementation.

To rerun the Impact Analysis
1 Review the results of previous impact analysis.
2 Investigate the paths traversed by components related to the change.

3  Refine analysis parameters by modifying the impact list, base selection list, and
impact generate options.

To execute new impact analyses, follow the same series of steps previously performed.
For instructions on generating summary and detailed analysis results, see "Locating

Impacted Components and Relationships (Summary Impact Analysis)" on page 82 and

"Listing the Relationships of Impacted Items (Detailed Impact Analysis)" on page 84.
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Appendix A

Valid Entities and Relationships

Due to its enhanced language support, Alliance recognizes these entities by multiple

names:

. FD, FILEVAR, or DCB

. PROGRAM, PROCEDURE, or FUNCTION

. RECORD, DSECT, or STRUCTURE

These are the entities recognized by Alliance (listed in alphabetical order):

AREA

CATALOG
CICS-TRANSACTION
COLUMN
COPYMEMBER

CSD

CSECT

CURSOR

DATABASE
DATAITEM

DBD
DCB/FD/FILEVAR
DD
DSECT/RECORD/STRUCTURE
DSN

ENTRY

FCT

LOADMODULE

LOGICALRECORD

MAP

MAPFIELD

MAPSET

MEMBER

PCB

PCT

PPT

PROC
PROCEDURE/PROGRAM/FUNCTION
PROGRAM/PROCEDURE/FUNCTION
PSB

RECORD/DSECT/STRUCTURE
SCHEMA

SEGFIELD

SEGMENT
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FCTCSD
FD/FILEVAR/DCB
FILEVAR/FD/DCB
FUNCTION/PROGRAM/PROCEDURE
IDMS

IDMS MAP

IDMS RECORD
IMS-TRANSACTION
IMS-FORMAT
IMSDYNALLOCMACRO
JOB

LIBRARY

SENFIELD

SENSEG

SQL

STEP

STOGROUP
STRUCTURE/RECORD/DSECT
SUBSCHEMA

TABLE

TABLESPACE

VIEW

These are the relationships recognized by Alliance (listed in alphabetical order):

ALTERNATE LINKED-BY
CALLED-BY LINKS

CALLS LOCALSYNONYM
DEFINED-IN REFERENCED-BY
EXECUTED-BY REFERENCES
EXECUTES SELECTED-BY
HAS SELECTS
HOMONYM SYNONYM

IN USEDBY
INCLUDES USES

IS
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These are the entity-relationships recognized by Alliance (listed in alphabetical order):

Definitions of Valid Entities in Alliance Query Usage

AREA HAS IDMSRECORD Identifies records
located in logical
areas of IDMS
Schemas

AREA IN PROGRAM Identifies logical

PROCEDURE areas of IDMS
Schemas in
FUNCTION Programs

AREA IN SUBSCHEMA Identifies local
areas in IDMS
databases that are
defined within
Subschemas

CATALOG USEDBY JOB Identifies catalogs
used by jobs in an
application

CATALOG USEDBY STEP Identifies catalogs
used by Job Steps
in an application

CICS-TRANSACTION EXECUTED-BY PROGRAM Identifies all

PROCEDURE CICS transactions
executed by

FUNCTION programs within
an application

CICS-TRANSACTION EXECUTES PROGRAM Identifies
programs

PROCEDURE executed by CICS

FUNCTION transactions
within an
application

CICS-TRANSACTION IN CSD Identifies CICS
transactions in
CSD files

CICS-TRANSACTION IN PCT Identifies CICS
transactions
within PCTs

COLUMN IN PROGRAM Identifies
relational

PROCEDURE database fields as
FUNCTION referenced in a

program
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COLUMN

Definitions of Valid Entities in Alliance Query Usage

TABLE

Identifies fields
within relational
database tables

COLUMN

VIEW

Identifies fields
within relational
database views

COPYMEMBER

HAS

DATAITEM

Identifies
copymembers that
are directly
included by the
copymember.
Same applies to
JCL INCLUDES.

COPYMEMBER

COPYMEMBER

Identifies
copymembers that
directly include
copymembers

COPYMEMBER

MEMBER

Identifies
members that
contain a
copybook. Same
applies to JCL
INCLUDES.

COPYMEMBER

PROGRAM
PROCEDURE
FUNCTION

Identifies
copymembers
referenced by
programs defined
to an application.
Identifies JCL
INCLUDES
referenced by JCL
defined to an
application.

COPYMEMBER

INCLUDES

COPYMEMBER

Identifies
copymembers
referencing data
items defined in a
copymember.
Same applies to
JCL INCLUDES.

COPYMEMBER

USEDBY

COPYMEMBER

Identifies
copymembers that
directly and
indirectly include
copymembers
(nested copies).
Same applies to
JCL INCLUDES.
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Definitions of Valid Entities in Alliance Query Usage

COPYMEMBER

USEDBY

MEMBER

Lists
copymembers that
are included in
program
members. Also
lists JCL
INCLUDES that
are included in the
JCL.

COPYMEMBER

USES

COPYMEMBER

Identifies
copymembers
directly and
indirectly
included by
copymembers
(nested copies).
Same applies to
JCL INCLUDES.

CSD

HAS

CICS-TRANSACTION

Identifies CICS
transactions
defined in CSD
files

CSD

HAS

DD

Identifies DDs
defined in CSD
files

CSECT

LOADMODULE

Identifies control
sections in a load
module

CSECT

IS

PROGRAM
PROCEDURE
FUNCTION

Identifies control
sections in a
program.

Assigns CSECTS
to a Program

CURSOR

DATABASE

Identifies SQL
object pointers
that can be used to
run through a set
of records that are
returned by a

query

CURSOR

PROGRAM
PROCEDURE
FUNCTION

Identifies SQL
cursorsreferenced
within a program
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DATABASE

Definitions of Valid Entities in Alliance Query Usage

HAS

CURSOR

Identifies SQL
cursors that are
defined to a
database

DATABASE

HAS

TABLESPACE

Indicates the
available
tablespaces in a
DB2 database

DATABASE

PROGRAM
PROCEDURE
FUNCTION

Indicates the
program where
DB2 databases are
referenced

DATABASE

STOGROUP

Indicates the
storage GROUPS
where a DB2
database resides

DATAITEM

DEFINED-IN

COPYMEMBER

Identifies data
items defined by
each copymember
defined to the
application

DATAITEM

DEFINED-IN

PROGRAM
PROCEDURE
FUNCTION

Identifies data
items defined by
each program in
an application

DATAITEM

HOMONYM

DATAITEM

Lists homonyms
of data items in an
application

DATAITEM

RECORD
DSECT
STRUCTURE

Lists records
containing data
items

DATAITEM

LOCALSYNONYM

DATAITEM

Lists local
synonyms of
dataitems within a
program

DATAITEM

SYNONYM

DATAITEM

Lists global
synonyms of data
items in an
application
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Definitions of Valid Entities in Alliance Query Usage

DBD HAS DD Identifies the DD
names to which
the database
definitions are
allocated

DBD HAS SEGMENT Identifies the
segments
(records) in an
IMS database that
are defined by the
database
definition

DBD IN MEMBER Identifies
members
containing an IMS
DBDGEN

DBD IN PCB Identifies
database
definitions
included ina PCB
(Program
Communication
Block)

DCB (See FD)

DD HAS DSN Identifies DSNs
referenced by DD
statement

DD IN CSD Identifies DD
statements in CSD
files

DD IN DBD Identifies DD
statements in a
database
description

DD IN FCT Identifies DD
statements in a
CICS FCT

DD IN FCTCSD Identifies the
location where
DDs are defined
by a CICS CSD
entry
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Definitions of Valid Entities in Alliance Query Usage

DD IN STEP Identifies DD
statements in each
step of a JCL job
stream

DD SELECTED-BY FD Identifies DD
names referenced

FILEVAR by an FD
DCB statement within a
COBOL program

DD USEDBY PROGRAM Lists DD names

used in a program
PROCEDURE via CICS
FUNCTION statements

DSECT

(See RECORD)

DSN HAS MEMBER Lists the members
within a
partitioned dataset

DSN IN DD dataset names, as
specified in the
DD statement in
the JCL

ENTRY CALLED-BY PROGRAM Identifies entry

PROCEDURE names called by a
program
FUNCTION
ENTRY IN PROGRAM Identifies a
PROCEDURE program’s eniry
point names
FUNCTION

FCT HAS DD Identifies DDs
defined in FCTS

FCT IN MEMBER Lists members
that contain an
FCT

FCTCSD HAS DD Identifies where

CICS DDs were
defined in CSD
files
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Definitions of Valid Entities in Alliance Query Usage

FD IN PROGRAM Identi.ﬁe.s the file
FILEVAR PROCEDURE description
statements 1n a
DCB FUNCTION COBOL source
program
FD SELECTS DD Lists the DD
names referenced
FILEVAR by an FD
DCB statement in a
COBOL program
FD USES RECORD Lists record
names referenced
FILEVAR DSECT by FD statements
DCB STRUCTURE
FILEVAR
(See FD)
FUNCTION
(See PROGRAM)
IDMS IN PROGRAM Lists IDMS
entitiesreferenced
PROCEDURE in a program
FUNCTION
IDMSMAP HAS IDMSRECORD Shows the
relationship
between IDMS
screen maps and
records
IDMSMAP IN PROGRAM Identifies
programs that
PROCEDURE reference IDMS
FUNCTION maps
IDMSRECORD IN AREA Lists IDMS
records contained
in logical areas
IDMSRECORD IN IDMSMAP Shows the
relationship
between IDMS
screenrecords and
maps
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IDMSRECORD

Definitions of Valid Entities in Alliance Query Usage

IN

LOGICALRECORD

Lists IDMS
subschema
records contained
in IDMS logical
records

IDMSRECORD

PROGRAM
PROCEDURE
FUNCTION

Identifies
programs that
reference IDMS
records

IMSDYNALLOCMAC

RO

IN

MEMBER

Lists PDS
members that
contain IMS
dynamic
allocation macros

IMS-FORMAT

EXECUTED-BY

IMS-FORMAT

Lists the
formats(s)
executed by a
format

IMS-FORMAT

EXECUTED-BY

PROGRAM
PROCEDURE
FUNCTION

Identifies
programs that
invoke IMS
formats

IMS-FORMAT

EXECUTES

IMS-TRANSACTION

Lists the formats
that execute an
IMS transaction

IMS-FORMAT

EXECUTES

IMS-FORMAT

Lists formats that
execute IMS
formats

IMS-FORMAT

MEMBER

Lists PDS
members that
contain IMS
format definitions

IMS-TRANSACTION

EXECUTED-BY

IMS-FORMAT

Lists the IMS
transactions
executed by IMS
formats

IMS-TRANSACTION

EXECUTED-BY

PROGRAM
PROCEDURE
FUNCTION

Identifies
programs that
invoke IMS
transactions

IMS-TRANSACTION

EXECUTES

LOADMODULE

Lists the load
modules executed
by IMS
transactions
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Definitions of Valid Entities in Alliance Query Usage

JOB

HAS STEP Lists all JCL job
names in the
application along
with their
associated step
names

JOB

IN MEMBER Lists JCL job
names and their
containing
member names

JOB

USES CATALOG Lists the JCL job
names in the
application and
the names of the
Catalogs they use,
if any

JOB

USES LIBRARY Lists the JCL job
names in the
application and
the JOBLIBS
used

LIBRARY

HAS MEMBER Lists the
partitioned dataset
names in the
application and
their member
names

LIBRARY

USEDBY JOB Lists the libraries
used as JOBLIBS
and the jobs
referencing them

LIBRARY

USEDBY STEP Lists the
LIBRARIES used
as STEPLIBS and
the steps
referencing them

LOADMODULE

EXECUTED-BY IMS-TRANSACTION Lists the load
module names in
the application
that are executed
by IMS
transactions
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LOADMODULE

Definitions of Valid Entities in Alliance Query Usage

EXECUTED-BY

STEP

Lists the load
module names in
the application
and the JCL step
names that
execute them

LOADMODULE

HAS

CSECT

Lists the load
modules in an
application and
their CSECT
names

LOADMODULE

MEMBER

Lists the load
modules in an
application and
their member
names in the
partition datasets
where they are
located

LOGICALRECORD

HAS

IDMSRECORD

Lists IDMS
logical records in
an application and
the IDMS records
they contain

LOGICALRECORD

PROGRAM
PROCEDURE
FUNCTION

Lists IDMS
logical records
referenced in a
program

MAP

HAS

MAPFIELD

Lists CICS maps
in an application
and their mapfield
names

MAP

MAPSET

Lists CICS maps
and the mapsets
that contain them

MAP

REFERENCES

RECORD
DSECT
STRUCTURE

Establishes the
relationship of
CICS maps to
COBOL records

MAP

USEDBY

PROGRAM
PROCEDURE
FUNCTION

Lists CICS maps
in an application,
and the programs
where they are
used
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Definitions of Valid Entities in Alliance Query Usage

MAPFIELD

MAP

Lists CICS
mapfields in an
application and
the map names
that contains them

MAPSET

HAS

MAP

Lists mapsets in
an application and
the Maps
contained by the
mapsets

MAPSET

MEMBER

Lists CICS
mapsets in an
application and
their member
names in a
partitioned dataset

MAPSET

USEDBY

PROGRAM
PROCEDURE
FUNCTION

Lists CICS
mapsets in an
application and
the programs that
reference them

MEMBER

HAS

COPYMEMBER

Lists the member
names of
partitioned
datasets that
contain
copymembers.
Same applies to
JCL INCLUDES.

MEMBER

HAS

DBD

Lists the member
names of
partitioned
datasets that
contain DBDS

MEMBER

HAS

FCT

Lists the member
names of
partitioned
datasets that
contain FCTS

MEMBER

HAS

FORMAT

Identifies member
names of
partitioned
datasets that
contain MFS
definitions for the
formats
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MEMBER

Definitions of Valid Entities in Alliance Query Usage

HAS

IMSDYNALLOCMACRO Lists the member

names of
partitioned
datasets that
contain dynamic
allocation macros

MEMBER

HAS

JOB

Lists the member
names of
partitioned
datasets that
contain JCL job
streams

MEMBER

HAS

LOADMODULE

Lists the member
names of
partitioned
datasets that
contain load
modules

MEMBER

HAS

MAPSET

Lists the member
names of
partitioned
datasets that
contain mapsets

MEMBER

HAS

PCT

Lists the member
names of
partitioned
datasets that
contain PCTS

MEMBER

HAS

PPT

Lists the member
names of
partitioned
datasets that
contain PPTS

MEMBER

HAS

PROC

Lists cataloged
procedure names
and their member
names in a
partitioned dataset

MEMBER

HAS

PROGRAM
PROCEDURE
FUNCTION

Lists the program
names in an
application and
their member
name in a
partitioned dataset
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Definitions of Valid Entities in Alliance Query Usage

MEMBER

HAS

PSB

Lists the member
names of
partitioned
datasets that
contain PSBS

MEMBER

DSN

Lists partition
dataset names and
their member
names

MEMBER

LIBRARY

Lists the
partitioned dataset
names in the
application and
their member
names

MEMBER

USES

COPYMEMBER

Lists the member
names of
partitioned
datasets that
contain “included
copymembers”.
Same applies to
JCL INCLUDES.

PCB

HAS

SENSEG

Lists PCBs that
have sensitive
segments as
defined by senseg
statements

PCB

PSB

Lists IMS
program
communication
blocks and the
PSB where they
are located

PCB

REFERENCES

DBD

Lists IMS PCBs
and the DBDS
they reference

PCT

HAS

CICS-TRANSACTION

Lists CICS
transactions
defined in PCTS

PCT

MEMBER

Lists PCTS and
their member
names in
partitioned
datasets
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Definitions of Valid Entities in Alliance Query Usage

PPT IN MEMBER Lists PPTS and
their member
names in
partitioned
datasets

PROC EXECUTED-BY STEP Lists cataloged
procedures and
the step names
that execute them

PROC HAS STEP Lists step names
in catalog
procedures

PROC IN MEMBER Lists PROC
names and their
member names in
partitioned
datasets

PROCEDURE

(See PROGRAM)

PROGRAM CALLS ENTRY Lists programs in

PROCEDURE the application
that issue calls to

FUNCTION load module entry
points

PROGRAM EXECUTED-BY CICS-TRANSACTION Lists programs in

PROCEDURE the application
that are executed

FUNCTION by CICS
transactions

PROGRAM EXECUTES CICS-TRANSACTION Lists programs in
the application

PROCEDURE that execute CICS

FUNCTION transactions

PROGRAM EXECUTES IMS-FORMAT Lists programs in
the application

PROCEDURE that execute IMS

FUNCTION formats

PROGRAM EXECUTES IMS-TRANSACTION Lists programs in
the application

PROCEDURE that execute IMS

FUNCTION transactions
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM HAS AREA Lists IDMS areas
referenced by
PROCEDURE programs within
FUNCTION an application
PROGRAM HAS COLUMN Lists DB2
PROCEDURE columns
referenced by
FUNCTION programs within
an application
PROGRAM HAS CURSOR Lists DB2 cursors
referenced by
PROCEDURE programs within
FUNCTION an application
PROGRAM HAS DATABASE Lists DB2
databases
PROCEDURE referenced by
FUNCTION programs within
an application
PROGRAM HAS DATAITEM Lists programs in
PROCEDURE the application
and data items
FUNCTION defined in that
program
PROGRAM HAS ENTRY Lists programs in
the application
PROCEDURE and any ENTRY
FUNCTION point names
PROGRAM HAS FD Lists programs in
the application
PROCEDURE FILEVAR that have FD
FUNCTION DCB statements
PROGRAM HAS IDMS Lists programs in
the application
PROCEDURE that reference
FUNCTION IDMS entities
PROGRAM HAS IDMSMAP Lists IDMS maps
referenced by
PROCEDURE programs within
FUNCTION an application
PROGRAM HAS IDMSRECORD Lists IDMS
PROCEDURE records
referenced by
FUNCTION Programs within

an application
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM HAS LOGICALRECORD Lists IDMS
PROCEDURE logical records
referenced by
FUNCTION programs within
an application
PROGRAM HAS RECORD Lists programs in
the application
PROCEDURE DSECT and record names
FUNCTION STRUCTURE referenced in FD
statements
PROGRAM HAS SCHEMA Lists IDMS
PROCEDURE schemas
referenced by
FUNCTION Programs within
an application
PROGRAM HAS SQL Lists programs in
PROCEDURE the application
that reference
FUNCTION SQL entities
PROGRAM HAS STOGROUP Lists DB2 storage
PROCEDURE groups referenced
by programs
FUNCTION within an
application
PROGRAM HAS SUBSCHEMA Lists IDMS
PROCEDURE subschemas
referenced by
FUNCTION programs within
an application
PROGRAM HAS TABLE Lists DB2 tables
PROCEDURE referenced by
programs within
FUNCTION an application
PROGRAM HAS TABLESPACE Lists DB2
PROCEDURE tablespaces
referenced by
FUNCTION programs within
an application
PROGRAM HAS VIEW Lists DB2 views
referenced by
PROCEDURE programs within
FUNCTION an application
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM IN MEMBER Lists the program
names in the
PROCEDURE application and
FUNCTION their member
names in a
partitioned dataset
PROGRAM INCLUDES COPYMEMBER Lists programs in
PROCEDURE the application
that have copy or
FUNCTION include
statements
PROGRAM IS CSECT Establishes
linkage between
PROCEDURE CSECTS and
FUNCTION programs
PROGRAM LINKED-BY PROGRAM Lists programs
executed by CICS
PROCEDURE PROCEDURE LINKs or XCTL
FUNCTION FUNCTION statements
PROGRAM LINKS PROGRAM Lists programs
PROCEDURE PROCEDURE that execute other
programs via
FUNCTION FUNCTION CICS LINKs or
XCTLs
PROGRAM USES DD Lists programs in
the application
PROCEDURE and the DD names
FUNCTION referenced via
CICS statements
PROGRAM USES MAP Lists programs in
the application
PROCEDURE that use CICS
FUNCTION maps
PROGRAM USES MAPSET Lists programs in
PROCEDURE the application
that reference
FUNCTION CICS mapsets
PROGRAM USES PSB Lists programs in
the application
PROCEDURE that use IMS
FUNCTION PSBS
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Definitions of Valid Entities in Alliance Query Usage

PROGRAM USES SEGMENT Lists programs in

PROCEDURE that application
that use segments

FUNCTION in an IMS
database

PSB HAS PCB Lists PSBs in the
application and
PCBs contained
by the PSBS

PSB IN MEMBER Lists PSBs in the
application and
the member
names they are
stored under in
partitioned
datasets

PSB USEDBY PROGRAM Lists PSBs in the
application and

PROCEDURE the programs that
FUNCTION use them

RECORD HAS DATAITEM Lists the record
names in an

DSECT application and

STRUCTURE their field names

RECORD IN PROGRAM Lists the record

DSECT PROCEDURE names i a
program

STRUCTURE FUNCTION

RECORD REFERENCED-BY MAP Lists the record
names defined to

DSECT an application and

STRUCTURE the map names
that reference
them

RECORD USEDBY FD Lists the record
names defined to

DSECT FILEVAR an application and

STRUCTURE DCB the FDs that use
them

SCHEMA HAS SUBSCHEMA Lists the IDMS

schemas defined
to an application
and their
associated
subschemas
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Definitions of Valid Entities in Alliance Query Usage

SCHEMA

PROGRAM
PROCEDURE
FUNCTION

Lists programs
that reference
entities defined in
IDMS schemas

SEGFIELD

SEGMENT

Lists the IMS
segment fields
defined to an
application and
the segments
where they are
defined

SEGMENT

HAS

SEGFIELD

Lists the IMS
segments defined
to an application
and the fields
defined within
them

SEGMENT

DBD

Lists IMS
segments and the
parental DBD
associated with
them

SEGMENT

SEGMENT

Lists the segments
in an IMS
database and their
parent segments

SEGMENT

USEDBY

PROGRAM
PROCEDURE
FUNCTION

Lists IMS
segments used by
programs within
an application

SEGMENT

USES

SEGMENT

List the segments
in an IMS
database and their
child segments

SENFIELD

SENSEG

Lists sensitive
fields (defined by
an IMS
SENFIELD
statement) in a
sensitive segment
(defined by an
IMS SENSEG
statement)
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SENSEG

Definitions of Valid Entities in Alliance Query Usage

HAS

SENFIELD

Lists IMS
sensitive
segments and any
fields within the
segment defined
witha SENFIELD
statement

SENSEG

PCB

Lists sensitive
segments and the
PCB names where
they appear

SENSEG

SENSEG

Lists the sensegs
in a PCB and their
parental sensegs

SENSEG

USES

SENSEG

Lists the sensegs
in a PCB and their
children sensegs

SQL

PROGRAM
PROCEDURE
FUNCTION

Lists SQL entities
and any
referencing
programs

STEP

EXECUTES

LOADMODULE

Lists JCL step
names and the
load module
names that they
execute

STEP

EXECUTES

PROC

Lists JCL job
steps that execute
PROCS

STEP

HAS

DD

Lists steps and
DDS referenced
by them

STEP

JOB

Lists step names
and the job names
they are
associated with

STEP

PROC

Lists step names
and the PROCS
where they reside

STEP

USES

CATALOG

Lists JCL step
names and the
catalogs that are
referenced in the
step
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Definitions of Valid Entities in Alliance Query Usage

STEP

USES

LIBRARY

Lists JCL step
names and the
libraries that are
referenced as
Steplibs

STOGROUP

HAS

DATABASE

Lists the storage
groups and the
DB?2 databases
they contain

STOGROUP

PROGRAM
PROCEDURE
FUNCTION

Lists storage
group names and
the programs
where they are
defined

STRUCTURE
(See RECORD)

SUBSCHEMA

HAS

AREA

Lists IDMS
subschema names
and the logical
areas in an IDMS
database defined
within the
subschemas

SUBSCHEMA

HAS

LOGICALRECORD

Lists IDMS
subschema names
and the logical
record names that
they are
associated with

SUBSCHEMA

PROGRAM
PROCEDURE
FUNCTION

Lists programs
that reference
entities defined in
IDMS
subschemas

SUBSCHEMA

SCHEMA

Lists IDMS
subschema names
in the schemas
with which they
are associated

TABLE

HAS

COLUMN

Lists DB2
relational
database table
definitions and the
columns defined
within them
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TABLE

Definitions of Valid Entities in Alliance Query Usage

PROGRAM
PROCEDURE
FUNCTION

Lists programs
that reference
relational
database tables

TABLE

TABLESPACE

Lists DB2 tables
and the
tablespaces that
contains them

TABLESPACE

HAS

TABLE

Lists DB2
tablespaces and
the Tables defined
within

TABLESPACE

HAS

VIEW

Lists DB2
tablespaces and
the Views defined
within

TABLESPACE

DATABASE

Lists DB2
tablespaces and
the Databases
where they are
defined

TABLESPACE

PROGRAM
PROCEDURE
FUNCTION

Lists Programs
that reference
entities defined
within DB2
tablespaces

VIEW

HAS

COLUMN

Lists any defined
DB2 views and
the columns they
control

VIEW

PROGRAM
PROCEDURE
FUNCTION

Lists any defined
DB2 views and
the programs that
use them

VIEW

TABLESPACE

Lists DB2 views
and the
tablespaces where
they are defined
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Impact Analysis Entity Relationships

The Alliance Impact Facility traverses these recognized relationships to search for
additional impact answers for each of the given starting entity kinds:

Starting Entity Kind Entity Relationships

AREA AREA IN PROGRAM
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
AREA HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM
CATALOG CATALOG USEDBY JOB
CATALOG USEDBY STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP
CICS CICSTRANSACTION EXECUTES PROGRAM
TRANSACTION

CICSTRANSACTION EXECUTED-BY PROGRAM
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CICSTRANSACTION IN CSD
CICSTRANSACTION IN PCT
COLUMN COLUMN IN PROGRAM
COLUMN IN VIEW
VIEW IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICAL
RECORD
LOGICAL IN PROGRAM
RECORD
IDMSRECORD IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED- MAP
BY
MAP IN MAPSET
MAP HAS MAPFIELD
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Starting Entity Kind Entity Relationships

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD

SEGMENT HAS SEGFIELD

SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
COPYMEMBER  COPYMEMBER IN PROGRAM

COPYMEMBER USEDBY COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER HAS DATAITEM
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Starting Entity Kind Entity Relationships

DATAITEM IN RECORD
RECORD REFERENCED- MAP
BY
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD IN DBD
DD IN FCT
DD IN CSD
DD HAS DSN
DSN HAS MEMBER
CSECT CSECT IN LOADMODULE

LOADMODULE IN MEMBER
MEMBER IN LIBRARY
LOADMODULE EXECUTED-BY IMSTRANSACT

ION
LOADMODULE EXECUTED-BY STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP
CSECT IS PROGRAM
PROGRAM LINKED-BY PROGRAM
PROGRAM HAS ENTRY
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Starting Entity Kind Entity Relationships

ENTRY CALLED-BY PROGRAM
PROGRAM EXECUTED-BY CICSTRANSAC
TION

CURSOR CURSOR IN DATABASE
DATABASE IN STOGROUP
CURSOR IN PROGRAM

DATABASE DATABASE IN PROGRAM
DATABASE IN STOGROUP
DATABASE HAS CURSOR
CURSOR IN PROGRAM
DATABASE HAS TABLESPACE
TABLESPACE IN PROGRAM
TABLESPACE HAS VIEW
VIEW IN PROGRAM
VIEW HAS COLUMN
TABLESPACE HAS TABLE
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM

DATAITEM DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
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RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

DD

STEP

STEP

SEGMENT

SEGMENT

DBD

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG

SENSEG

SENSEG

REFERENCED-
BY

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN

IN

IN

IN

USEDBY

IN

HAS

HAS

IN

USES

HAS

IN

HAS

IN

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

STEP

JOB

PROC

PROGRAM

DBD

DD

SEGFIELD

SEGMENT

SEGMENT

SEGFIELD

PCB

SENFIELD

SENSEG
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Starting Entity Kind Entity Relationships

SENSEG USES SENSEG

IDMSRECORD IN AREA

AREA IN SUBSCHEMA

SUBSCHEMA IN SCHEMA

IDMSRECORD IN IDMSMAP

IDSMRECORD IN LOGICAL

RECORD

LOGICAL IN PROGRAM

RECORD

IDMSRECORD IN PROGRAM

COLUMN IN TABLE

TABLE IN TABLESPACE

TABLESPACE IN DATABASE

DATABASE IN STOGROUP

COLUMN IN VIEW

VIEW IN TABLESPACE
DBD DBD HAS DD

DD HAS DSN

DSN HAS MEMBER

DD IN STEP

STEP IN JOB

STEP IN PROC

PROC EXECUTED-BY STEP

DBD HAS SEGMENT
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Starting Entity Kind Entity Relationships

SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
DBD IN PCB
PCB HAS SENSEG
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
PCB IN PSB
PSB USEDBY PROGRAM
DBD IN MEMBER
MEMBER IN LIBRARY
DD DD SELECTED-BY FD
FD IN PROGRAM
FD USES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DD USEDBY PROGRAM
DD IN DBD
DD IN FCT
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Starting Entity Kind Entity Relationships

DD IN CSD
DD HAS DSN
DSN HAS MEMBER
DD IN STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP

DSN DSN HAS MEMBER
DSN IN DD
DD USEDBY PROGRAM
DD IN DBD
DBD HAS SEGMENT
SEGMENT USEDBY PROGRAM
DD IN FCT
DD IN CSD
DD SELECTED-BY FD
FD IN PROGRAM
FD USES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DD IN STEP
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STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP

ENTRY ENTRY IN PROGRAM
PROGRAM EXECUTED-BY CICSTRANSAC

TION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM USES DD
PROGRAM HAS FD
FD SELECTS DD
DD IN STEP
DD IN CSD
DD IN FCT
DD HAS DSN
DSN HAS MEMBER
PROGRAM HAS AREA
PROGRAM HAS LOGICAL
RECORD

PROGRAM HAS IDMSMAP
PROGRAM HAS IDMSRECORD
PROGRAM HAS SCHEMA
PROGRAM HAS SUBSCHEMA
PROGRAM HAS RECORD
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RECORD

RECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

MEMBER

PROGRAM

COPYMEMBER

PROGRAM

CSECT

LOADMODULE

STEP

STEP

PROC

LOADMODULE

PROGRAM

PROGRAM

HAS

REFERENCED-
BY

HAS

HAS

HAS

HAS

HAS

HAS

HAS

IN

IN

INCLUDES

USES

IS

IN

EXECUTED-BY

IN

IN

EXECUTED-BY

EXECUTED-BY

LINKED-BY

USES

Starting Entity Kind Entity Relationships

DATAITEM

MAP

COLUMN

CURSOR

DATABASE

STOGROUP

TABLE

TABLESPACE

VIEW

MEMBER

LIBRARY

COPYMEMBER

COPYMEMBER

CSECT

LOADMODULE

STEP

JOB

PROC

STEP

IMSTRANSAC
TION

PROGRAM

MAP
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Starting Entity Kind Entity Relationships

MAP IN MAPSET
PROGRAM USES MAPSET
PROGRAM USES PSB
PROGRAM USES SEGMENT
SEGMENT IN DBD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB

FCT FCT IN MEMBER
MEMBER IN LIBRARY
FCT HAS DD
DD USEDBY PROGRAM
DD SELECTED-BY FD
FD IN PROGRAM
FD USES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
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DD

IDMSRECORD

AREA

SUBSCHEMA

IDMSRECORD

IDMSRECORD

LOGICAL
RECORD

IDMSRECORD

COLUMN

TABLE

COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

USEDBY

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

DEFINED-IN

DEFINED-IN

USES

IN

IN

REFERENCED-
BY

Starting Entity Kind Entity Relationships

PROGRAM

AREA

SUBSCHEMA

SCHEMA

IDMSMAP

LOGICAL
RECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

153



ASG-Alliance User’s Guide

Starting Entity Kind Entity Relationships

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG

SENSEG

SENSEG

SENSEG

PCB

PCB

PSB

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN

HAS

IN

USES

USEDBY

IN

USES

IN

HAS

IN

REFERENCES

IN

USEDBY

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

SEGFIELD

SEGMENT

SEGMENT

PROGRAM

DBD

SENSEG

SENSEG

SENFIELD

PCB

DBD

PSB

PROGRAM
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Starting Entity Kind Entity Relationships

FCTCSC

FCT

CSD

DD

DD

FD

FD

RECORD

DATAITEM

COPYMEMBER

COPYMEMBER

IDMSRECORD

AREA

SUBSCHEMA

IDMSRECORD

IDMSRECORD

LOGICAL
RECORD

IDMSRECORD

TABLE

COLUMN

TABLE

TABLESPACE

HAS

HAS

HAS

USEDBY

SELECTED-BY

IN

USES

HAS

DEFINED-IN

USES

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

DD

DD

DD

PROGRAM

FD

PROGRAM

RECORD

DATAITEM

COPYMEMBER

COPYMEMBER

PROGRAM

AREA

SUBSCHEMA

SCHEMA

IDMSMAP

LOGICALRECO
RD

PROGRAM

PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

155



ASG-Alliance User’s Guide

Starting Entity Kind Entity Relationships

156

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

IN

IN

IN

DEFINED-IN

DEFINED-IN

USES

IN

IN

REFERENCED-
BY

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN

HAS

IN

USES

USEDBY

IN

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET
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FD
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DSN
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FCT

CSD

SEGFIELD

SEGMENT

SEGMENT

PROGRAM

DBD
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Starting Entity Kind Entity Relationships

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
FD FD SELECTS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD IN STEP

STEP IN JOB

STEP IN PROC

DD HAS DSN

DSN HAS MEMBER

FD IN PROGRAM

FD USES RECORD

RECORD REFERENCED- MAP

BY

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD HAS DATAITEM
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DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
FORMAT FORMAT EXECUTED-BY FORMAT
FORMAT EXECUTED-BY PROGRAM
PROGRAM EXECUTED-BY CICSTRANSAC
TION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM IS CSECT
CSECT IN LOADMODULE
LOADMODULE EXECUTED-BY IMSTRANSACT
ION
IMSTRANSACTION EXECUTED-BY PROGRAM
IMSTRANSACTION EXECUTED-BY FORMAT
PROGRAM LINKED-BY PROGRAM
IDMS IDMSMAP HAS IDMSRECORD
MAP REFERENCES RECORD
RECORD HAS DATAITEM
IDMS IN PROGRAM
IDMSMAP IN PROGRAM
IDMSRECORD IN PROGRAM
LOGICAL IN PROGRAM
RECORD
AREA IN PROGRAM



Appendix B - Impact Analysis Entity Relationships

SCHEMA

SUBSCHEMA

IDMSRECORD

IDMSRECORD

AREA

SUBSCHEMA

DATAITEM

DATAITEM

RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

DATAITEM

COPYMEMBER

COPYMEMBER

SEGMENT

IN

IN

IN

IN

IN

IN

DEFINED-IN

IN

REFERENCED-
BY

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN

DEFINED-IN

USES

IN

USEDBY

Starting Entity Kind Entity Relationships

PROGRAM

PROGRAM

LOGICAL
RECORD

AREA

SUBSCHEMA

SCHEMA

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

COPYMEMBER

COPYMEMBER

PROGRAM

PROGRAM
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Starting Entity Kind Entity Relationships

SEGMENT IN DBD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN PCB
SENSEG HAS SENFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
IDMS MAP IDMSMAP IN PROGRAM
IDMSMAP HAS IDMSRECORD
IDMSRECORD IN LOGICAL
RECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
COLUMN IN PROGRAM
TABLE IN PROGRAM
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COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

SEGMENT

SEGMENT
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DEFINED-IN
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HAS

USEDBY

SELECTS
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IN

IN
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HAS
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TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

SEGFIELD

SEGMENT
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Starting Entity Kind Entity Relationships

SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB
PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
IDMS RECORD IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM
IDMSRECORD IN LOGICAL
RECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
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COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG
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DEFINED-IN

DEFINED-IN

USES
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USEDBY

SELECTS
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IN
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USEDBY

IN
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VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

SEGFIELD

SEGMENT

SEGMENT

PROGRAM

DBD

SENSEG
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SENSEG IN SENSEG

SENSEG HAS SENFIELD

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM
IMS DYNALLOC IMS DYNALLOC IN MEMBER
MACRO MACRO

MEMBER IN LIBRARY
IMS IMSTRANSACTION EXECUTED-BY PROGRAM
TRANSACTION

PROGRAM EXECUTED-BY CICSTRANS

ACTION

PROGRAM HAS ENTRY

ENTRY CALLED-BY PROGRAM

PROGRAM IS CSECT

CSECT IN LOADMODULE

LOADMODULE EXECUTED-BY STEP

STEP IN JOB

STEP IN PROC

PROC EXECUTED-BY STEP

LOADMODULE EXECUTED-BY IMS

TRANSACTION
PROGRAM LINKED-BY PROGRAM
IMSTRANSACTION EXECUTED-BY FORMAT
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Starting Entity Kind Entity Relationships

FORMAT EXECUTED-BY FORMAT

FORMAT EXECUTED-BY PROGRAM

IMSTRANSACTION EXECUTES LOADMODULE

LOADMODULE HAS CSECT

CSECT IS PROGRAM
JCL PROC PROC EXECUTED-BY STEP

STEP IN JOB

JOB USES LIBRARY

JOB USES CATALOG

PROC HAS STEP

STEP USES CATALOG

STEP USES LIBRARY

STEP HAS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER

STEP EXECUTES LOADMODULE

LOADMODULE HAS CSECT

CSECT IS PROGRAM

PROC IN MEMBER

MEMBER IN LIBRARY
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JOB JOB HAS STEP
STEP USES LIBRARY
STEP USES CATALOG
STEP HAS DD
DD IN DBD
DD IN FCT
DD IN CSD
DD HAS DSN
DSN HAS MEMBER
STEP EXECUTES LOADMODULE
LOADMODULE HAS CSECT
CSECT IS PROGRAM
STEP EXECUTES PROC
JOB USES LIBRARY
JOB USES CATALOG
JOB IN MEMBER
MEMBER IN LIBRARY

LIBRARY LIBRARY USEDBY STEP
STEP IN JOB
STEP IN PROC
PROC EXECUTED-BY STEP
LIBRARY USEDBY JOB
LIBRARY HAS MEMBER
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Starting Entity Kind Entity Relationships

MEMBER HAS LOADMODULE

MEMBER HAS PROGRAM

MEMBER HAS JOB

MEMBER HAS PROC

MEMBER HAS PSB

MEMBER HAS DBD

MEMBER HAS PCT

MEMBER HAS PPT

MEMBER HAS FCT

MEMBER HAS MAPSET

MEMBER HAS IMSDYNALLOC
MACRO

MEMBER HAS FORMAT

MEMBER HAS COPYMEMBER

LOADMODULE LOADMODULE HAS CSECT

CSECT IS PROGRAM

PROGRAM EXECUTED-BY CICS
TRANSACTION

PROGRAM LINKED-BY PROGRAM

PROGRAM HAS ENTRY

ENTRY CALLED-BY PROGRAM

LOADMODULE EXECUTED-BY IMS
TRANSACTION

LOADMODULE EXECUTED-BY STEP

STEP IN JOB

167



ASG-Alliance User’s Guide

Starting Entity Kind Entity Relationships

168

STEP IN PROC
PROC EXECUTED-BY STEP
LOADMODULE IN MEMBER
MEMBER IN LIBRARY
LOGICAL LOGICALRECORD IN PROGRAM
RECORD
LOGICALRECORD  HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM
IDMSRECORD IN LOGICAL
RECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
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DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

MAP

MAP

RECORD

FD

DD

DSN

DD

DD

DD

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG

SENSEG

SENSEG

SENSEG

DEFINED-IN

USES

IN

IN

REFERENCED-
BY

IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN

HAS

IN

USES

USEDBY

IN

USES
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HAS

IN
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COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD

SEGFIELD

SEGMENT

SEGMENT

PROGRAM

DBD

SENSEG

SENSEG

SENFIELD

PCB
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PCB REFERENCES  DBD
PCB IN PSB
PSB USEDBY PROGRAM

MAP (CICS) MAP HAS MAPFIELD
MAP IN MAPSET
MAPSET USEDBY PROGRAM
MAP REFERENCES ~ RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN  PROGRAM
MAP USEDBY PROGRAM
IDMSMAP HAS IDMSRECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN LOGICAL

RECORD

IDMSMAP IN PROGRAM

MAPFIELD MAPFIELD IN MAP

(CICS)
MAP IN MAPSET
MAPSET USEDBY PROGRAM
MAP REFERENCES ~ RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN  PROGRAM
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MAP USEDBY PROGRAM
IDMSMAP HAS IDMSRECORD
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN LOGICAL
RECORD
IDMSMAP IN PROGRAM
MAPSET MAPSET USEDBY PROGRAM
MAPSET HAS MAP
MAP HAS MAPFIELD
MAP IN MAPSET
MAP REFERENCES RECORD
RECORD HAS DATAITEM
DATAITEM DEFINED-IN PROGRAM
MAP USEDBY PROGRAM
MEMBER MEMBER HAS DBD
MEMBER HAS FCT
MEMBER HAS FORMAT
MEMBER HAS JOB
MEMBER HAS LOADMODULE
MEMBER HAS MAPSET
MEMBER HAS IMSDYNALLOC

MACRO
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MEMBER HAS PCT
MEMBER HAS PROGRAM
MEMBER HAS PPT
MEMBER HAS PROC
MEMBER HAS PSB
MEMBER HAS COPYMEMBER
COPYMEMBER IN PROGRAM
COPYMEMBER USEDBY COPYMEMBER
COPYMEMBER HAS DATAITEM
DATAITEM IN RECORD
MEMBER IN LIBRARY
MEMBER IN DSN

PCB PCB REFERENCES DBD
PCB IN PSB
PSB USEDBY PROGRAM
PCB HAS SENSEG
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SENFIELD
SEGMENT HAS SENFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
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SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
PCT PCT IN MEMBER
MEMBER IN LIBRARY
PCT HAS CICS
TRANSACTION
CICSTRANSACTION EXECUTES PROGRAM
PPT PPT IN MEMBER
MEMBER IN LIBRARY
PROGRAM PROGRAM EXECUTED-BY CICS
TRANSACTION
PROGRAM HAS ENTRY
ENTRY CALLED-BY PROGRAM
PROGRAM USES DD
PROGRAM HAS FD
FD SELECTS DD
DD IN STEP
DD IN CSD
DD IN FCT
DD HAS DSN
DSN HAS MEMBER
PROGRAM HAS AREA
PROGRAM HAS LOGICAL
RECORD
PROGRAM HAS ISMSMAP
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PROGRAM

PROGRAM

PROGRAM

PROGRAM

RECORD

RECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

PROGRAM

MEMBER

PROGRAM
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PROGRAM

CSECT

LOADMODULE
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STEP

PROC

HAS
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INCLUDES
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EXECUTED-BY

IN

IN

EXECUTED-BY

IDMSRECORD

SCHEMA

SUBSCHEMA

RECORD

DATAITEM

MAP

COLUMN

CURSOR
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STOGROUP

TABLE

TABLESPACE

VIEW

LIBRARY

COPYMEMBER

COPYMEMBER

CSECT

LOADMODULE

STEP

JOB

PROC

STEP
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LOADMODULE EXECUTED-BY IMS
TRANSACTION

PROGRAM LINKED-BY PROGRAM
PROGRAM USES MAP
MAP IN MAPSET
PROGRAM USES MAPSET
PROGRAM USES PSB
PROGRAM USES SEGMENT
SEGMENT IN DBD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SEGFIELD
SENSEG IN PCB

PSB PSB USEDBY PROGRAM
PSB HAS PCB
PCB REFERENCES DBD
PCB HAS SENSEG
SENSEG IN SENSEG
SENSEG USES SENSEG
SENSEG HAS SEGFIELD
SEGMENT HAS SEGFIELD
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SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

PSB IN MEMBER

MEMBER IN LIBRARY
RECORD RECORD HAS DATAITEM

DATAITEM DEFINED-IN PROGRAM

DATAITEM DEFINED-IN COPYMEMBER

COPYMEMBER USES COPYMEMBER

COPYMEMBER IN PROGRAM

RECORD REFERENCED- MAP

BY

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD IN DBD

DD IN FCT

DD IN CSD

DD HAS DSN

DSN HAS MEMBER

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD
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SEGMENT

SEGMENT

SEGMENT

SEGMENT

SENSEG

SENSEG

SENSEG

SENSEG

IDMSRECORD

IDMSRECORD

AREA

SUBSCHEMA

IDMSRECORD

IDMSRECORD

LOGICALRECORD

COLUMN

TABLE

COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

HAS

IN

USES

HAS

IN

HAS

IN

USES

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

Starting Entity Kind Entity Relationships

SEGFIELD

SEGMENT

SEGMENT

SEGFIELD

PCB

SENFIELD

SENSEG

SENSEG

PROGRAM

AREA

SUBSCHEMA

SCHEMA

IDMSMAP

LOGICAL
RECORD

PROGRAM

PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE
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SCHEMA SCHEMA IN PROGRAM
SCHEMA HAS SUBSCHEMA
SUBSCHEMA IN PROGRAM
SUBSCHEMA HAS LOGICAL

RECORD

LOGICALRECORD IN PROGRAM
LOGICALRECORD  HAS IDMSRECORD
SUBSCHEMA HAS AREA

AREA IN PROGRAM
AREA HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMPA
IDMSMAP IN PROGRAM

SEGMENT SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
DBD HAS DD
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB
PCB REFERENCES DBD
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Starting Entity Kind Entity Relationships

PCB IN PSB
PSB USEDBY PROGRAM
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICAL
RECORD
LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
COLUMN IN PROGRAM
TABLE IN PROGRAM
COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM

DATAITEM IN RECORD
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RECORD REFERENCED- MAP
BY

MAP IN MAPSET

MAP HAS MAPFIELD

RECORD USEDBY FD

FD SELECTS DD

DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT
SEGFIELD DD IN CSD

SEGFIELD IN SEGMENT

SENSEG USES SENSEG

SENSEG IN SENSEG

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM

SEGMENT IN SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

IDMSRECORD IN AREA

AREA IN SUBSCHEMA

SUBSCHEMA IN SCHEMA
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IDMSRECORD

IDMSRECORD

LOGICALRECORD

IDMSRECORD

COLUMN

TABLE

COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD

MAP

MAP

RECORD

FD

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

DEFINED-IN

DEFINED-IN

USES

IN

IN

REFERENCED-
BY

IN

HAS

USEDBY

SELECTS
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IDMSMAP

LOGICAL
RECORD

PROGRAM

PROGRAM

PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD
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DD HAS DSN

DSN HAS MEMBER

DD IN DBD

DD IN FCT

DD IN CSD
SENFIELD SENFIELD IN SENSEG

SENFIELD USES SENSEG

SENSEG IN SENSEG

SENSEG IN PCB

PCB REFERENCES DBD

PCB IN PSB

PSB USEDBY PROGRAM

SEGMENT IN SEGMENT

SEGMENT USES SEGMENT

SEGMENT USEDBY PROGRAM

SEGMENT IN DBD

IDMSRECORD IN AREA

AREA IN SUBSCHEMA

SUBSCHEMA IN SCHEMA

IDMSRECORD IN IDMSMAP

IDMSRECORD IN LOGICALRECO

RD
LOGICALRECORD IN PROGRAM

IDMSRECORD IN PROGRAM
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COLUMN

TABLE

COLUMN

TABLE

TABLESPACE

DATABASE

COLUMN

VIEW

DATAITEM

DATAITEM

COPYMEMBER

COPYMEMBER

DATAITEM

RECORD
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MAP

RECORD

FD

DD

DSN

DD

DD

DD
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IN
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IN
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IN

IN

DEFINED-IN

DEFINED-IN

USES

IN

IN
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IN

HAS

USEDBY

SELECTS

HAS

HAS

IN

IN

IN
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PROGRAM

PROGRAM

TABLE

TABLESPACE

DATABASE

STOGROUP

VIEW

TABLESPACE

PROGRAM

COPYMEMBER

COPYMEMBER

PROGRAM

RECORD

MAP

MAPSET

MAPFIELD

FD

DD

DSN

MEMBER

DBD

FCT

CSD
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SENSEG

SENSEG

SENSEG

SENSEG

SENSEG

PCB

PCB

PSB

SEGMENT

SEGMENT

SEGMENT

SEGMENT

SEGMENT

IDMSRECORD
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IDMSRECORD
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PROGRAM
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Starting Entity Kind Entity Relationships

TABLESPACE IN DATABASE
DATABASE IN STOGROUP
COLUMN IN VIEW
VIEW IN TABLESPACE
DATAITEM DEFINED-IN PROGRAM
DATAITEM DEFINED-IN COPYMEMBER
COPYMEMBER USES COPYMEMBER
COPYMEMBER IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED- MAP
BY

MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD HAS DSN
DSN HAS MEMBER
DD IN DBD
DD IN FCT
DD IN CSD

SQL COLUMN IN TABLE
TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
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COLUMN
VIEW

SQL
COLUMN
TABLE

VIEW
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DATABASE
DATAITEM
DATAITEM
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DATAITEM
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COPYMEMBER
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PROGRAM

PROGRAM

PROGRAM

PROGRAM
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Starting Entity Kind Entity Relationships

SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT HAS SEGFIELD
SENSEG IN PCB
SENSEG HAS SENFIELD
SENSEG IN SENSEG
SENSEG USES SENSEG
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICAL
RECORD
LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
STEP STEP IN JOB
STEP IN PROC
STEP EXECUTES PROC
STEP USES LIBRARY
STEP USES CATALOG
STEP HAS DD
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DD IN DBD
DD IN FCT
DD IN CSD
DD HAS DSN
DSN HAS MEMBER
STEP EXECUTES LOADMODULE
LOADMODULE HAS CSECT
CSECT IS PROGRAM
STOGROUP STOGROUP IN PROGRAM
STOGROUP HAS DATABASE
DATABASE IN PROGRAM
DATABASE HAS CURSOR
CURSOR IN PROGRAM
DATABASE HAS TABLESPACE
TABLESPACE IN PROGRAM
TABLESPACE HAS VIEW
VIEW IN PROGRAM
VIEW HAS COLUMN
TABLESPACE HAS TABLE
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM
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Starting Entity Kind Entity Relationships

SUBSCHEMA SUBSCHEMA IN PROGRAM
SUBSCHEMA IN SCHEMA
SUBSCHEMA HAS LOGICAL

RECORD

LOGICALRECORD IN PROGRAM
LOGICALRECORD  HAS IDMSRECORD
SUBSCHEMA HAS AREA

AREA IN PROGRAM
AREA HAS IDMSRECORD
IDMSRECORD IN PROGRAM
IDMSRECORD IN IDMSMAP
IDMSMAP IN PROGRAM

TABLE TABLE IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICAL

RECORD
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LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED- MAP

BY
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD HAS DSN
DSN HAS MEMBER
DD IN DBD
DD IN FCTY
DD IN CSD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB
PCB REFERENCES DBD
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PCB IN PSB
PSB USEDBY PROGRAM
TABLESPACE TABLESPACE IN DATABASE
DATABASE IN STOGROUP
TABLESPACE IN PROGRAM
TABLESPACE HAS VIEW
VIEW IN PROGRAM
VIEW HAS COLUMN
TABLESPACE HAS TABLE
TABLE IN PROGRAM
TABLE HAS COLUMN
COLUMN IN PROGRAM
EW VIEW IN TABLESPACE
TABLESPACE IN DATABASE
DATABASE IN STOGROUP
VIEW IN PROGRAM
VIEW HAS COLUMN
COLUMN IN PROGRAM
IDMSRECORD IN AREA
AREA IN SUBSCHEMA
SUBSCHEMA IN SCHEMA
IDMSRECORD IN IDMSMAP
IDMSRECORD IN LOGICAL

RECORD
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LOGICALRECORD IN PROGRAM
IDMSRECORD IN PROGRAM
DATAITEM IN RECORD
RECORD REFERENCED- MAP

BY
MAP IN MAPSET
MAP HAS MAPFIELD
RECORD USEDBY FD
FD SELECTS DD
DD HAS DSN
DSN HAS MEMBER
DD IN DBD
DD IN FCT
DD IN CSD
SEGMENT HAS SEGFIELD
SEGMENT IN SEGMENT
SEGMENT USES SEGMENT
SEGMENT USEDBY PROGRAM
SEGMENT IN DBD
SENSEG USES SENSEG
SENSEG IN SENSEG
SENSEG HAS SENFIELD
SENSEG IN PCB
PCB REFERENCES DBD
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Starting Entity Kind Entity Relationships

PCB IN PSB

PSB USEDBY PROGRAM
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Appendix C
Managing the AKR

The ESW family of components provides AKR management tools through online
utilities. For more information on online utilities, see the ASG-Application Definition and
Analysis User’s Guide.

Allocating the AKR

An AKR is a BDAM or VSAM file. The AKR is the repository for all of the information
used by the ESW family of components.

You can create a new AKR, or expand an existing one. Each AKR can contain multiple
applications and you can allocate multiple AKRs for a single change, as necessary. You
may want to allocate one AKR for each major business unit in your company (for
example, manufacturing, accounting, sales). The size of the AKR depends on the number
and size of the application definitions it contains.

Allocating the AKR with ISPF

You can allocate an AKR with or without using ISPF. For step-by-step instructions on
allocating the AKR without using ISPF, see "Allocating and Expanding AKRs without
ISPF" on page 198.
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To use ISPF to allocate an AKR

1 Choose File » AKR utility from the primary product screen and press Enter. The
ESW - AKR Utility pop-up (see Figure 69) displays.

Figure 69 « ESW - AKR Utility Pop-up

E:ZM — AKR Utility
ConHand ===

Elank - Di=splay Hedber list O - Delete Hednber
] = Hllocate~<eHdpand AKR R - Renane Hedbetr

Application Knowledge Repository [AKR]:

Data =et name . . 'UIAUERLGEMERAL.AKR’

HeWbar o o & & & o __ [if "R" or "0 selected)
Mew maWe o . . o __________ [if "R" selected)
Volure =erial . . ______ [if not cataloged]
Password . . . . [if password protected]

2 In the Dataset name field, type the name of the AKR to be allocated. If the high level
qualifier is different than your TSO prefix or user ID, enter the name in single quotes
(). The last node of the name should normally be AKR.

3  Type A on the Command line to specify the allocate command and press Enter.

4  Ifthe AKR will not be cataloged, in the Volume serial field, type the serial number
of the volume where the AKR will reside.

5  To password-protect the AKR, type the password in the Password field.
6  Press Enter to open the File - AKR Allocate/Expand pop-up.
7  The pop-up that opens depends on whether you use BDAM or VSAM AKRs and

whether SMS is turned on for your site. Figure 70 on page 197 assumes a
BDAM-VSAM sequential AKR.
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Figure 70  File - AKR Allocate/Expand Pop-up with a VSAM AKR

File Understand Change

Command ===

Test

File - AKR AllocatesExpand

Document Re-engineer

5 - Submit JCL
Expand existing AKR . . . HO
AKR data set name .

Yolume
Unit

Job statement information:
A ANAME
ey MSGCLASS=A

Fiw

E - Edit JCL

'USER. TEST.AKR'

. FECORDE

Space units . {Records, Tracks or Cylinders)
Primary space . . . dE00 (Primary amount in above units}
Secondary space . . . . A {Secondary amount in above units)

JOE {ACCOUMT 3, MNAHE,

fi® INSERT '/+ROUTE PRINT NOCDE.USER' HERE IF NEEDED.

C - Specify Catalog

(¥es or No)

{Generic unit name}

Specify this information:

Expand existing AKR field

Enter No in this field.

Volume field The volume serial number for the AKR. This
field is required if Storage class is not specified.
Unit field The generic unit name.

Space units field

The type of units to allocate. The units must be
records, tracks, or cylinders.

Primary space field

The amount of space required. For information
on the expected size of the AKR and analyze
work files, see the ASG-Application Definition
and Analysis User’s Guide.

Secondary space field

The amount of secondary space required.

Job statement information field

Enter the job card and routing information.
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13

If you need to specify a private catalog to contain the name of the AKR, type C on
the Command line and press Enter. The AKR Catalog Information pop-up displays.
Type the catalog dataset name and password.

To submit the AKR for allocation, type S in the command line and press Enter.
Or
To edit the JCL, type E in the command line and press Enter.

Modify the JCL, then issue the standard TSO SUBMIT command.

Type End in the command line or press PF3 to return to the File - AKR
Allocate/Expand pop-up.

Verify the allocation job by examining the job output. The allocation is successful
when the condition code 0 appears in the output.

After the AKR is successfully allocated, create the application. For step-by-step
instructions on creating and defining the application, see the ASG-Application Definition
and Analysis User’s Guide.

Allocating and Expanding AKRs without ISPF

The batch AKR utility can allocate and expand VSAM AKRs without using ISPF. ESW
provides you with the VIASAKRA JCL to allocate an AKR, and the VIASAKRX JCL to
expand an AKR. Figure 71 on page 199 shows the VIASAKRA JCL. Figure 72 on page
201 and Figure 73 on page 202 show the VIASAKRX JCL.
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Figure 71 « VIASAKRA JCL for a VSAM AKR

Appendix C - Managing the AKR

CM % % ko s ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok Sk ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok Sk ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok k k 00010000

)
)CM * ASG, INC. ASG-CENTER MM-YYYY * 00020003
)CM * * 00030000
)CM * SKELETON JCL FOR SUBMITTING A BATCH JOB TO ALLOCATE AND * 00040000
)CM * INITIALIZE A ASG APPLICATION KNOWLEDGE REPOSITORY (AKR) . * 00050003
)CM khkkhkhkhkhkhhkhkhkhhhhhhhhkhkhkhhhkhhkhkhhhhhhhkhhhhkhkhhkhhkhhkhkhkhkhkhkhkhkhkhkhkhkhkkkhkkkhkhkkx 00060000
) CM 00070000
) CM 00080000
)CM KAk hkhkhkkhkhhkhkkhkhkkhkhkkhkhkhkhkhkhkhkhkhkkhkrhhkkxkkhkkx 00090000
)CM * JOB STATEMENT INFORMATION * 00100000
)CM EE SRS S S SRS RS EEEEEEEEEEEEESEEEEEEE] Oolloooo
) CM 00120000
&VSV11JB1 00130000
&VSV11JB2 00140000
&VSV11JB3 00150000
&VSV11JB4 00160000
) CM 00170000
)CM Kk hkhkhkkhkhkhkhkhkhkkhkhkhkhkhkhkhkhkhkhkhkhkrhhkkxkkkkx 00180000
)CM * IN-STREAM JCL PROCEDURE * 00190000
)CM EE SRS S S SRS RS EEEEEEEEEEEEESEEEEEEE] OOzOOOOO
) CM 00210000
) IM VIASAKAP OPT 00220000
// PEND 00230000
//* 00240000
) CM 00250000
)CM EE SRS S S SRS RS EEEREEEEEEEEESEEEEEEE] 00260000
)CM * EXECUTE JCL STATEMENTS * 00270000
)CM Kk hkhkhkhkhkhkhkhkhkhkkhkhkkhkhkhkhkhkhkhkhkhkhkrhhkkxkkkkx 00280000
) CM 00290000
//VIASAKRA EXEC VIASAKAP 00300000
//* 00310000
) SEL &VSV32VAC = YES 00320000
//DEFAKR.SYSIN DD * 00330000
DEFINE CLUSTER - 00340000
(NAME (&VSVIDB) - 00350000
) SEL &VSV32SPU = CYLINDERS 00360000
CYLINDERS (&VSV32SPA) - 00370000
) ENDSEL 00380000
) SEL &VSV32SPU = RECORDS 00390000
RECORDS (&VSV32SPA) - 00400000
) ENDSEL 00410000
) SEL &VSV32SPU = TRACKS 00420000
TRACKS (&§VSV32SPA) - 00430000
) ENDSEL 00440000
) SEL &VSV32DCL 2= &7Z 00450000
DATACLAS (&VSV32DCL) - 00460000
) ENDSEL 00470000
) SEL &VSV32MCL 2= &7Z 00480000
MGMTCLAS (&VSV32MCL) - 00490000
) ENDSEL 00500000
) SEL &VSV32VOL 2= &7 00510000
VOLUME (&VSV32VOL) - 00520000
) ENDSEL 00530000
) SEL &VSV32SCL 2= &7Z 00540000
STORCLAS (&VSV32SCL) - 00550000
) ENDSEL 00560000
CONTROLINTERVALSIZE (4096) - 00570000
NUMBERED - 00580000
RECORDSIZE (4089 4089) - 00590000
RECOVERY - 00600000
) SEL &VSV32UNQ 2= NO 00610000
UNIQUE - 00620000
) ENDSEL 00630000
SHAREOPTIONS (3 3)) - 00640000
) SEL &VSV32CAT 2= &Z && &VSV32PSW = &% 00650000
CATALOG (&§VSV32CAT) - 00660000
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To allocate an AKR without ISPF

1 Replace XX in the NAME(XX), NAME(XX.DATA), and the DSNAME(XX)
parameters with the name of the AKR to be allocated.

2 Replace XX(xX) with the allocation units values and quantities for your site.

Figure 72 on page 201 and Figure 73 on page 202 show an example of an AKR
VIASAKRX JCL.
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Figure 72 « VIASAKRX JCL for a VSAM AKR (1 of 2)

Appendix C - Managing the AKR

)CM khkkkhkkhkhkhhkhkhkhhhhhhkhhkhhhhrkhhkhhhhhkhhhkhhkhhkhkhhkhhkhkhkhkhkhkhkhkhkhkhkhkkhkhkkhkhkkhxkhkkxk OOOlOOOO
)CM * ASG, INC. ASG-CENTER MM-YYYY * 00020003
)CM * * 00030000
)CM * SKELETON JCL FOR SUBMITTING A BATCH JOB TO EXPAND A * 00040000
)CM *  ASG APPLICATION KNOWLEDGE REPOSITORY (AKR) . * 00050003
)CM Ak kkhkkhkhkhhkhkhkhhhhhhkhhkhhrkhrkhhkhhhhhhhhkhhkhkhkhkhhkhhkhkhkhkhkhkhkhkhkhkhkhkkhkhkkhkhkkhxkhkhkxk 00060000
) CM 00070000
) CM 00080000
)CM KAk hkhkhkkhkhhkhkkhkhkkhkhkkhkhkhkhkhkhkhkhkhkkhkrhhkkxkkhkkx 00090000
)CM * JOB STATEMENT INFORMATION * 00100000
)CM EE SRS S S SRS RS EEEEEEEEEEEEESEEEEEEE] Oolloooo
) CM 00120000
&VSV11JB1 00130000
&VSV11JB2 00140000
&VSV11JB3 00150000
&VSV11JB4 00160000
) CM 00170000
)CM Kk hkhkhkkhkhkhkhkhkhkkhkhkhkhkhkhkhkhkhkhkhkhkrhhkkxkkkkx 00180000
)CM * IN-STREAM JCL PROCEDURE * 00190000
)CM EE SRS S S SRS RS EEEEEEEEEEEEESEEEEEEE] OOzOOOOO
) CM 00210000
) IM VIASAKXP OPT 00220000
// PEND 00230000
//* 00240000
) CM 00250000
)CM EE SRS S S SRS RS EEEREEEEEEEEESEEEEEEE] 00260000
)CM * EXECUTE JCL STATEMENTS * 00270000
)CM Kk hkhkhkhkhkhkhkhkhkhkkhkhkkhkhkhkhkhkhkhkhkhkhkrhhkkxkkkkx 00280000
) CM 00290000
//VIASAKRX EXEC VIASAKXP 00300000
//* 00310000
) SEL &VSV32VAC = YES 00320000
//DEFAKR.SYSIN DD * 00330000
DEFINE CLUSTER - 00340000
(NAME (§VSVIDB. .EX) - 00350000

) SEL &VSV32SPU = CYLINDERS 00360000
CYLINDERS (&VSV32SPA) - 00370000

) ENDSEL 00380000
) SEL &VSV32SPU = RECORDS 00390000
RECORDS (&VSV32SPA) - 00400000

) ENDSEL 00410000
) SEL &VSV32SPU = TRACKS 00420000
TRACKS (&§VSV32SPA) - 00430000

) ENDSEL 00440000
) SEL &VSV32DCL 2= &7Z 00450000
DATACLAS (&VSV32DCL) - 00460000

) ENDSEL 00470000
) SEL &VSV32MCL 2= &7Z 00480000
MGMTCLAS (&VSV32MCL) - 00490000

) ENDSEL 00500000
) SEL &VSV32VOL 2= &7 00510000
VOLUME (&VSV32VOL) - 00520000

) ENDSEL 00530000
) SEL &VSV32SCL 2= &7Z 00540000
STORCLAS (&VSV32SCL) - 00550000

) ENDSEL 00560000
CONTROLINTERVALSIZE (4096) - 00570000

NUMBERED - 00580000

RECORDSIZE (4089 4089) - 00590000

RECOVERY - 00600000

) SEL &VSV32UNQ 2= NO 00610000
UNIQUE - 00620000

) ENDSEL 00630000
SHAREOPTIONS (3 3)) - 00640000

) SEL &VSV32CAT 2= &Z && &VSV32PSW = &% 00650000
CATALOG (&§VSV32CAT) - 00660000

) ENDSEL 00670000
) SEL &VSV32CAT 2= &Z && &VSV32PSW 2= &% 00680000
CATALOG (&§VSV32CAT/&VSV32PSW) - 00690000
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Figure 73 « VIASAKRX JCL for a VSAM AKR (2 of 2)

) ENDSEL 00700000
DATA - 00710000

(NAME (&VSVIDB. .EX.DATA) ) 00720000

) ENDSEL 00730000
//* 00740000
//INITAKR.STEPLIB DD DSN=VIASHxx.PROD.XALOAD,DISP=SHR ** IN-HOUSE** 00750002
//INITAKR.VIASYSIN DD * 00770000
INIT DSNAME (&VSVIDB..EX) 00780000
//* 00790000
) SEL &VSV32CAT 2= &7 00800000
//INITAKR.STEPCAT DD DSN=&VSV32CAT, 00810000
// DISP=SHR 00820000
) ENDSEL 00830000
//* 00840000
) SEL &VSV32EXD 2= MIX 00850000
//REPRO.SYSIN DD * 00860000
REPRO INDATASET (&VSVIDB) - 00870000
OUTDATASET (&VSVIDB. .EX) - 00880000
REPLACE 00890000

//* 00900000
) SEL &VSV32CAT 2= &7 00910000
//REPRO.STEPCAT DD DSN=&VSV32CAT, 00920000
// DISP=SHR 00930000
) ENDSEL 00940000
//* 00950000
//RESIZE.STEPLIB DD DSN=VIASHxx.PROD.XALOAD,DISP=SHR ** IN-HOUSE ** 00960002
//RESIZE.VIASYSIN DD * 00980000
RESIZE DSNAME (§VSVIDB. .EX) 00990000
//* 01000000
) SEL &VSV32CAT 2= &7 01010000
//RESIZE.STEPCAT DD DSN=&VSV32CAT, 01020000
// DISP=SHR 01030000
) ENDSEL 01040000
) ENDSEL 01050000
//* 01060000
) SEL &VSV32EXD = MIX 01070000
//COPY.VIASYSIN DD * 01080000
COPY * NOREPLACE 01090000
) ENDSEL 01100000
//RENAME .SYSIN DD * 01110000
01120000

DELETE &VSVIDB PURGE 01130000
01140000

ALTER &VSVIDB..EX - 01150000
NEWNAME (&VSVIDB) 01160000

) SEL &VSV32VAC = YES 01170000
ALTER &VSVIDB..EX.DATA - 01180000
NEWNAME (&VSVIDB. .DATA) 01190000

) ENDSEL 01200000
//* 01210000
) SEL &VSV32CAT 2= &7 01220000
//RENAME . STEPCAT DD DSN=&VSV32CAT, 01230000
// DISP=SHR 01240000
) ENDSEL 01250000
//* 01260000
//DELETE.SYSIN DD * 01270000
DELETE &VSVIDB..EX PURGE 01280000
//* 01290000
) SEL &VSV32CAT 2= &7 01300000
//DELETE.STEPCAT DD DSN=&VSV32CAT, 01310000
// DISP=SHR 01320000
) ENDSEL 01330000
//* 01340000
) CM 01350000
)CM *** END OF VIASAKRX *** 01360000
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To expand an AKR without using ISPF

1 Replace XX in the NAME(XX.EX), NAME(XX.EX.DATA), DSNAME(XX.EX),
INDATASET(XX), and the OUTDATASET(XX.EX) parameters with the name of
the AKR to be expanded.

2 Replace XX(xX) with the allocation units values and quantities for your site.

To rename an AKR without using ISPF

1 Replace the XX in the DELETE statement with the AKR to be renamed.

2 Type the new AKR name in the NEWNAME(XX) parameter.
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Appendix D

Import and Export Facility

Importing an Application Definition

The Import facility enables you to import an application definition into Alliance. To
prepare the application definition to be imported, you must either edit an existing file or
create a new file, inserting keywords from the Import language described in the
ASG-Application Definition and Analysis User’s Guide. These keywords enable Alliance
to identify the components and attributes for each library and member included in the file
and to convert the application definition to the structure required by the Application
Analytical Engine.

To import an application definition

1

Using the Import language described in the ASG-Application Definition and
Analysis User’s Guide, edit or create a file containing the keywords to identify the
application information, defaults, and the components and attributes of the
application definition.

Save the file.

Start Alliance using the procedure defined for your site.

Select File » Import/Export from the Alliance Primary screen and press Enter.

Select Import Definition and press Enter.

In the Dataset name field of the File - Import Definition pop-up, type the name of the
dataset containing the import file you created in step 1.

If the high level qualifier is different than your TSO prefix or user ID, enter the name
in single quotes ('). For example, 'USER.TEST.APPLDEF"'.

205



ASG-Alliance User’s Guide

7  Inthe Member name field, type the name of the member containing the import
information and press Enter.

The message APPLICATION <application name> IMPORTED
SUCCESSFULLY displays.

Note:

If the import does not complete successfully, verify the dataset and member names
for the import file. If the names are correct, review the structure and syntax of the
import file to locate any errors or invalid data input.

Exporting the Application Information

You can export both the application definition and the information produced from an
analyze job. Store the exported definition in a sequential file or a PDS member. Load
exported application analysis information into DB2 tables or input it to other database
managers. For information on loading into DB2, see "Defining and Loading DB2
Databases" on page 258. For information on exporting application information to the
Texas Instruments Transition Enablement Facility product, see "Exporting to Transition
Enablement Facility (TEF)" on page 334.

For AutoChange users, Alliance provides an automated export facility that stores both the
application definition and information produced from an analyze job in PDS members for
use by AutoChange. For information on using this facility see "Using Export for
AutoChange" on page 216.

Exporting Application Definition Data
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The exported application definition consists of a series of keyword control statements
with a syntax that is consistent with the requirements of the Import facility. The keyword
control statements identify:

. The AKR
. The application name and description

. The application components and their associated attributes

For a description of the keyword control statement syntax, see "Importing an Application

Definition" on page 205.
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Use the exported application definition to perform these tasks:
. Create a backup of the application definition for easy recovery.
. Copy an application definition from one AKR to another.

. Copy an application definition to use as a template when you are creating a similar
definition.

To export the application definition

1 Identify or create a sequential file or a PDS to contain the exported definition. The
file must have a record length of 80.

2 Select File » Import/Export from the Alliance Primary screen and press Enter. The
File - Export Definition pop-up (see Figure 74) displays.

Figure 74 « File - Export Definition Pop-up

File - Export Definitiaon
Cammand ===

Type AKR and Export information, then press enter.
Application Enowledge Repository (AKR 3

Data set name . . . ‘VIAKAS.TEST AKR'
Application name . .

Expart:

Data set name
Hember . . . . . . .

3 On the File - Export Definition pop-up, specify this information:
. The AKR dataset name containing the application to export
. The application name
. The export definition dataset name

. If the export definition dataset is a PDS, specify the export definition member
name

4 Press Enter to execute the export request.

Note:
When the export of the application definition is complete, the message <application
name>" EXPORTED displays in the short message area of the File - Export Definition
pop-up.
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Copying Application Definition Data

Use the Import facility to copy the exported application definition to an AKR (the
original AKR or another AKR) by editing the exported definition.

To copy the exported application definition

1

At the <AKR> keyword control statement, change the AKR dataset name to indicate
the target dataset name.

At the <APPLICATION NAME> keyword statement, change the application name
to the application name desired.

Note:
Application names must be unique within an AKR.

To complete this process, follow the instructions located in "Importing an
Application Definition" on page 205.

Creating an Application Definition Template
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Edit the exported definition to use the Import facility to create an application definition
template.

To create a template from the exported application

1

At the <AKR> keyword control statement, change the AKR dataset name to indicate
the target dataset name.

At the <APPLICATION NAME> keyword statement, change the application name
to the application name desired.

Application names must be unique within an AKR.
To update the application definition, use either of these methods:

Edit the exported application definition file. Modify the keyword control
statements, and their associated attribute keyword control statements, to create the
new application definition.

Or

Import the application definition into the target AKR (see "Importing an
Application Definition" on page 205). Then use the online application definition
function to modify the imported definition as appropriate.
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Exporting Application Analysis Results

Exported application analysis information consists of comma delimited output files
created for each application entity and relationship. Use the exported application
information files to load DB2 tables, or transfer it to your workstation for input to
database applications. For more information about AKR export output, see "Output From
an AKR Export" on page 223.

Use the exported application analysis information as part of the input to develop this
business information:

. Planning models

. Impact of change analyses
. Where-used queries

. Work plans

. Manpower requirement estimates

Export application information using the online facility or using batch JCL supplied with
the product.

Using the Online Facility to Export Analysis Data
To export application information using the online facility
1 Start the product using the procedure defined for your site.

2 Select File » Export application from the Alliance Primary screen and press Enter.
The File - Import/Export pop-up displays.

3 Select Export Data and press Enter. The Data Export pop-up (see Figure 75 on
page 210) displays.
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Figure 75 » Data Export Pop-up

CorHand ===}

Data Export

3. COOLIGen Export

Job statenent information:
#NAFE JOE [ACCOUNT ], MAHE,

£ HEGCLAEE=A
s TNEERT
sk

Ipecify optionz and jobcard infornation.

Zelecting "Edit JCL" or "SubWit TJCL" will delete any edizting

WRRNI NG!
EHDDPT files created under thiz userid.
E¥port Tupe __ 1. Flat Files

2. DBZ Load

' AROUTE PRINT MWODE.UZER' HERE IF MEEDED.

PF4=COOLIGen EXport Options PFS=Edit JCL  PFE=SubHiT JCL

Then press PF kKey for action.

DEZ2 Zubsyzten:

4  Type the DB2 subsystem name to immediately load the files into a DB2 database in

the DB2 Subsystem field.

5  In the Export Type field, perform one or more of these actions:

Sequential files containing the
exported application data

Flat File. For example, you might want to
create a sequential file and bypass the DB2
database load.

Note:
If you specify Flat File, the sequential files

containing the exported application data are
catalogued when you submit the export job.

Use the data as input to a batch DB2 load or
other software, or transfer it to your
workstation for input to a database manager.

Application data exported into
sequential files and then loaded
into a DB2 database as part of the
same job
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DB2 Load.

The appropriate DB2 entities must be defined
before the DB2 export.
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If you want Specify Export Type

Note:
If you specify that a DB2 load is performed
as part of the export job, the default JCL
deletes the files containing the exported data
after a successful load. To retain these files,
edit the JCL before submitting the job, and
change the disposition JCL parameters.

Application data exported to the =~ TI-TEF Export. For more information about
TI Transition Enablement Facility this option, see "Exporting to Transition
Enablement Facility (TEF)" on page 334.

6  Type the job card information required for your site in the Job Statement information
field.

7 To submit the export job, choose one of these options:

To edit the generated JCL file before submitting the export job, press Edit JCL. Use
the editor SUBMIT command to submit the export job for execution.

Or

To execute the export request without editing the generated JCL, press Submit JCL.

Using Batch JCL to Export Analysis Data

You can also use batch JCL to export application data. The JCL has symbolic parameters
you can edit to meet your export requirements. Edit and submit these jobs when you
prefer not to start the online application.

The batch JCL members you need to accomplish these tasks are located in this PDS:

<ASG>.<CENTER>.CNTL

You might have to consult your systems administrator for help on locating the JCL.
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This is the JCL included with the Export facility:

Dataset Name Description

VIABXTRIJ Exports application data from a ESW AKR into sequential files.
See Figure 76.

VIABXDFJ Defines a DB2 database. See Figure 77 on page 213.

VIABXDF1 Inputs CREATE control statements for VIABXDFIJ. See Figure 78
on page 213.

VIABXDF2 Inputs DSN control statements for VIABXDF]J. See Figure 79 on
page 213.

VIABXLD Loads application data from sequential files into a DB2 database.
See Figure 80 on page 214.

VIABXLD1 Inputs LOAD control statements for VIABXLDJ. See Figure 81
on page 215.

Figure 76 » Sample VIABXTRJ

//*ASG JOB ( ),'ASG EXPORT EXTR' 00010001
//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED. 00020000
//* 00030000
//* R RS RS E RS RS EEESEEEEESESEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEE] 00040000
//* * ASG, INC. ASG-ALLIANCE MM-YYYY * 00050001
//* * * 00060000
//* * UNLOAD APPLICATION DATA FROM A ASG AKR INTO FLAT FILES * 00070001
//* * * 00080000
//* * NOTE: ELRECL & RLRECL ARE ALREADY MINIMIZED TO REFLECT * 00090000
//* * THE INFORMATION OUTPUT BY THE EXPORT FACILITY. * 00100000
//* * 00110000
//* khkkkhkhkhhkhkhkhkhhhhhhhhhkhhrkhhkhkhkhkhhhhhhhkhhk kb hkhhkhhkhkhkhkhkhkhkhkhkhkhkkkhkhkkhkkkhkkx 00120000
//* 00130000
//VIABXTR PROC SYSOUT='*"', PRINTED OUTPUT MESSAGE CLASS 00140000
// VIASOFT='ASG', HIGH LEVEL NODE OF ASG DATA SETS 00150001
// CENTER='VIACENXX', MIDDLE NODE OF ASG DATA SETS 00160001
// AKR="XXX.YYY.ZZZ"' ASG AKR 00170001
//* 00180000
//EXTRACT EXEC PGM=VIABEXPT,REGION=4096K, 00190000
// PARM= ('APPL=APPLNAME") 00200000
//* 00210000
//STEPLIB DD DSN=&VIASOFT..&CENTER..LOADLIB, DISP=SHR 00220000
//VIAAKR DD DSN=&AKR, DISP=SHR 00230000
//VIAUT3 DD UNIT=SYSDA,SPACE=(CYL, (10,10)) 00240000
//VIALOG DD SYSOUT=&SYSOUT 00250000
//VIAARPT DD SYSOUT=&SYSOUT 00260000
//VIAPRINT DD SYSOUT=&SYSOUT 00270000
//SYSPRINT DD SYSOUT=&SYSOUT 00280000
//* 00290000
// PEND 00300000
//* 00310000
//STEP1  EXEC VIABXTR 00320000
//* 00330000
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Figure 77 « Sample VIABXDFJ

//ASG JOB ( ),'ASG EXPORT DEF' 00010001
//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED. 00020000
//* 00030000
//* AR RS S S S S SRS SR SRS SRS R SRS R R R R R SRS RS SR SRS RS RS EEEE SRS EEEESE S S ST 00040000
//* * ASG, INC. ASG-ALLIANCE MM-YYYY * 00050001
//* * * 00060000
//* * DEFINE DB2 DATABASE FOR EXPORT FEATURE * 00070000
//* * * 00080000
//* khhkhkhkkhkhkhkhkhkhkhhkhkhkhhkhkhkhkhhkhhkhkrhkhkhkhkhkhkhhkhkhkhkhkhkhkkhkhkhkhkhhkhkkhkhkhkhkhkhkhkhkhkkkxk*x*k 00090000
//* 00100000
//JOBLIB DD DSN=DB2.DSNLOAD, DISP=SHR 00110000
//* 00120000
//DEFINE EXEC PGM=IKJEFTO1, DYNAMNBR=20 00130000
//SYSTSPRT DD SYSOUT=* 00140000
//SYSTSIN DD * 00150000
//SYSPRINT DD SYSOUT=* 00160000
//SYSUDUMP DD SYSOUT=* 00170000
//SYSIN DD DSN=ASG.VIACENXX.CNTL (VIABXDF1),DISP=SHR 00180001
//SYSTSIN DD DSN=ASG.VIACENXX.CNTL (VIABXDF2),DISP=SHR 00190001
//* 00200000

Figure 78 « Sample VIABXDF1

CREATE TABLE ASG.PROGRAM
(PROGRAM KEY CHAR(8) NOT NULL,
PROGRAM_NAME CHAR(8) NOT NULL,
PRIMARY KEY (PROGRAM KEY))

IN DATABASE USERDB;

CREATE UNIQUE INDEX ASG.PROGRAM KEY INX
ON ASG.PROGRAM
(PROGRAM_KEY ASC)
USING STOGROUP USERSTGP
PRIQTY 10
ERASE NO
BUFFERPOOL BPO
CLOSE YES;

CREATE INDEX ASG.PROGRAM NAME INX
ON ASG.PROGRAM
(PROGRAM NAME ASC)
USING STOGROUP USERSTGP
PRIQTY 10
ERASE NO
BUFFERPOOL BPO
CLOSE YES;

COMMIT;

Figure 79 « Sample VIABXDF2

DSN SYSTEM(USERSYS)
RUN PROGRAM(DSNTIAD) LIB(USER.DB2.LOADLIB') PLAN(USERPLAN)
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214

Figure 80 « Sample VIABXLDJ

//ASG JOB ( ),'ASG EXPORT LOAD'

//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

//*

//* AR RS S S S S SRS SR SRS SRS R SRS R R R R R SRS RS SR SRS RS RS EEEE SRS EEEESE S S ST
//*  * ASG, INC. ASG-ALLIANCE *
//* * *
//* * LOAD APPLICATION DATA FROM FLAT FILES TO DB2 *
//* * *
//* khhkhkhkkhkhkhkhkhkhkhhkhkhkhhkhkhkhkhhkhhkhkrhkhkhkhkhkhkhhkhkhkhkhkhkhkkhkhkhkhkhhkhkkhkhkhkhkhkhkhkhkhkkkxk*x*k
//*

//VIABXLD EXEC DSNUPROC, PARM= ('SUBSYSTEM')

//*

//SORTLIB DD DSN=SYS1.SORTLIB,DISP=SHR

//SORTOUT DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//SORTWKO1 DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//SORTWK02 DD UNIT=SYSDA, SPACE=(CYL, (10,10),,,ROUND)

//SORTWKO3 DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//SORTWK04 DD UNIT=SYSDA,SPACE=(CYL, (10,10),,,ROUND)

//DSNTRACE DD SYSOUT=*

//SYSMAP DD UNIT=SYSDA,SPACE=(CYL, (1,1)

//SYSUT1 DD UNIT=SYSDA,SPACE=(CYL, (50,50),,,ROUND)

//*

//SYSIN DD DSN=ASG.VIACENXX.CNTL (VIABXLD1),DISP=SHR

//*

//DDENT000 DD DSN=USER.VIABEXPT.EXPORT.EPGM, DISP=(SHR, KEEP, KEEP)
//DDENT001 DD DSN=USER.VIABEXPT.EXPORT.EENTRY,DISP=(SHR,KEEP, KEEP)
//DDENT002 DD DSN=USER.VIABEXPT.EXPORT.ECOPYMEM, DISP=(SHR,KEEP,KEEP)
//DDENT003 DD DSN=USER.VIABEXPT.EXPORT.EFD,DISP=(SHR,KEEP,KEEP)
//DDENT004 DD DSN=USER.VIABEXPT.EXPORT.ERECORD,DISP=(SHR,KEEP, KEEP)
//DDENT005 DD DSN=USER.VIABEXPT.EXPORT.EDATAITM, DISP=(SHR,KEEP,KEEP)
//DDENT006 DD DSN=USER.VIABEXPT.EXPORT.EIDMS,DISP=(SHR,KEEP,KEEP)
//DDENT007 DD DSN=USER.VIABEXPT.EXPORT.ESQL,DISP=(SHR,KEEP,KEEP)
//DDENT008 DD DSN=USER.VIABEXPT.EXPORT.ECSECT,DISP=(SHR,KEEP, KEEP)
//DDENT009 DD DSN=USER.VIABEXPT.EXPORT.ELOADMOD, DISP=(SHR, KEEP, KEEP)
//DDENT010 DD DSN=USER.VIABEXPT.EXPORT.EJOB,DISP=(SHR,KEEP,KEEP)

00010001
00020000
00030000
00040000
00050001
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230001
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
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Figure 81 « Sample of VIABXLD1

LOAD DATA REPLACE
INDDN (DDENT000) INTO TABLE VIASOFT.PROGRAM
(PROGRAM_KEY POSITION(01:08) CHAR(8) ,
PROGRAM_NAME POSITION(10:17) CHAR (8))

LOAD DATA REPLACE
INDDN (DDENT001) INTO TABLE VIASOFT.ENTRY
(ENTRY_KEY POSITION(01:08) CHAR(8),
ENTRY NAME POSITION(10:19) CHAR (10))

LOAD DATA REPLACE
INDDN (DDENTO002) INTO TABLE VIASOFT.COPYMEMBER
(COPYMEMBER KEY POSITION(01:08) CHAR(8),
COPYMEMBER NAME POSITION (10:19) CHAR(10))

LOAD DATA REPLACE
INDDN (DDENT003) INTO TABLE VIASOFT.FED
(FD_KEY POSITION(01:08) CHAR(8) ,
FD NAME POSITION(10:39) CHAR (30))

LOAD DATA REPLACE
INDDN (DDENTO004) INTO TABLE VIASOFT.RECORD
(REC_KEY POSITION(01:08) CHAR(8),
REC_NAME POSITION (10:39) CHAR (30))

LOAD DATA REPLACE
INDDN (DDENTO005) INTO TABLE VIASOFT.DATAITEM

(DATA_KEY POSITION(01:08) CHAR(8),
DATA NAME POSITION (10:39) CHAR (30),
DATA LEVEL POSITION (41:42) CHAR(2),
DATA PARENT POSITION (44:51) CHAR(8),
DATA CHILD POSITION (53:60) CHAR(8),

DATA NEXT STBLING POSITION (62:69) CHAR(8),
DATA PREV_SIBLING POSITION(71:78) CHAR(8),
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Using Export for AutoChange

Use this procedure to export an application definition and the corresponding data
resulting from an analyze job:

Note:

To successfully complete this export procedure, the application must be sematically
linked and be free of errors.

1 From the Alliance primary screen (see Figure 82) open the application you want to
export.

Figure 82 ¢ Alliance Opened to Application to be Exported

File Edit Wiew Facility Options Help

ASG-ALliance

Command ===3>
KEERRRRRRRRRRRRRRRAR RRERRRRRRRRRRRRRRRRR R AR AR AR AR AR AR AR
RRERRRRRRRRRRRRARLRELE  RRRRRRRR R R R R R R R R R AR AR Rk Rk kR
Kk kkE KhkkE  KRERER Kk kkE
Kk kkE KhkkE  KRERER Kk kkE
RRERRRRRRRRRRRRRRLREE KRR RRRRRRRRRRRRAR Kk kkE EETET 2T
RRERRRRRRRRRRRRRRRRAR RRERRRRRRRRRRRREE  KRERA EEZETETE
Kk kkE Kk kkE KhkkRE RRRER EEE
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Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Yisit the ASG Support Web Site at www.asg.com

2 Select Facility » Impact option and press Enter. The Impact Facility screen displays
(see Figure 83).

Figure 83 « Impact Facility Screen for Selected Application

File Edit ¥iew Search Generate Worklist Options Help

Impact Facility
Command ===% Scroll ===* L3R

MName:
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3 On the Impact Facility screen, select File » Option 3 » New Impact List and press
Enter.
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length. (see Figure 84)

Figure 84 « New Impact Pop-up

File

Command i
Mame:

Aok
Aok

Edit Miew Search Generate Worklist Options  Help

Hew Imnpact
Command ===

ASG3ITTEL IMPACT "TESTEWTRZ" SUCCESSFULLY OPEMED.

Specify the name and description. Then press PF key for action.

Hame . . . . . TESTEHMTRZ
Lescription . . TEST FILE

FF4=Edit Impact FF3=Summary Impact FFE=Detailed Impact

5  Press PF4 to go the Impact Entity List (see Figure 85).

Figure 85 » Impact Entity List

Inpact Entity List

CoHHand === Ecroll ===k CER

Press PF kew for actions. Delete requires selection 1 of 2695
of entryls].

Current Zort kKewl NAHE

Entity Kind Nare
PROGRAN-PROCEDURE-FUNCTION «BACE-DATE
PROGRAN-PROCEDURE-FUNCTION - COBSC-ERROR-CODE:
PROGRAN-PROCEDURE-FUNCTION «DATEE-TY
PROGRAN-PROCEDURE-FUNCTION SME-DATES-YY
PROGRAN-PROCEDURE-FUNCTION SWE-E-TY
ENTRYT ' COBSE"
ENTRYT tCoesct
ENTRYT ‘CDileR’
ENTRYT ‘CD1GE"
ENTRYT 'CDLSE’

PFd=Add entity PFS=Delete entity PFE=Change fort
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6  To add an entity, Press PF4. The Impact Entities Selection Criteria pop-up displays
(see Figure 86).

Figure 86 « Impact Entities Selection Criteria Pop-up

Inpact Entities &election Criteria
Comrand === Zcroll ===k CER

Textl *
1 of 51
Entity kind [Default = All)

ARER

CATALOG
CICE-TRANSACTION
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DATRAEBASE
DATAITEH

DED

oo

DEN

PF5=%elect all FFe=Unselact all

7 Confirm that the Text field contains an asterisk (*), then select the Dataitem entity
and press Enter. The Add Impact List Entity screen displays (see Figure 87).

Figure 87 « Add Impact List Entity Screen

fadd Impact List Entity

Command ===} _ Scroll ===: CSR
Select desired entries then press the Add key. 1 of 157
Previously selected entries are marked with an asterisk.
Text: #*
Text Entity Kind
< EMD-IHPUT CATAITEM
< EMD-0F-COLS CATAITEM
< FIRST-TIME CATAITEM
< FIRST-TIME-SW CATAITEM
< IMPUT-EMD-0OF -FILE CATAITEM
< MISC-FIELDS CATAITEM
< OTL-CHG-CC-4 CATAITEM
< OTL-CHG-DL-1 CATAITEM
< OTL-CHG-DD-2 CATAITEM
< OTL-CHG-DL-32 CATAITEM

FFS=5elect all FPFE=Unhselect a1l  FPF1lO=Add

8 Press PF5 to Select all selections, then press PF10 to Add the selection.

9 Press PF3 to return to the New Impact screen.

218



Appendix D - Import and Export Facility

10 To generate the Summary Impact, press PF5. The
Summary Impact - Select Impact Generation Entities screen displays (see

11

12

Figure 88).

Figure 88 « Summary Impact - Select Impact Generation Entities Screen

Command ===

Summary Impact - Select Impact Generation Entities

Scroll ===: CSR

be generated.

FF2=0ptions PFd4=Generate

Select the items from which the impact list will

Text Entity Kind
— EMD-IHPUT CATAITEM
— EMD-IHPUT CATAITEM
— EMD-IHPUT CATAITEM
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— EMD-IHPUT CATAITEM
— EMD-0F-COLES CATAITEM
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— FIRST-TIME CATAITEM
— FIRST-TIME CATAITEM
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PFE=Hide entity kind

To select all entities, press PF5.

Or

Select individual entities to include in the summary.

Press PF2 for Options. The Impact Generate Options screen displays (see Figure 89).
Confirm you have chosen all options shown selected on this example screen.

Figure 89  Impact Generate Options Screen
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Select desired Impact Generate Options.
#  Include Baze Selection in results
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FF4=Restore ASG Default Options

EBase Impact Targets: Application Assighments
Targets Lewel Synonyms  To Fram Alternates
# Base Selection s - - -
# Parents of Base Selection - - - -
# Children of Baze Selection s s s s
Expanded Impact Targets: Application Assighments
Targets Lewel Synonyms  To Fram Alternates
<  Base Impact Targets - - # #
< Parents of Base Impact Targets - - - -
# Children of Base Impact Targets ~ - - -

PFS=Detailed Options
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13  Press PF3 to return to the Summary Impact - Select Impact Generation Entities

screen.

14  To generate the entity list, press PF4. When the entity list is complete, the Impact

Facility screen displays.

15 To create a worklist to store the saved results of this summary, select Worklist » New

worklist and press Enter. The New Worklist pop-up (see Figure 90).

Figure 90 « New Worklist Pop-up

Mew Worklist
Command ===}

Hame . « « o . WELSTTST
Description . . TEST WORKLIST
[Lata =set

Specify the worklist name and description. Then press Enter.

[(Optional)

16  Enter a name and description for the new worklist. Press Enter. If you do not enter a
worklist name, Alliance assigns a default name to the worklist.

17  Select Worklist » Write worklist and press Enter. The Impact Facility screen displays
the statement VIEW CONTENTS HAS BEEN SAVED TO WORKLIST "XXXXX"

where XXXXX is the name given to your worklist.

18 Seclect Worklist » Close worklist and press Enter.

19 Select Generate » ASG-AutoChange Export File and press Enter. The

Generate Impact Export for ASG-AutoChange screen displays (see Figure 91).

Figure 91  Generate Impact Export for ASG-AutoChange Screen

Batch Options Help

Gernerate Impact Export For ASG-AutoChange
Command ===}

ppplication Definition:

Data Set Mame 'V IAJFC.EXPORT.DEF '
Member Mame . . YIAQAHEW

Export Data:

Lata Set Mame "WIAJFC.EXPORT.DATA'

Member Mame . . WIAQAHEW

Warklist Hame "MIAJFC.ALHOOOGOS, Y IAWKLET
AKR DSH . . . . "MIAQA.QAESWSE. ATCHMAST. AKRS
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20 Enter this information:

. Application Definition:

. Export Data:

of the application.

Appendix D - Import and Export Facility

Use a PDS for the Dataset name and enter a new member name.

Use a PDS for Dataset name and enter the member name that is the name

The Worklist Name is the name of the worklist created in step 15. The

AKR DSN is the name of the AKR where the application definition is

stored.

Note:

All dataset names must be fully qualified.

21

From the Batch Menu choose one of these actions:

To export the impact, submit the job. The Batch job is scheduled. A message

displays stating the job was submitted.

Or

To edit the JCL, edit the job. The JCL edit facility displays (see Figure 92).

Figure 92 « JCL Edit Facility

File Edit Confirm Henu Utilities CoWpilers Test Help

EDIT UIATFC.T1dE714, VIATCL ColuHns DRAOL DDATE

CoHHand === Zcroll ===} PAGE
Top of Data

==HZG> —Uarning— The UNDD cordand i=s not available until Loy change

==Hz5r our edit profile using the coWdand RECOUERY OM.

apoael ~-ULATFE  TOE [ACCOUMT ), MAHE,

AOEROZ - HIZGCLASI=A

A0EAO3 <ok INZERT '.~kROUTE PRINT WODE.USER' HERE IF MEEDED.

AOBAOG ok

AOBEOS ok

AOOAOE ~oRAZG  JOE [ ),'ASE EXPORT EXTR

AOEAO7 <ok INZERT '.~ROUTE PRINT WODE.USER' HERE IF MEEDED.

AOBAOS ok

AOBEOD ok

BOEALD sok ok AEE, INC. AZE-ALLIANCE HH =0T *

AOEAL1 sok *

BOEAL2 <ok UMLOAD APPLICATION DATA FROM A AZE AKR INTO FLAT FILES *

AOEALT sok *

@0E@ld <ok # NOTE: ELRECL & RLRECL ARE ALREADY MIWIHIZED TO REFLECT

AOEALE sok THE INFORHATION OUTPUT EY THE EXPORT FACILITY. *

BOORLE sok *
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Appendix E
Export Language Reference

Output From an AKR Export

Entity Files

The AKR export job creates a sequential file for each of the entities and relationships in
the application. Transfer the files created by the AKR export to your workstation and load
them into your workstation database. You can also load these files into DB2 tables or

1

other databases. For more information about exporting data to DB2, see "Defining and
Loading DB2 Databases" on page 258.

The format for application data files created for entities is described in the section under
Entity Files. The format for application data files created for relationships is described
under "Relationship Files" on page 232.

Note:

The Assembler language does not create specific ASM entity kinds. All entity kinds look
the same as their COBOL counterparts (for example, a DCB appears as an FD). For more
information about Assembler language support, see the chapter regarding assembler
language support in the ASG-Application Definition and Analysis User’s Guide.

These are the application entity data types and export files:

Entity Type Filename

AREA <userid>EXPORT.<application name>.AREA
Col 1: AREA Key
Col 2: AREA Name
CATALOG <userid>.EXPORT.<application name>.CATALOG
Col 1: CATALOG Key
Col 2: CATALOG Name
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Entity Type Filename

CICS-TRANSA <userid>EXPORT.<application name>CICSTRAN

CTION
Col 1: CICS-TRANSACTION Key
Col 2: CICS-TRANSACTION Name
COLUMN <userid>EXPORT.<application name>COLUMN
Col 1: COLUMN Key
Col 2: COLUMN Name

COPYMEMBER <userid>EXPORT.<application name>COPYMEMB

Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Name
CSD <userid>.EXPORT.<application name>.CSD
Col 1: CSD Key
Col 2: CSD Name
CSECT <userid>.EXPORT.<application name>.CSECT
Col 1: CSECT Key
Col 2: CSECT Name
CURSOR <userid>EXPORT.<application name>CURSOR
CURSOR Key
CURSOR Name

DATABASE <userid>.EXPORT.<application name>DATABASE
Col 1: DATABASE Key

Col 2: DATABASE Name
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Entity Type Filename

DATAITEM <userid>.EXPORT.<application name>DATAITEM
Col 1: DATAITEM Key
Col 2: DATAITEM Name
Col 3: ATTRIBUTE Level
Col 4: ATTRIBUTE Parent Key
Col 5: ATTRIBUTE Child Key
Col 6: ATTRIBUTE Next Key
Col 7: ATTRIBUTE Prev Key
Col 8: ATTRIBUTE Picture Clause
Col 9: ATTRIBUTE Usage
Col 10: ATTRIBUTE Occurs
Col 11: ATTRIBUTE Redefines Key
Col 12: ATTRIBUTE Rename Key
Col 13: ATTRIBUTE Rename Through Key
Col 14: ATTRIBUTE Size
Col 15: ATTRIBUTE Offset
Col 16: ATTRIBUTE Position
Col 17: ATTRIBUTE Value Clause
Col 18: ATTRIBUTE Uses
Col 19: ATTRIBUTE Modifications
Col 20: ATTRIBUTE References
Col 21: ATTRIBUTE Conditional
Col 22: ATTRIBUTE Arithmetic
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Entity Type Filename

Col 23: ATTRIBUTE Create
Col 24: ATTRIBUTE Read
Col 25: ATTRIBUTE Update
Col 26: ATTRIBUTE Delete
DBD <userid>EXPORT.<application name>DBD
Col 1: DBD Key
Col 2: DBD Name
DD <userid>.EXPORT.<application name>DD
Col 1: DD Key
Col 2: DD Name
DSN <userid>EXPORT.<application name>DSN
Col 1: DSN Key
Col 2: DSN Name
Col 3: DSN Entity ATTRIBUTE
ENTRY <userid>EXPORT.<application name>ENTRY
Col 1: ENTRY Key
Col 2: ENTRY Name
FCTCSD <userid>.EXPORT.<application name>FCTCSD
Col 1: FCTCSD Key
Col 2: FCTCSD Name
FD <userid>EXPORT.<application name>FDFILEVA
Col 1: FD Key
Col 2: FD Name
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Entity Type Filename

Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
FORMAT <userid>EXPORT.<application name>IMSFORMA
Col 1: FORMAT Key
Col 2: FORMAT Name
FCT <userid>.EXPORT.<application name>FCT
Col 1: FCT Key
Col 2: FCT Name
IDMS <userid>EXPORT.<application name>IDMS
Col 1: IDMS Key
Col 2: IDMS Name
IDMSMAP <userid>.EXPORT.<application name>IDMSMAP
Col 1: IDMSMAP Key
Col 2: IDMSMAP Name

IDMSRECORD <userid>.EXPORT.<application name>IDMSRECO

Col 1: IDMSRECORD Key

Col 2: IDMSRECORD Name

Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
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Entity Type Filename

IMS DYN <userid>.EXPORT.<application name>IMSDYNAL
ALLOC MACRO
Col 1: IDMS DYN ALLOC MACRO Key
Col 2: IDMS DYN ALLOC MACRO Name
IMS- <userid>EXPORT.<application name>IMSTRANS
TRANSACTION
Col 1: IMS-TRANSACTION Key
Col 2: IMS-TRANSACTION Name
JOB <userid>.EXPORT.<application name>.JOB
Col 1: JOB Key
Col 2: JOB Name
LIBRARY <userid>EXPORT.<application name>.LIBRARY
Col 1: LIBRARY Key
Col 2: LIBRARY Name

LOADMODULE <userid>.EXPORT.<application name>LOADMODU

Col 1: LOADMOD Key

Col 2: LOADMOD Name
LOGICAL <userid>EXPORT.<application name>LOGICALR
RECORD

Col 1: LOGICALRECORD Key

Col 2: LOGICALRECORD Name
MAP <userid>.EXPORT.<application name>MAP

Col 1: MAP Key

Col 2: MAP Name
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Filename

Appendix E - Export Language Reference

MAPFIELD <userid>.EXPORT.<application name>MAPFIELD
Col 1: MAPFIELD Key
Col 2: MAPFIELD Name
MAPSET <userid>EXPORT.<application name>MAPSET
Col 1: MAPSET Key
Col 2: MAPSET Name
MEMBER <userid>.EXPORT.<application name>MEMBER
Col 1: MEMBER Key
Col 2: MEMBER Name
PCB <userid>EXPORT.<application name>PCB
Col 1: PCB Key
Col 2: PCB Name
PCT <userid>.EXPORT.<application name>PCT
Col 1: PCT Key
Col 2: PCT Name
PPT <userid>EXPORT.<application name>.PPT
Col 1: PPT Key
Col 2: PPT Name
PROC <userid>.EXPORT.<application name>PROC
Col 1: PROC Key
Col 2: PROC Name
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Entity Type Filename

PROGRAM <userid>.EXPORT.<application name>PROGRAMP
Col 1: PROGRAM Key
Col 2: PROGRAM Name
PSB <userid>EXPORT.<application name>.PSB
Col 1: PSB Key
Col 2: PSB Name
RECORD <userid>.EXPORT.<application name>RECORDS
Col 1: RECORD Key
Col 2: RECORD Name
SCHEMA <userid>EXPORT.<application name>SCHEMA
Col 1: SCHEMA Key
Col 2: SCHEMA Name
SEGFIELD <userid>.EXPORT.<application name>SEGFIELD
Col 1: SEGFIELD Key
Col 2: SEGFIELD Name
SEGMENT <userid>EXPORT.<application name>SEGMENT
Col 1: SEGMENT Key
Col 2: SEGMENT name
Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
Col 5: T/F: Indicates whether a UPDATE was used
Col 6: T/F: Indicates whether a DELETE was used
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Entity Type Filename

SENFIELD <userid>.EXPORT.<application name>.SENFIELD
Col 1: SENFIELD Key
Col 2: SENFIELD Name
SENSEG <userid>EXPORT.<application name>.SENSEG
Col 1: SENSEG Key
Col 2: SENSEG Name
SQL <userid>EXPORT.<application name>.SQL
Col 1: SQL Entity Key
Col 2: SQL Entity Name
STEP <userid>EXPORT.<application name>.STEP
Col 1: STEP Key
Col 2: STEP Name
STOGROUP <userid>.EXPORT.<application name>.STOGROUP
Col 1: STOGROUP Key
Col 2: STOGROUP name

SUBSCHEMA <userid>.EXPORT.<application name>SUBSCHEM

Col 1: SUBSCHEMA Key
Col 2: SUBSCHEMA Name
TABLE <userid>.EXPORT.<application name>TABLE
Col 1: TABLE Key
Col 2: TABLE Name
Col 3: T/F: Indicates whether a CREATE was used
Col 4: T/F: Indicates whether a READ was used
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Entity Type Filename

Col 5: T/F: Indicates whether a UPDATE was used

Col 6: T/F: Indicates whether a DELETE was used

TABLESPACE <userid>EXPORT.<application name>TABLESPA

Col 1: TABLESPACE Key
Col 2: TABLESPACE Name
VIEW <userid>.EXPORT.<application name>VIEW
Col 1: VIEW Key
Col 2: VIEW Name

Relationship Files

These are the relationship files:

Relationship Type Filename

AREA HAS RECORDS <userid>.EXPORT.<application
name>ARAHRECF

Col 1: AREA Key
Col 2: IDMSRECORD Key

AREA IN PROGRAM <userid>.EXPORT.<application
name>.ARAINPGM

Col 1: AREA Key
Col 2: PROGRAM Key

AREA IN SUBSCHEMA  <userid>.EXPORT.<application
name>. AINSUBSF

Col 1: AREA Key
Col 2: SUBSCHEMA Key

CALLS IS ENTRY <userid>.EXPORT.<application
name>.CALISENT

Col 1: CALL Key
Col 2: ENTRY Key
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Relationship Type Filename

CATALOG USEDBY JOB <userid>EXPORT.<application
name>.CATUBJOB

Col 1: CATALOG Key
Col 2: JOB Key

CATALOG USEDBY <userid>.EXPORT.<application
STEP name>.CATUBSTF

Col 1: CATALOG Key
Col 2: STEP Key

CICSDD USEDBY <userid>.EXPORT.<application
PROGRAM name>.CDDUBPGM

Col 1: CICSDD Key
Col 2: PROGRAM Key

CICS-TRANSACTION <userid>.EXPORT.<application
EXECUTED-BY name>TRAEBPGM

PROGRAM Col 1: CICS-TRANSACTION Key
Col 2: PROGRAM Key

CICS-TRANSACTION <userid>.EXPORT.<application
EXECUTES PROGRAM  name>.CTREXPGM

Col 1: CICS-TRANSACTION Key
Col 2: PROGRAM Key

CICS-TRANSACTION IN <userid>EXPORT.<application
CSD name>.CTRINCSD

Col 1: CICS-TRANSACTION Key
Col 2: CSD Key

CICS-TRANSACTION IN <userid>EXPORT.<application
PCT name>.CTRINPCT

Col 1: CICS-TRANSACTION Key
Col 2: PCT Key

COLUMN IN PROGRAM <userid>EXPORT.<application
name>.COLINPGM

Col 1: COLUMN Key
Col 2: PROGRAM Key
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Relationship Type Filename
COLUMN IN TABLE <userid>.EXPORT.<application
name>.COLINTAB

Col 1: COLUMN Key
Col 2: TABLE Key

COLUMN IN VIEW <userid>.EXPORT.<application
name>.COLIVIEW

Col 1: COLUMN Key
Col 2: VIEW Key

COPYMEMBER HAS <userid>.EXPORT.<application
DATAITEM name>INCHDDEF

Col 1: COPYMEMBER Key
Col 2: DATAITEM Key

COPYMEMBER IN <userid>EXPORT.<application
COPYMEMBER name>.CPYINICP

Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

COPYMEMBER IN <userid>EXPORT.<application
MEMBER name>.COPYIMBR

Col 1: COPYMEMBER Key
Col 2: MEMBER Key

COPYMEMBER IN <userid>.EXPORT.<application
PROGRAM name>.CPMINPGM

Col 1: COPYMEMBER Key
Col 2: PROGRAM Key

COPYMEMBER <userid>.EXPORT.<application
INCLUDES name>.CPYICPYF
COPYMEMBER

Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

COPYMEMBERUSEDBY <userid>EXPORT.<application
COPYMEMBER name>.CPYUSBCP

Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key
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Relationship Type Filename

COPYMEMBERUSEDBY <userid>EXPORT.<application
MEMBER name>MBINCSRC

Col 1: COPYMEMBER
Col 2: MEMBER

COPYMEMBER USES <userid>.EXPORT.<application
COPYMEMBER name>.CPYUSCPY

Col 1: COPYMEMBER Key
Col 2: COPYMEMBER Key

CSD HAS <userid>.EXPORT.<application
CICS-TRANSACTION name>.CSDHCTRF

Col 1: CSD Key
Col 2: CICS-TRANSACTION Key

CSD HAS DD <userid>.EXPORT.<application
name>.CSDHDDF
Col 1: CSD Key
Col 2: DD Key
CSECT IN <userid>.EXPORT.<application
LOADMODULE name>.CSECINLM

Col 1: CSECT Key
Col 2: LOADMODULE Key

CSECT IS PROGRAM <userid>.EXPORT.<application
name>.CSECTPGM

Col 1: CSECT Key
Col 2: PROGRAM Key

CURSOR IN DATABASE <userid>EXPORT.<application
name>.CURINDBF

Col 1: CURSOR Key
Col 2: DATABASE Key

CURSOR IN PROGRAM  <userid>EXPORT.<application
name>.CSRINPGM

Col 1: CURSOR Key
Col 2: PROGRAM Key
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Relationship Type Filename
DATABASE HAS <userid>.EXPORT.<application
CURSOR name>DBHCSRF

Col 1: DATABASE Key
Col 2: CURSOR Key

DATABASE HAS <userid>.EXPORT.<application
TABLESPACE name>DBHTBLSP

Col 1: DATABASE Key
Col 2: TABLESPACE Key

DATABASE IN <userid>.EXPORT.<application
PROGRAM name>.DBINPGMF

Col 1: DATABASE Key
Col 2: PROGRAM Key

DATABASE IN <userid>.EXPORT.<application
STOGROUP name>.DBINSGRP

Col 1: DATABASE Key
Col 2: STOGROUP Key

DATAITEM DEFINED-IN <userid>.EXPORT.<application
INCLUDE name>DTDEFINC

Col 1: DATAITEM Key
Col 2: INCLUDE Key

DATAITEM DEFINED-IN <userid>EXPORT.<application
PROGRAM name>DTDEFPGM

Col 1: DATAITEM Key
Col 2: PROGRAM Key

DATAITEM IN RECORD <userid>EXPORT.<application
name>DATINREC

Col 1: DATAITEM Key
Col 2: RECORD Key

DATAITEM <userid>.EXPORT.<application
REFERENCED-BY FIELD name>DIRMAPF

Col 1: DATAITEM Key
Col 2: MAPSET Key
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DATAITEM <userid>.EXPORT.<application
REFERENCED-BY name>.DIRBMAPF
MAPFIELD

Col 1: DATAITEM Key
Col 2: MAPFIELD Key

DATAITEM <userid>.EXPORT.<application
REFERENCES name>.DIRMAPF
MAPFIELD

Col 1: DATAITEM Key
Col 2: MAPFIELD Key

DBD HAS DD <userid>.EXPORT.<application
name>.DBDHSDDF

Col 1: DBD Key
Col 2: DD Key

DBD HAS SEGMENT <userid>.EXPORT.<application
name>.DBDHSEGF

Col 1: DBD Key
Col 2: SEGMENT Key

DBD IN MEMBER <userid>.EXPORT.<application
name>DBDINMBR

Col 1: DBD Key
Col 2: MEMBER Key

DBD IN PCB <userid>.EXPORT.<application
name>.DBDINPCB

Col 1: DBD Key
Col 2: PCB Key

DD HAS DSN <userid>.EXPORT.<application
name>DDHDSNF

Col 1: DD Key
Col 2: DSN Key

DD IN CSD <userid>.EXPORT.<application
name>.DDINCSDF

Col 1: DD Key
Col 2: CSD Key
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Relationship Type Filename

DD IN DBD <userid>.EXPORT.<application
name>DDINDBDF
Col 1: DD Key

Col 2: DBD Key

DD IN FCT <userid>.EXPORT.<application
name>DDINFCTF

Col 1: DD Key
Col 2: FCT Key

DD IN CICS <userid>.EXPORT.<application
name>.DDINCICS

Col 1: DD Key
Col 2: CICS Key

DD IN STEP <userid>.EXPORT.<application
name>.DDINSTEP

Col 1: DD Key
Col 2: STEP Key

DD SELECTED-BY FD <userid>EXPORT.<application
name>DDSELBFDF

Col 1: DD Key
Col 2: FD Key

DSN HAS MEMBER <userid>.EXPORT.<application
name>DSNHMBRF

Col 1: DSN Key
Col 2: MEMBER Key

DSN IN DD <userid>.EXPORT.<application
name>DSNINDDF
Col 1: DSN Key
Col 2: DD Key
ENTRY CALLED-BY <userid>.EXPORT.<application
PROGRAM name>ENTCBPGM

Col 1: ENTRY Key
Col 2: PROGRAM Key
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Relationship Type Filename

ENTRY IN PROGRAM <userid>.EXPORT.<application
name>ENTINPGM

Col 1: ENTRY Key
Col 2: PROGRAM Key

ENTRY IS CALLS <userid>.EXPORT.<application
name>ENTISCAL

Col 1: ENTRY Key
Col 2: CALL Key

FCT HAS DD <userid>.EXPORT.<application
name>.FCTHDDF

Col 1: FCT Key
Col 2: DD Key

FCT IN MEMBER <userid>.EXPORT.<application
name>.FCTINMBR

Col 1: FCT Key
Col 2: MEMBER Key

FCTCSD HAS DD <userid>EXPORT.<application
name>.CICSHDDF

Col 1: FCTCSD Key
Col 2: DD Key

FD IN PROGRAM <userid>.EXPORT.<application
name>FDINPGMF

Col 1: FD Key
Col 2: PROGRAM Key

FD SELECTS DD <userid>.EXPORT.<application
name>FDSELDDF

Col 1: FD Key
Col 2: DD Key

FD USES RECORD <userid>.EXPORT.<application
name>FDUSRECF

Col 1: FD Key
Col 2: RECORD Key

239



ASG-Alliance User’s Guide

240

Relationship Type

Filename

FORMAT <userid>.EXPORT.<application
EXECUTED-BY name>FMTEBFMT
FORMAT Col 1: FORMAT Key

Col 2: FORMAT Key
FORMAT <userid>.EXPORT.<application
EXECUTED-BY name>FMTEBPGM
FROGRAM Col 1: FORMAT Key

Col 2: PROGRAM Key
FORMAT EXECUTES <userid>.EXPORT.<application
FORMAT name>FMTEXFMT

Col 1: FORMAT Key

Col 2: FORMAT Key
FORMAT EXECUTES <userid>.EXPORT.<application

IMS-TRANSACTION

name>FMEXITRN
Col 1: FORMAT Key
Col 2: IMS-TRANSACTION Key

FORMAT IN MEMBER

<userid>EXPORT.<application
name>FMINMBRF

Col 1: FORMAT Key
Col 2: MEMBER Key

IDMS IN PROGRAM

<userid>.EXPORT.<application
name>IDMSIPGM

Col 1: IDMS Key
Col 2: PROGRAM Key

IDMSMAP HAS
IDMSRECORD

<userid>.EXPORT.<application
name>MAPHRECF

Col 1: IDMSMAP Key
Col 2: IDMSRECORD Key

IDMSMAP IN PROGRAM <userid>.EXPORT.<application

name>MAPINPGM
Col 1: IDMSMAP Key
Col 2: PROGRAM Key
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Relationship Type Filename

IDMSRECORD IN AREA <userid>EXPORT.<application
name>RECINAF

Col 1: IDMSRECORD Key
Col 2: AREA Key

IDMSRECORD IN <userid>.EXPORT.<application
IDMSMAP name>RECINMAP

Col 1: IDMSRECORD Key
Col 2: IDMSMAP Key

IDMSRECORD IN <userid>.EXPORT.<application
LOGICALRECORD name>.RECILREC

Col 1: IDMSRECORD Key
Col 2: LOGICALRECORD Key

IMSDYNALLOCMACRO <userid>EXPORT.<application
IN MEMBER name>MDAINMBR

Col 1: IMSDYNALLOCMACRO Key
Col 2: MEMBER Key

IMS-TRANSACTION <userid>.EXPORT.<application
EXECUTED-BY name>ITRNEBFM
FORMAT

Col 1: IMS-TRANSACTION Key
Col 2: FORMAT Key

IMS-TRANSACTION <userid>.EXPORT.<application
EXECUTED-BY name>ITRNEBPG
PROGRAM

Col 1: IMS-TRANSACTION Key
Col 2: PROGRAM Key

IMS-TRANSACTION <userid>.EXPORT.<application
EXECUTES name>ITRNEXLM
LOADMODULE

Col 1: IMS-TRANSACTION Key
Col 2: LOADMODULE Key

JOB HAS STEP <userid>.EXPORT.<application
name>.JOBHSTPF

Col 1: JOB Key
Col 2: STEP Key
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Relationship Type Filename
JOB IN MEMBER <userid>.EXPORT.<application
name>JOBINMBR

Col 1: JOB Key
Col 2: MEMBER Key

JOB USES CATALOG <userid>.EXPORT.<application
name>JOBUSCAT

Col 1: JOB Key
Col 2: CATALOG Key

JOB USES LIBRARY <userid>EXPORT.<application
name>JOBUSLIB

Col 1: JOB Key
Col 2: LIBRARY Key

LIBRARY HAS MEMBER <userid>EXPORT.<application
name>LIBHMBRF

Col 1: LIBRARY Key
Col 2: MEMBER Key

LIBRARY USEDBY JOB <userid>.EXPORT.<application
name>LIBUBJOB

Col 1: LIBRARY Key
Col 2: JOB Key

LIBRARY USEDBY STEP <userid>.EXPORT.<application
name>LIBUBSTF

Col 1: LIBRARY Key
Col 2: STEP Key

LOADMODULE <userid>.EXPORT.<application
EXECUTED-BY STEP name>LMEXSTPF

Col 1: LOADMODULE Key
Col 2: STEP Key

LOADMODULE <userid>.EXPORT.<application
EXECUTED-BY name>LMEBITRN

IMS-TRANSACTION Col 1: LOADMODULE Key
Col 2: IMS-TRANSACTION Key
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LOADMODULE HAS <userid>.EXPORT.<application
CSECT name>LMHCSECT

Col 1: LOADMODULE Key
Col 2: CSECT Key

LOADMODULE IN <userid>.EXPORT.<application
MEMBER name>LMINMBRF

Col 1: LOADMODULE Key
Col 2: MEMBER Key

LOGICALRECORD HAS <userid>.EXPORT.<application
IDMSRECORD name>.LRHRECF

Col 1: LOGICALRECORD Key
Col 2: IDMSRECORD Key

LOGICAL RECORD IN <userid>.EXPORT.<application
PROGRAM name>.LRINPGMF

Col 1: LREC Key
Col 2: PROGRAM Key

MAP IN MAPSET <userid>.EXPORT.<application
name>MAPINMST

Col 1: MAP Key
Col 2: MAPSET Key

MAP REFERENCES <userid>.EXPORT.<application
RECORD name>MRCRFREC

Col 1: MAP Key
Col 2: RECORD Key

MAP USEDBY <userid>.EXPORT.<application
PROGRAM name>MPAUBPGM

Col 1: MAP Key
Col 2: PROGRAM Key

MAPFIELD IN MAP <userid>.EXPORT.<application
name>.MFDINMAP

Col 1: MAPFIELD Key
Col 2: MAP Key
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Relationship Type Filename

MAPFIELD <userid>.EXPORT.<application
REFERENCED BY name>MAPFRFDI

DATAITEM

Col 1: MAPSET Key
Col 2: DATAITEM Key

MAPSET HAS MAP <userid>.EXPORT.<application
name>MSETHMAP

Col 1: MAPSET Key
Col 2: MAP Key

MAPSET IN MEMBER <userid>.EXPORT.<application
name>MSTINMBR

Col 1: MAPSET Key
Col 2: MEMBER Key

MAPSET USEDBY <userid>.EXPORT.<application
PROGRAM name>MSETUPGM

Col 1: MAPSET Key
Col 2: PROGRAM Key

MDA HAS DD <userid>.EXPORT.<application
name>.MDAHSDDF
Col 1: MDA Key
Col 2: DD Key
MEMBER HAS <userid>.EXPORT.<application
COPYMEMBER name>MBRISCIN

Col 1: MEMBER Key
Col 2: COPYMEMBER Key

MEMBER HAS DBD <userid>.EXPORT.<application
name>MBRHDBDF

Col 1: MEMBER Key
Col 2: DBD Key

MEMBER HAS FCT <userid>.EXPORT.<application
name>MBRHFCTF

Col 1: MEMBER Key
Col 2: FCT Key
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Relationship Type Filename

MEMBER HAS FORMAT <userid>EXPORT.<application
name>MBRHFMF

Col 1: MEMBER Key
Col 2: FORMAT Key

MEMBER HAS <userid>.EXPORT.<application
IMSDYNALLOCMACRO name>MBRHMDA

Col 1: MEMBER Key
Col 2: IMSDYNALLOCMACRO Key

MEMBER HAS JOB <userid>.EXPORT.<application
name>.MBRHJOBF

Col 1: MEMBER Key
Col 2: JOB Key

MEMBER HAS <userid>.EXPORT.<application
LOADMODULE name>MBRHLMF

Col 1: MEMBER Key
Col 2: LOADMODULE Key

MEMBER HAS MAPSET <userid>.EXPORT.<application
name>MBRHMSET

Col 1: MEMBER Key
Col 2: MAPSET Key

MEMBER HAS PCT <userid>.EXPORT.<application
name>MBRHPCTF

Col 1: MEMBER Key
Col 2: PCT Key

MEMBER HAS PPT <userid>.EXPORT.<application
name>MBRHPPTF

Col 1: MEMBER Key
Col 2: PPT Key

MEMBER HAS PROC <userid>.EXPORT.<application
name>.MBRHPROC

Col 1: MEMBER Key
Col 2: PROC Key
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MEMBER HAS <userid>.EXPORT.<application
PROGRAM name>MBRHPGMF

Col 1: MEMBER Key
Col 2: PROGRAM Key

MEMBER HAS PSB <userid>.EXPORT.<application
name>MBRHPSBF

Col 1: MEMBER Key
Col 2: PSB Key

MEMBER IN DSN <userid>.EXPORT.<application
name>MBRINDSN

Col 1: MEMBER Key
Col 2: DSN Key

MEMBER IN LIBRARY  <userid>EXPORT.<application
name>MBRINLIB

Col 1: MEMBER Key
Col 2: LIBRARY Key

MEMBER USES <userid>.EXPORT.<application
COPYMEMBER name>.SRCINCMB

Col 1: MEMBER Key
Col 2: COPYMEMBER Key

PCB HAS SENSEG <userid>.EXPORT.<application
name>PCBHSSGF

Col 1: PCB Key
Col 2: SENSEG Key

PCB IN PSB <userid>.EXPORT.<application
name>PCBINPSB

Col 1: PCB Key
Col 2: PSB Key

PCB REFERENCES DBD <userid>.EXPORT.<application
name>PCBHDBDF

Col 1: PCB Key
Col 2: DBD Key
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PCT HAS
CICS-TRANSACTION

<userid>.EXPORT.<application
name>PCTHCTRF

Col 1: PCT Key
Col 2: CICS-TRANSACTION Key

PCT IN MEMBER <userid>.EXPORT.<application
name>PCTINMBR
Col 1: PCT Key
Col 2: MEMBER Key

PPT IN MEMBER <userid>.EXPORT.<application

name>.PPTINMBR
Col 1: PPT Key
Col 2: MEMBER Key

PROC HAS STEP

<userid>EXPORT.<application
name>PRCHSTPF

Col 1: PROC Key
Col 2: STEP Key

PROC EXECUTED-BY
STEP

<userid>EXPORT.<application
name>PROCEBST

Col 1: PROC Key
Col 2: STEP Key

PROC IN MEMBER

<userid>.EXPORT.<application
name>PRCINMBR

Col 1: PROC Key
Col 2: MEMBER Key

PROGRAM CALLS
ENTRY

<userid>.EXPORT.<application
name>PGMCENTF

Col 1: PROGRAM Key
Col 2: ENTRY Key

PROGRAM
EXECUTED-BY
CICS-TRANSACTION

<userid>EXPORT.<application
name>PGMEBCTR

Col 1: PROGRAM Key
Col 2: CICS-TRANSACTION Key
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PROGRAM EXECUTES <userid>.EXPORT.<application
CICS-TRANSACTION name>PGMEXTRN

Col 1: PROGRAM Key
Col 2: CICS-TRANSACTION Key

PROGRAM EXECUTES <userid>.EXPORT.<application
FORMAT name>PGMEXFMT

Col 1: PROGRAM Key
Col 2: FORMAT Key

PROGRAM EXECUTES <userid>.EXPORT.<application
IMS-TRANSACTION name>PGMEXITR

Col 1: PROGRAM Key
Col 2: IMS-TRANSACTION Key

PROGRAM HAS AREA <userid>.EXPORT.<application
name>PGMHAREA

Col 1: PROGRAM Key
Col 2: AREA Key

PROGRAM HAS <userid>.EXPORT.<application
COLUMN name>PGHHCOLF

Col 1: PROGRAM Key
Col 2: COLUMN Key

PROGRAM HAS <userid>.EXPORT.<application
CURSOR name>PGMHCSRF

Col 1: PROGRAM Key
Col 2: CURSOR Key

PROGRAM HAS <userid>.EXPORT.<application
DATABASE name>PGMHDBF

Col 1: PROGRAM Key
Col 2: DATABASE Key

PROGRAM HAS <userid>.EXPORT.<application
DATAITEM name>.PGMHDDEF

Col 1: PROGRAM Key
Col 2: DATAITEM Key
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PROGRAM HAS ENTRY <userid>EXPORT.<application

name>PGMHENTF
Col 1: PROGRAM Key
Col 2: ENTRY Key

PROGRAM HAS FD <userid>.EXPORT.<application

name>PGMHFDF

Col 1: PROGRAM Key

Col 2: FD Key
PROGRAM HAS IDMS <userid>.EXPORT.<application

name>PGMHIDMS

Col 1: PROGRAM Key

Col 2: IDMS Key
PROGRAM HAS <userid>.EXPORT.<application
IDMSMAP name>PGMHMAP

Col 1: PROGRAM Key

Col 2: IDMSMAP Key
PROGRAM HAS <userid>.EXPORT.<application
IDMSRECORD name>.PGMHRECS

Col 1: PROGRAM Key

Col 2: IDMSRECORD Key
PROGRAM HAS <userid>.EXPORT.<application
LOGICALRECORD name>PGMHLREC

Col 1: PROGRAM Key

Col 2: LOGICALRECORD Key
PROGRAM HAS <userid>.EXPORT.<application
RECORD name>PGMRHREC

Col 1: PROGRAM Key

Col 2: RECORD Key
PROGRAM HAS <userid>.EXPORT.<application
SCHEMA name>PGMHSCHF

Col 1: PROGRAM Key
Col 2: SCHEMA Key
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PROGRAM HAS SQL <userid>.EXPORT.<application
name>PGMHSQLF

Col 1: PROGRAM Key
Col 2: SQL Entity Key

PROGRAM HAS <userid>.EXPORT.<application
STOGROUP name>PGMHSTGF

Col 1: PROGRAM Key
Col 2: STOGROUP Key

PROGRAM HAS <userid>.EXPORT.<application
SUBSCHEMA name>.PGMHSSCH

Col 1: PROGRAM Key
Col 2: SUBSCHEMA Key

PROGRAM HAS TABLE <userid>.EXPORT.<application
name>PGMHTBLF

Col 1: PROGRAM Key
Col 2: TABLE Key

PROGRAM HAS <userid>.EXPORT.<application
TABLESPACE name>PGMHTBLS

Col 1: PROGRAM Key
Col 2: TABLESPACE Key

PROGRAM HAS VIEW <userid>.EXPORT.<application
name>PGMHVIEW

Col 1: PROGRAM Key
Col 2: VIEW Key

PROGRAM IN MEMBER <userid>EXPORT.<application
name>PGMINMBR

Col 1: PROGRAM Key
Col 2: MEMBER Key

PROGRAM INCLUDES <userid>.EXPORT.<application
COPYMEMBER name>.PGMILMBR

Col 1: PROGRAM Key
Col 2: COPYMEMBER Key
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PROGRAM IS CSECT <userid>.EXPORT.<application
name>.PGMISCSC

Col 1: PROGRAM Key
Col 2: CSECT Key

PROGRAM LINKEDBY <userid>.EXPORT.<application
PROGRAM name>PGMLBPGM

Col 1: PROGRAM Key
Col 2: PROGRAM Key

PROGRAM LINKS <userid>.EXPORT.<application
PROGRAM name>PGMLKPGM

Col 1: PROGRAM Key
Col 2: LINKED PROGRAM Key

PROGRAM USES DD <userid>.EXPORT.<application
name>.PGMUSCDD

Col 1: PROGRAM Key
Col 2: DD Key

PROGRAM USES MAP <userid>.EXPORT.<application
name>.PGMUSMAP

Col 1: PROGRAM Key
Col 2: MAP Key

PROGRAM USES <userid>.EXPORT.<application
MAPSET name>PGMUSMST

Col 1: PROGRAM Key
Col 2: MAPSET Key

PROGRAM USES PSB <userid>.EXPORT.<application
name>PGMUSPSB

Col 1: PROGRAM Key
Col 2: PSB Key

PROGRAM USES <userid>.EXPORT.<application
SEGMENT name>PGMUSEGF

Col 1: PROGRAM Key
Col 2: SEGMENT Key
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PROGRAM USES <userid>.EXPORT.<application
SPECIALREGISTER name>PGMUSREG

Col 1: PROGRAM Key
Col 2: SPECIALREGISTER Key

PSB HAS PCB <userid>.EXPORT.<application
name>.PSBHPCBF

Col 1: PSB Key
Col 2: PCB Key

PSB IN MEMBER <userid>.EXPORT.<application
name>.PSBINMBR

Col 1: PSB Key
Col 2: MEMBER Key

PSB USEDBY PROGRAM <userid>.EXPORT.<application
name>PSBUBPGM

Col 1: PSB Key
Col 2: PROGRAM Key

RECORD HAS <userid>.EXPORT.<application
DATAITEM name>RECHDATA

Col 1: RECORD Key
Col 2: DATAITEM Key

RECORD IN PROGRAM <userid>.EXPORT.<application
name>RECINPGM

Col 1: RECORD Key
Col 2: PROGRAM Key

RECORD REFERENCED <userid>.EXPORT.<application
BY MAP name>RECRBMRC

Col 1: RECORD Key
Col 2: MAP Key

RECORD USEDBY FD <userid>.EXPORT.<application
name>RECUBFDF

Col 1: RECORD Key
Col 2: FD Key
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SCHEMA HAS <userid>.EXPORT.<application
SUBSCHEMA name>.SCMHSSCM

Col 1: SCHEMA Key
Col 2: SUBSCHEMA Key

SCHEMA IN PROGRAM <userid>EXPORT.<application
name>.SCHINPGM

Col 1: SCHEMA Key
Col 2: PROGRAM Key

SEGFIELD IN SEGMENT <userid>EXPORT.<application
name>FLDINSEG

Col 1: SEGFIELD Key
Col 2: SEGMENT Key

SEGMENT HAS <userid>.EXPORT.<application
SEGFIELD name>.SEGHFLDF

Col 1: SEGMENT Key
Col 2: SEGFIELD Key

SEGMENT IN DBD <userid>EXPORT.<application
name>.SEGINDBD

Col 1: SEGMENT Key
Col 2: DBD Key

SEGMENT IN SEGMENT <userid>EXPORT.<application
name>.SEGINSEG

Col 1: SEGMENT Key
Col 2: SEGMENT Key

SEGMENT USEDBY <userid>.EXPORT.<application
PROGRAM name>.SEGUBPGM

Col 1: SEGMENT Key
Col 2: PROGRAM Key

SEGMENT USES <userid>.EXPORT.<application
SEGMENT name>.SEGHSEGF

Col 1: SEGMENT Key
Col 2: SEGMENT Key
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SENFIELD IN SENSEG <userid>.EXPORT.<application
name>.SENFISEN

Col 1: SENFIELD Key
Col 2: SENSEG Key

SENSEG HAS SENFIELD <userid>EXPORT.<application
name>.SSGHSFDF

Col 1: SENSEG Key
Col 2: SENFIELD Key

SENSEG IN PCB <userid>EXPORT.<application
name>.SSEGIPCB

Col 1: SENSEG Key
Col 2: PCB Key

SENSEG IN SENSEG <userid>EXPORT.<application
name>.SENINSEN

Col 1: SENSEG Key
Col 2: SENSEG Key

SENSEG USES SENSEG  <userid>EXPORT.<application
name>.SSGHSSGF

Col 1: SENSEG Key
Col 2: SENSEG Key

SQL IN PROGRAM <userid>.EXPORT.<application
name>.SQLINPGM

Col 1: SQL Entity Key
Col 2: PROGRAM Key

STEP EXECUTES <userid>.EXPORT.<application
LOADMODULE name>.STEPELMF

Col 1: STEP Key
Col 2: LOADMODULE Key

STEP EXECUTES PROC <userid>EXPORT.<application
name>.STPEXPRC

Col 1: STEP Key
Col 2: PROC Key
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STEP HAS DD <userid>.EXPORT.<application
name>.STPHDDF
Col 1: STEP Key
Col 2: DD Key

STEP IN JOB <userid>.EXPORT.<application
name>.STEPIJOB

Col 1: STEP Key
Col 2: JOB Key

STEP IN PROC <userid>.EXPORT.<application
name>.STINPROC

Col 1: STEP Key
Col 2: PROC Key

STEP USES CATALOG <userid>.EXPORT.<application
name>.STPUSCAT

Col 1: STEP Key
Col 2: CATALOG Key

STEP USES LIBRARY <userid>EXPORT.<application
name>.STPUSLIB

Col 1: STEP Key
Col 2: LIBRARY Key

STOGROUP HAS <userid>.EXPORT.<application
DATABASE name>.STGHDBF

Col 1: STOGROUP Key
Col 2: DATABASE Key

STOGROUP IN <userid>.EXPORT.<application
PROGRAM name>.STGINPGM

Col 1: STOGROUP Key
Col 2: PROGRAM Key

SUBSCHEMA HAS AREA <userid>.EXPORT.<application
name>.SSCMHARA

Col 1: SUBSCHEMA Key
Col 2: AREA Key
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SUBSCHEMA HAS <userid>.EXPORT.<application
LOGICALRECORD name>.SSCMHLRF

Col 1: SUBSCHEMA Key
Col 2: LOGICALRECORD Key

SUBSCHEMA IN <userid>.EXPORT.<application
PROGRAM name>.SSCMINPG

Col 1: SUBSCHEMA Key
Col 2: PROGRAM Key

SUBSCHEMA IN <userid>EXPORT.<application
SCHEMA name>.SUBSISCM

Col 1: SUBSCHEMA Key
Col 2: SCHEMA Key

TABLE HAS COLUMN <userid>.EXPORT.<application
name>TBHCOLF

Col 1: TABLE Key
Col 2: COLUMN Key

TABLE IN PROGRAM <userid>.EXPORT.<application
name>.TBLINPGM

Col 1: TABLE Key
Col 2: PROGRAM Key

TABLE IN TABLESPACE <userid>EXPORT.<application
name>TABINTSF

Col 1: TABLE Key
Col 2: TABLESPACE Key

TABLESPACE HAS <userid>.EXPORT.<application
TABLE name>TBLSPHTB

Col 1: TABLESPACE Key
Col 2: TABLE Key

TABLESPACE HAS <userid>.EXPORT.<application
VIEW name>TBLSPHVW

Col 1: TABLESPACE Key
Col 2: VIEW Key
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Relationship Type Filename
TABLESPACE IN <userid>.EXPORT.<application
DATABASE name>.TSINDBF

Col 1: TABLESPACE Key
Col 2: DATABASE Key

TABLESPACE IN <userid>.EXPORT.<application
PROGRAM name>TBSINPGM

Col 1: TABLESPACE Key
Col 2: PROGRAM Key

VIEW HAS COLUMN <userid>.EXPORT.<application
name>.VWHCOLF

Col 1: VIEW Key
Col 2: COLUMN Key

VIEW IN PROGRAM <userid>.EXPORT.<application
name>.VWINPGMF

Col 1: VIEW Key
Col 2: PROGRAM Key

VIEW IN TABLESPACE <userid>EXPORT.<application
name>.VIEWINTS

Col 1: VIEW Key
Col 2: TABLESPACE Key
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Defining and Loading DB2 Databases

The Export facility provides for loading output sequential files, created from the unload
job, to a DB2 database.

To define and load a DB2 database
1 Use the JCL VIABXDFI to define the database.

2 To load the sequential files from the unload step (in the AKR export job), use the
JCL VIABXLDI.

DB2 Database Description
Entity Tables

Table Name Contents
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ASG.AREA Col 1: Area Key Char(8)
Col 2: Area Name Char(8)
Primary Area_Key
Key:

ASG.CATALOG Col 1: Catalog_Key Char(8)
Col 2: Catalog Name Char(44)
Primary Catalog_Key
Key:

ASG.CICSTXN Col 1: CICSTXN Key Char(8)

(CICS Trans)
Col 2: CICSTXN_ Name Char(8)
Primary CICSTXN Key
Key:

ASG.COLUMN Col 1: Column_Key Char(8)
Col 2: Column_Name Char(30)
Primary Column_Key
Key:
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ASG.COPYMEMBER Col 1: Copymember Key Char(8)
Col 2: Copymember Name Char(10)
Primary Copymember Key
Key:

ASG.CSD Col 1: CSD_Key Char(8)
Col 2: CSD Name Char(44)
Primary CSD_Key
Key:

ASG.CSECT Col 1: CSECT Key Char(8)
Col 2: CSECT_Name Char(8)
Primary CSECT Key
Key:

ASG.CURSOR Col 1: Cursor Key Char(8)
Col 2: Cursor Name Char(30)
Primary Cursor_Key
Key:

ASG.DATABASE Col 1: Database Key Char(8)
Col 2: Database Name Char(44)
Primary Database Key
Key:

ASG.DATAITEM Col 1: Data Key Char(8)

Not Null
Col 2: Data Name Char(50)
Not Null

Col 3: Data_Level Char(2)
Col 4: Data_Parent Char(8)
Col 5: Data_Child Char(8)
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Col 6: Data Next Sibling Char(8)
Col 7: Data Prev_Sibling Char(8)
Col 8: Data_Picture Char(20)
Col 9: Data Usage Char(10)
Col 10: Data Occurs Char(8)
Col 11: Data_Redefine Char(8)
Col 12: Data Rename From Char(8)
Col 13: Data Rename Thru Char(8)
Col 14: Data_ Size Char(8)
Col 15: Data Offset Char(8)
Col 16: Data Position Char(8)
Col 17: Data Value Char(40)
Col 18: Data Use Char(8)
Col 19: Data Mod Char(8)
Col 20: Data Ref Char(8)
Col 21: Data Cond Char(8)
Col 22: Data_Arith Char(8)
Col 23: Data Create Char(1)
Col 24: Data Read Char(1)
Col 25: Data Update Char(1)
Col 26: Data_Delete Char(1)
Primary Data_Key

Key:
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ASG.DBD Col 1: DBD_Key Char(8)
Col 2: DBD_Name Char(8)
Primary DBD_ Key
Key:

ASG.DD Col 1: DD Key Char(8)
Col 2: DD Name Char(8)
Primary DD Key
Key:

ASG.DSN Col 1: DSN_Key Char(8)
Col 2: DSN_Name Char(44)
Primary DSN Key
Key:

ASG.ENTRY Col 1: Entry Key Char(8)
Col 2: Entry Name Char(10)
Primary Entry key
Key:

ASG.FCT Col 1: FCT Key Char(8)
Col 2: FCT Name Char(8)
Primary FCT Key
Key:

ASG.FCTCSD Col 1: FCTCSD Key Char(8)
Col 2: FCTCSD Name Char(44)
Primary FCTCSD Key
Key:
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ASG.FD Col 1: FD_Key Char(8)
Col 2: FD_Name Char(30)
Primary FD_Key
Key:

ASG.FORMAT Col 1: Format Key Char(8)
Col 2: Format Name Char(8)
Primary Format Key
Key:

ASG.IDMS Col 1: IDMS_ Key Char(8)
Col 2: IDMS Name Char(36)
Primary IDMS Key
Key:

ASG.IDMSMAP Col 1: IDMSMAP_ Key Char(8)
Col 2: IDMSMAP_Name Char(8)
Primary IDMSMAP_ Key Char(8)
Key:

ASG.IDMSRECORD Col 1: IDMSRECORD Key Char(30)
Col 2: IDMSRECORD_ Name
Primary IDMSRECORD Key
Key:

ASG.IMSDYNALLOCMAC Col I: IMSALCMAC Key Char(8)

RO
Col 2: IMSALCMAC Name Char(8)

Primary IMSALCMAC Key
Key:

262



Appendix E - Export Language Reference

ASG.IMSTXN (IMS Col 1: IMSTXN_Key Char(8)

Transaction)
Col 2: IMSTXN_ Name Char(8)
Primary IMSTXN Key
Key:

ASG.JOB Col 1: Job Key Char(8)
Col 2: Job_Name Char(8)
Primary Job_Key
Key:

ASG.LIBRARY Col 1: Library Key Char(8)
Col 2: Library Name Char(44)
Primary Library Key
Key:

ASG.LOADMODULE Col 1: LoadModule Key Char(8)
Col 2: LoadModule Name Char(8)
Primary LoadModule Key
Key:

ASG.LOGICAL Col 1: LOGICALRECORD Key  Char(8)

RECORD
Col 2: LOGICALRECORD Name Char(30)
Primary LOGICALRECORD Key
Key:

ASG.MAP Col 1: Map Key Char(8)
Col 2: Map Name Char(8)
Primary Map Key
Key:
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ASG.MAPFIELD Col 1: Mapfield Key Char(8)
Col 2: Mapfield Name Char(30)
Primary Mapfield Key
Key:

ASG.MAPSET Col 1: Mapset Key Char(8)
Col 2: Mapset Name Char(8)
Primary Mapset_Key
Key:

ASG.MEMBER Col 1: Member Key Char(8)
Col 2: Member Name Char(10)
Primary Member Key
Key:

ASG.PCB Col 1: PCB Key Char(8)
Col 2: PCB_ Name Char(8)
Primary PCB_Key
Key:

ASG.PCT Col 1: PCT Key Char(8)
Col 2: PCT Name Char(8)
Primary PCT Key
Key:

ASG.PPT Col 1: PPT Key Char(8)
Col 2: PPT Name Char(8)

Primary PPT Key
Key:
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ASG.PROC Col 1: Proc_Key Char(8)
Col 2: Proc_Name Char(8)
Primary Proc_Key
Key:

ASG.PROGRAM Col 1: Program_Key Char (8)
Col 2: Program Name Char(8)
Primary Program_Key
Key:

ASG.PSB Col 1: PSB Key Char(8)
Col 2: PSB_Name Char(8)
Primary PSB Key
Key:

ASG.RECORD Col 1: Rec Key Char(8)
Col 2: Rec Name Char(30)
Primary Rec Key
Key:

ASG.SCHEMA Col 1: Schema_ Key Char(8)
Col 2: Schema Name Char(8)
Primary Schema Key
Key:

ASG.SEGFIELD Col 1: SEGFIELD Key Char(8)
Col 2: SEGFIELD Name Char(30)
Primary SEGFIELD Key
Key:
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ASG.SEGMENT Col 1: Segment Key Char(8)
Col 2: Segment Name Char(30)
Primary Segment Key
Key:

ASG.SENFIELD Col 1: SENFIELD Key Char(8)
Col 2: SENFIELD Name Char(30)
Primary SENFIELD Key
Key:

ASG.SENSEG Col 1: SENSEG_Key Char(8)
Col 2: SENSEG_Name Char(30)
Primary SENSEG Key
Key:

ASG.SQL Col 1: SQL Key Char(8)
Col 2: SQL Name Char(30)
Primary SQL Key
Key:

ASG.STEP Col 1: Step_Key Char(8)
Col 2: Step Name Char(8)
Primary Step Key
Key:

ASG.STOGROUP Col 1: STOGROUP_Key Char(8)

(Storage Group)
Col 2: STOGROUP Name Char(8)

Primary STOGROUP Key
Key:
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ASG.SUBSCHEMA Col 1: Subschema_Key Char(8)
Col 2: Subschema Name Char(8)
Primary Subschema Key
Key:

ASG.TABLE Col 1: Table Key Char(8)
Col 2: Table Name Char(30)
Primary Table Key
Key:

ASG.TABLESPACE Col 1: TableSpace Key Char(8)
Col 2: TableSpace Name Char(8)
Primary TableSpace Key
Key:

ASG.VIEW Col 1: View Key Char(8)
Col 2: View Name Char(30)
Primary View_Key
Key:
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ASG.AREA HAS Col 1: AREA Key Char(8)
RECORDS
Col 2: RECORDS Key Char(8)
Primary Key: (AREA Key, RECORDS Key)
Foreign Key: AREAKEY (AREA Key)
References: ASG.AREA
Foreign Key: RECRDKEY (RECORDS Key)
References: ASG.RECORD
ASG.AREAS IN PGM Col I: AREA Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (AREA Key, PGM_Key)
Foreign Key: AREAKEY (AREA Key)
References: ASG.AREA
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.AREAS IN Col 1: AREAS Key Char(8)
SUBSCHEMA
Col 2: SUBSCHEMA Key Char(8)
Primary Key: (AREAS Key,
SUBSCHEMA Key)
Foreign Key: AREASKEY (AREAS Key)
References: ASG.AREA
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Foreign Key: SUBSCKEY
(SUBSCHEMA_Key)
References: ASG.SUBSCHEMA
ASG.CATALOG _ Col 1: CATALOG Key Char(8)
USDBY_JOB
Col 2: JOB Key Char(8)
Primary Key: (CATALOG Key, JOB Key)
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
Foreign Key: JOBKEY (JOB_Key)
References: ASG.JOB
ASG.CATALOG _ Col 1: CATALOG Key Char(8)
USDBY_STP
Col 2: STEP Key Char(8)
Primary Key: (CATALOG Key, STEP_ Key)
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.CICS_ HAS DD Col 1: CICS Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (CICS Key, DD Key)
Foreign Key: CICSKEY (CICS Key)
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References: ASG.FCTCSD

Foreign Key: DDKEY (DD Key)

References: ASG.DD
ASG.CICSDD _ Col 1: CICSDD Key Char(8)
USDBY_PGM

Col 2: PGM_Key Char(8)

Primary Key: (CICSDD_ Key, PGM_Key)

Foreign Key: CIDDKEY (CICSDD_Key)

References: ASG.DD

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.CICSTRANS Col 1: CICSTRANS Key Char(8)
EXEC_PGM

Col 2: PGM_Key Char(8)

Primary Key: (CICSTRANS Key, PGM_Key)

Foreign Key: CITXNKEY (CICSTRANS Key)

References: ASG.CICSTXN

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.CICSTRANS IN_ Col 1: CICSTRANS Key Char(8)
CSD

Col 2: CSD Key Char(8)

Primary Key: (CICSTRANS Key, CSD Key)

Foreign Key: CTXNKEY (CICSTRANS Key)

References: ASG.CICSTXN
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Foreign Key:

References:

PSDKEY (CSD Key)

ASG.CSD

ASG.CICSTRANS_IN_
PCT

Col 1:

Col 2:

Primary Key:

Foreign Key:

References:

Foreign Key:

References:

CICSTRANS Key Char(8)

PCT Key Char(8)
(CICSTRANS_ Key, PCT Key)
CTXNKEY (CICSTRANS_Key)
ASG.CICSTXN

PCTKEY (PCT Key)

ASG.PCT

ASG.COLUMNS _
IN PGM

Col 1:

Col 2:

Primary Key:

Foreign Key:

References:

Foreign Key:

References:

COLUMN Key Char(8)

PGM_Key Char(8)
(COLUMN Key, PGM._Key)

COLKEY (COLUMN_Key)
ASG.COLUMN

PGMKEY (PGM._Key)

ASG.PROGRAM

ASG.COLUMNS _
IN TABLE

Col 1:

Col 2:

Primary Key:

Foreign Key:

COLUMNS Key Char(8)

TABLE Key Char(8)
(COLUMNS Key, TABLE Key)

COLUMKEY (COLUMNS Key)
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References: ASG.COLUMN
Foreign Key: TABLEKEY (TABLE_ Key)
References: ASG.TABLE
ASG.COLUMNS Col 1: COLUMNS Key Char(8)
IN_VIEW
Col 2: VIEW_ Key Char(8)
Primary Key: (COLUMNS Key, VIEW Key)
Foreign Key: COLUMKEY (COLUMNS Key)
References: ASG.COLUMN
Foreign Key: VIEWKEY (VIEW_ Key)
References: ASG.VIEW
ASG.COPY _ Col 1: COPY_Key Char(8)
INCLIN. MEMBER
Col 2: MEMBER Key Char(8)
Primary Key: (COPY_Key, MEMBER Key)
Foreign Key: COPYKEY COPY_Key)
References: ASG.COPYMEMBER
Foreign Key: MEMBRKEY (MEMBER_Key)
References: ASG.MEMBER
ASG.COPY _ Col 1: COPY_Key Char(8)
INCLIN_PGM
Col 2: PGM_Key Char(8)
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Primary Key:

(COPY_Key, PGM_Key)
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Foreign Key: COPYKEY (COPY_Key)
References: ASG.COPYMEMBER
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.COPYMB INCLIN Col I: COPYMBR Key Char(8)
_COPYMB
Col 2: COPYMBR2 Key Char(8)
Primary Key: (COPYMBR Key,
COPYMBR2_ Key)
Foreign Key: CPMBKEY (COPYMBR_ Key)
References: ASG.COPYMEMBER
Foreign Key: CPMB2KEY (COPYMBR2 Key)
References: ASG.COPYMEMBER
ASG.COPYMB _USES  Col 1: COPYMBR Key Char(8)
COPYMB
Col 2: COPYMBR2 Key Char(8)
Primary Key: (COPYMBR Key,
COPYMBR2_ Key)
Foreign Key: CPMBKEY (COPYMBR Key)
References: ASG.COPYMEMBER
Foreign Key: CPMB2KEY (COPYMBR2 Key)
References: ASG.COPYMEMBER
ASG.CSD_HAS Col 1: CSD_Key Char(8)
CICSTRANS
Col 2: CICSTRANS Key Char(8)

Primary Key:

(CSD_Key, CICSTRANS Key)
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Foreign Key: CSDKEY (CSD Key)
References: ASG.CSD

Foreign Key: CTXNKEY
(CICSTRANS Key)

References: ASG.CICSTXN

ASG.CSD _HAS Col 1: CSD_Key Char(8)
DD

Col 2: DD Key Char(8)
Primary Key: (CSD_Key, DD_Key)

Foreign Key: CSDKEY (CSD Key)

References: ASG.CSD

Foreign Key: DDKEY (DD_Key)

References: ASG.DD

ASG.CSECT _IN_ Col 1: CSECT _Key Char(8)
LM

Col 2: LM Key Char(8)
Primary Key: (CSECT Key, LM Key)

Foreign Key: CSECTKEY (CSECT Key)

References: ASG.CSECT

Foreign Key: LMKEY (LM _Key)

References: ASG.LOADMODULE

ASG.CSECT IS Col 1: CSECT Key Char(8)
PGM

Col 2: PGM Key Char(8)

Primary Key: (CSECT Key, PGM Key)
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Foreign Key: CSECTKEY (CSECT Key)
References: ASG.CSECT
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.CURSOR IN Col 1: CURSOR Key Char(8)
DATABASE
Col 2: DATABASE Key Char(8)
Primary Key: (CURSOR Key,
DATABASE Key)
Foreign Key: CURSRKEY (CURSOR_Key)
References: ASG.CURSOR
Foreign Key: DBASEKEY (DATABASE Key)
References: ASG.DATABASE
ASG.CURSOR_IN Col 1: CURSOR_Key Char(8)
PGM
Col 2: PGM_Key Char(8)
Primary Key: (CURSOR Key,PGM_Key)
Foreign Key: CURSRKEY(CURSOR Key)
References: ASG.CURSOR
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.DATA _ Col 1: DATA Key Char(8)
DEFIN_INCL
Col 2: INCL Key Char(8)
Primary Key: (DATA Key, INCL Key)

275



ASG-Alliance User’s Guide

Table name Contents

Foreign Key:
References:
Foreign Key:

References:

DATAKEY (INCL Key)
ASG.DATAITEM
INCLKEY (INCL_Key)

ASG.COPYMEMBER

ASG.DATA_
DEFIN_PGM

Col 1:

Col 2:

Primary Key:

Foreign Key:
References:
Foreign Key:

References:

DATA Key Char(8)

PGM_Key Char(8)
(DATA_Key, PGM_Key)

DATAKEY (DATA_ Key)
ASG.DATAITEM

PGMKEY (PGM_Key)

ASG.PROGRAM

ASG.DATA HAS_
HOMONYM

Col 1:

Col 2:

Primary Key:

Foreign Key:
References:
Foreign Key:

References:

DATA Key Char(8)

HOMONYM Key Char(8)
(DATA Key, HOMONYM Key)
DATAKEY (DATA Key)
ASG.DATAITEM

HOMKEY (HOMONYM Key)

ASG.DATAITEM

ASG.DATA HAS
SYNONYM
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Col 1:

Col 2:

Primary Key:

Foreign Key:

DATA Key Char(8)

SYNONYM Key Char(8)
(DATA_Key, SYNONYM _Key)

DATAKEY (DATA_Key)
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References: ASG.DATAITEM

Foreign Key: SYNKEY (SYNONYM Key)

References: ASG.DATAITEM
ASG.DATA IN Col 1: DATA Key Char(8)
RECORD

Col 2: RECORD Key Char(8)

Primary Key: (DATA_Key, RECORD_ Key)

Foreign Key: DATAKEY (DATA_Key)

References: ASG.DATAITEM

Foreign Key: RECKEY (RECORD Key)

References: ASG.RECORD
ASG.DATABASE HAS Col 1: DATABASE Key Char(8)
_CRSR

Col 2: CURSOR Key Char(8)

Primary Key: (DATABASE Key,

CURSOR _Key)

Foreign Key: DBASEKEY (DATABASE Key)

References: ASG.DATABASE

Foreign Key: CURSRKEY (CURSOR_Key)

References: ASG.CURSOR
ASG.DATABASE HAS Col 1: DATABASE Key Char(8)
_TBLSP

Col 2: TBLSP Key Char(8)

Primary Key: (DATABASE Key,

TBLSP Key)
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Foreign Key: DBASEKEY
(DATABASE Key)

References: ASG.DATABASE

Foreign Key: TBLSPKEY (TBLSP Key)

References: ASG.TABLESPACE
ASG.DATABASE IN  Col I: DATABASE Key Char(8)
PGM

Col 2: PGM_Key Char(8)

Primary Key: (DATABASE Key, PGM_Key)

Foreign Key: DBKEY (DATABASE Key)

References: ASG.DATABASE

Foreign Key: PGMPKEY (PGM_Key)

References = ASG.PROGRAM
ASG.DATABASE IN_ Col 1: DATABASE Key Char(8)
STOGRP

Col 2: STOGRP_Key Char(8)

Primary Key: (DATABASE Key,

STOGRP_Key)

Foreign Key: DBASEKEY (DATABASE Key)

References: ASG.DATABASE

Foreign Key: STOGPKEY (STOGRP_Key)

References ~ ASG.STOGROUP
ASG.DBD HAS Col 1: DBD Key Char(8)
DD

Col 2: DD Key Char(8)
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(DBD_Key, DD Key)



Appendix E - Export Language Reference

Table name Contents

Foreign Key:
References:
Foreign Key:

References:

DBDKEY (DBD Key)
ASG.DBD
DDKEY (DD _Key)

ASG.DD

ASG.DBD HAS
SEGMENT

Col 1:

Col 2:

Primary Key:

Foreign Key:
References:
Foreign Key:

References:

DBD_ Key Char(8)

SEGMENT Key Char(8)
(DBD Key, SEGMENT Key)
DBDKEY (DBD Key)

ASG.DBD

SEGMTKEY (SEGMENT Key)

ASG.SEGMENT

ASG.DBD _IN_
MBR

Col 1:

Col 2:

Primary Key:

Foreign Key:
References:
Foreign Key:

References:

DBD Key Char(8)

MBR_Key Char(8)
(DBD_Key, MBR_Key)

DBDKEY (DBD Key)

ASG.DBD

MBRKEY (MBR Key)

ASG.MEMBER

ASG.DBD IN_
PCB

Col 1:

Col 2:

Primary Key:

Foreign Key:

DBD Key Char(8)

PCB_Key Char(8)
(DBD_Key, PCB_Key)

DBDKEY (DBD_Key)
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References: ASG.DBD
Foreign Key: PCBKEY (PCB_Key)
References: ASG.PCB
ASG.DD _HAS Col 1: DD Key Char(8)
DSN
Col 2: DSN Key Char(8)
Primary Key: (DD Key, DSN Key)
Foreign Key: DDKEY (DD Key)
References: ASG.DD
Foreign Key: DSNKEY (DSN_Key)
References: ASG.DSN
ASG.DD _IN CICS Col 1: DD Key Char(8)
Col 2: CICS Key Char(8)
Primary Key: (DD Key, CICS Key)
Foreign Key: DDKEY (DD Key)
References: ASG.DD
Foreign Key: CICSKEY (CICS Key)
References: ASG.CICSTXN
ASG.DD_IN _CSD Col 1: DD Key Char(8)
Col 2: CSD Key Char(8)
Primary Key: (DD Key, CSD_Key)
Foreign Key: DDKEY (DD _Key)
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References: ASG.DD
Foreign Key: CSDKEY (CSD Key)
References: ASG.CSD

ASG.DD IN DBD Col 1: DD Key Char(8)
Col 2: DBD Key Char(8)
Primary Key: (DD Key, DBD Key)
Foreign Key: DDKEY (DD Key)
References: ASG.DD
Foreign Key: DBDKEY (DBD Key)
References: ASG.DBD

ASG.DD _IN FCT Col 1: DD Key Char(8)
Col 2: FCT Key Char(8)
Primary Key: (DD Key, FCT Key)
Foreign Key: DDKEY (DD Key)
References: ASG.DD
Foreign Key: FCTKEY (FCT Key)
References: ASG.FCT

ASG.DD_IN _STEP Col 1: DD Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (DD_Key, STEP Key)
Foreign Key: DDKEY (DD Key)
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References: ASG.DD
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.DD Col 1: DD Key Char(8)
SELECTEDBY_ FD
Col 2: FD Key Char(8)
Primary Key: (DD Key, FD Key)
Foreign Key: DDKEY (DD Key)
References: ASG.DD
Foreign Key: FDKEY (FD Key)
References: ASG.FD
ASG.DI_REF Col 1: DATA Key Char(8)
MAPFIELD
Col 2: MAPFIELD Key Char(8)
Primary Key: (DATA_Key, MAPFIELD Key)
Foreign Key: DIKEY (DATA Key)
References: ASG.DATAITEM
Foreign Key: MPFKEY (MAPFIELD Key)
References: ASG.MAPFIELD
ASG.DSN_HAS Col 1: DSN_Key Char(8)
MEMBER
Col 2: MBR Key Char(8)
Primary Key: (DSN_Key, MBR Key)
Foreign Key: DSNKEY (DSN_Key)
References: ASG.DSN
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Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.DSN IN DD Col 1: DSN_ Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (DSN Key, DD Key)
Foreign Key: DSNKEY (DSN_Key)
References: ASG.DSN
Foreign Key: DDKEY (DD Key)
References: ASG.DD
ASG.ENTRY Col 1: ENTRY Key Char(8)
CALLEDBY PGM
Col 2: PGM_Key Char(8)
Primary Key: (ENTRY Key, PGM_Key)
Foreign Key: ENTRYKEY (ENTRY Key)
References: ASG.ENTRY
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.ENTRY IN PGM Col 1: ENTRY Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (ENTRY Key, PGM_Key)
Foreign Key: ENTRYKEY (ENTRY_Key)
References: ASG.ENTRY
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Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.FCT HAS Col 1: FCT Key Char(8)
DD
Col 2: DD Key Char(8)
Primary Key: (FCT_Key, DD Key)
Foreign Key: FCTKEY (FCT_Key)
References: ASG.FCT
Foreign Key: DDKEY (DD Key)
References: ASG.DD
ASG.FCT IN_ Col 1: FCT Key Char(8)
MBR
Col 2: MBR Key Char(8)
Primary Key: (FCT Key, MBR Key)
Foreign Key: FCTKEY (FCT_Key)
References: ASG.FCT
Foreign Key: MBRKEY (MBR_Key)
References: ASG.MEMBER
ASG.FD IN PGM Col 1: FD Key Char(8)
Col 2: PGM_Key Char(8)
Primary Key: (FD Key, PGM_Key)
Foreign Key: FDKEY (FD_ Key)
References: ASG.FD
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Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.FD_ Col 1: FD Key Char(8)
SELECTS DD

Col 2: DD Key Char(8)

Primary Key: (FD_Key, DD Key)

Foreign Key: FDKEY (FD_Key)

References: ASG.FD

Foreign Key: DDKEY (DD Key)

References: ASG.DD
ASG.FD_USES Col 1: FD Key Char(8)
RECORD

Col 2: REC Key Char(8)

Primary Key: (FD _Key, REC Key)

Foreign Key: FDKEY (FD_Key)

References: ASG.FD

Foreign Key: RECKEY (REC Key)

References: ASG.RECORD
ASG.FIELD IN Col 1: FIELD Key Char(8)
SEGMENT

Col 2: SEGMENT Key Char(8)

Primary Key: (FIELD Key, SEGMENT Key)

Foreign Key: FIELDKEY (FIELD Key)

References: ASG.SEGFIELD
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Foreign Key: SEGMTKEY (SEGMENT _Key)

References: ASG.SEGMENT
ASG.FMT _ FMT Key Char(8)
EXECBY PGM
PGM_Key Char(8)
Primary Key: (FMT_Key, PGM_Key)
Foreign Key: FMTKEY (FMT_Key)
References: ASG.FORMAT
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.FORMAT _ FORMAT Key Char(8)
EXBY FORMAT
FORMAT2 Key Char(8)

Primary Key:

(FORMAT Key,
FORMAT2_Key)

Foreign Key: FORMTKEY (FORMAT Key)
References: ASG.FORMAT
Foreign Key: FORMAT2KEY
(FORMAT2 Key)
References: ASG.FORMAT
ASG.FORMAT _ FORMAT Key Char(8)
EXEC IMSTXN
IMSTRANS Key Char(8)
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References: ASG.FORMAT
Foreign Key: IMTXNKEY (IMSTRANS Key)
References: ASG.IMSTXN
ASG.FORMAT IN Col 1: FORMAT Key Char(8)
MBR
Col 2: MBR_ Key Char(8)
Primary Key: (FORMAT Key, MBR Key)
Foreign Key: FMTKEY (FORMAT Key)
References: ASG.FORMAT
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.IDMS IN Col 1: IDMS Key Char(8)
PGM
Col 2: PGM_Key Char(8)
Primary Key: (IDMS_Key, PGM_Key)
Foreign Key: IDMSKEY (IDMS Key)
References: ASG.IDMS
Foreign Key: FDKEY (PGM Key)
References: ASG.PROGRAM
ASG.IDMSMAP _ Col 1: IDMSMAP_Key Char(8)
IN_PGM
Col 2: PGM_Key Char(8)
Primary Key: (IDMSMAP_ Key, PGM_Key)
Foreign Key: IMAPKEY (IDMSMAP_ Key)
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References: ASG.IDMSMAP

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.IDMSREC Col 1: IDMSRECORD Key Char(8)
IN_ PGM

Col 2: PGM_Key Char(8)

Primary Key: (IDMSRECORD Key,

PGM_Key)

Foreign Key: IRECKEY (IDMSRECORD_Key)

References: ASG.IDMSRECORD

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.IMSTRANS EXEC Col 1: IMSTRANS Key Char(8)
_LOAD

Col 2: LOAD Key Char(8)

Primary Key: (IMSTRANS Key, LOAD Key)

Foreign Key: IMTXNKEY (IMSTRANS Key)

References: ASG.IMSTXN

Foreign Key: LOADKEY (LOAD Key)

References: ASG.LOADMODULE
ASG.IMSTXN _ Col 1: IMSTRANS Key Char(8)
EXBY _FORMAT

Col 2: FORMAT Key Char(8)

Primary Key: (IMSTRANS Key,

FORMAT Key)
Foreign Key: IMTXNKEY (IMSTRANS Key)
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References: ASG.IMSTXN
Foreign Key: FORMTKEY (FORMAT Key)
References: ASG.FORMAT
ASG.IMSTXN Col 1: IMSTRANS Key Char(8)
EXECBY _PGM
Col 2: PGM_Key Char(8)
Primary Key: (IMSTRANS Key, PGM_Key)
Foreign Key: IMTXNKEY (IMSTRANS Key)
References: ASG.IMSTXN
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.INCL_HAS DATA Col 1: INCL_Key Char(8)
Col 2: DATA Key Char(8)
Primary Key: (INCL_Key,DATA Key)
Foreign Key: INCLKEY (INCL Key)
References: ASG.COPYMEMBER
Foreign Key: DATAKEY (DATA Key)
References: ASG.DATAITEM
ASG.JOB_HAS Col 1: JOB Key Char(8)
STEP
Col 2: STEP Key Char(8)
Primary Key: (JOB_Key, STEP Key)
Foreign Key: JOBKEY (JOB_Key)
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References: ASG.JOB
Foreign Key: STEPKEY (STEP_Key)
References: ASG.JOB
ASG.JOB_IN Col 1: JOB Key Char(8)
MBR
Col 2: MBR_ Key Char(8)
Primary Key: (JOB_Key, MBR Key)
Foreign Key: JOBKEY (JOB_Key)
References: ASG.JOB
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.JOB_USES Col 1: JOB Key Char(8)
CATALOG
Col 2: CATALOG Key Char(8)
Primary Key: (JOB_Key, CATALOG_Key)
Foreign Key: JOBKEY (JOB Key)
References: ASG.JOB
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
ASG.JOB_USES Col 1: JOB Key Char(8)
LIBRARY
Col 2: LIBRARY Key Char(8)
Primary Key: (JOB_Key, LIBRARY Key)
Foreign Key: JOBKEY (JOB_ Key)
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References: ASG.JOB

Foreign Key: LIBKEY (LIBRARY Key)

References: ASG.LIBRARY
ASG.LIBRARY _ Col 1: LIBRARY Key Char(8)
HAS MBR

Col 2: MBR_ Key Char(8)

Primary Key: (LIBRARY_ Key, MBR Key)

Foreign Key: LIBKEY (LIBRARY Key)

References: ASG.LIBRARY

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER
ASG.LIBRARY Col 1: LIBRARY Key Char(8)
USDBY_JOB

Col 2: JOB_Key Char(8)

Primary Key: (LIBRARY Key, JOB Key)

Foreign Key: LIBKEY (LIBRARY Key)

References: ASG.LIBRARY

Foreign Key: JOBKEY (JOB_ Key)

References: ASG.JOB
ASG.LIBRARY _ Col 1: LIBRARY Key Char(8)
USDBY_STP

Col 2: STEP Key Char(8)

Primary Key: (LIBRARY Key, STEP Key)

Foreign Key: LIBKEY (LIBRARY Key)
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References: ASG.LIBRARY
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.LM Col 1: LM Key Char(8)
EXECBY_STEP
Col 2: STEP Key Char(8)
Primary Key: (LM_Key, STEP_ Key)
Foreign Key: LMKEY (LM_Key)
References: ASG.LOADMODULE
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.LM _HAS Col 1: LM Key Char(8)
CSECT
Col 2: CSECT Key Char(8)
Primary Key: (LM_Key, CSECT Key)
Foreign Key: LMKEY (LM_Key)
References: ASG.LOADMODULE
Foreign Key: CSECTKEY (CSECT Key)
References: ASG.CSECT
ASG.LM_IN_MBR Col 1: LM Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (LM_Key, MBR Key)
Foreign Key: LMKEY (LM_Key)
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References: ASG.LOADMODULE
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.LOAD _ Col 1: LOAD Key Char(8)
EXECBY_IMSTXN
Col 2: IMSTXN_ Key Char(8)
Primary Key: (LOAD_Key, IMSTXN Key)
Foreign Key: LOADKEY (LOAD_Key)
References: ASG.LOADMODULE
Foreign Key: IMTXNKEY (IMSTXN Key)
References: ASG.IMSTXN
ASG.LREC HAS Col 1: LREC Key Char(8)
RECORDS
Col 2: RECORDS Key Char(8)
Primary Key: (LREC Key, RECORDS Key)
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD
Foreign Key: RECRDKEY (RECORDS Key)
References: ASG.RECORD
ASG.LREC_IN _ Col 1: LREC Key Char(8)
PGM
Col 2: PGM_Key Char(8)
Primary Key: (LREC Key, PGM Key)
Foreign Key: LRECKEY (LREC Key)
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References: ASG.LOGICALRECORD
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.MAP HAS Col 1: MAP_Key Char(8)
MAPFIELD
Col 2: MAPFIELD Key Char(8)
Primary Key: (MAP_Key, MAPFIELD Key)
Foreign Key: MAPKEY (MAP_Key)
References: ASG.MAP
Foreign Key: MAPFDKEY (MAPFIELD Key)
References: ASG.MAPFIELD
ASG.MAP HAS Col 1: MAP_Key Char(8)
RECORDS
Col 2: RECORDS Key Char(8)
Primary Key: (MAP_Key, RECORDS Key)
Foreign Key: MAPKEY (MAP Key)
References: ASG.MAP
Foreign Key: RECRDKEY (RECORDS Key)
References: ASG.RECORD
ASG.MAP_IN Col 1: MAP_Key Char(8)
MAPSET
Col 2: MAPSET Key Char(8)
Primary Key: (MAP_Key, MAPSET Key)
Foreign Key: MAPKEY (MAP_Key)
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References: ASG.MAP
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
ASG.MAP _ Col 1: MAP_Key Char(8)
USDBY PGM
Col 2: PGM_Key Char(8)
Primary Key: (MAP_Key, PGM_Key)
Foreign Key: MAPKEY (MAP_Key)
References: ASG.MAP
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.MAPFIELD IN_ Col 1: MAPFIELD Key Char(8)
MAP
Col 2: MAP_ Key Char(8)
Primary Key: (MAPFIELD Key, MAP Key)
Foreign Key: MAPFDKEY (MAPFIELD Key)
References: ASG.MAPFIELD
Foreign Key: MAPKEY (MAP_Key)
References: ASG.MAP
SISG.MAPFIELD_REF_ Col 1: MAPFIELD Key Char(8)
Col 2: DATA Key Char(8)
Primary Key: (MAPFIELD Key, DATA Key)
Foreign Key: MPFKEY (MAPFIELD Key)
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References: ASG.MAPFIELD
Foreign Key: DIKEY (DATA Key)
References: ASG.DATAITEM
ASG.MAPREC _ Col 1: MAPREC Key Char(8)
REFR_RECORD
Col 2: RECORD Key Char(8)
Primary Key: (MAPREC Key, RECORDD Key)
Foreign Key: MAPRCKEY (MAPREC Key)
References: ASG.MAP
Foreign Key: RECRDKEY (RECORD_ Key)
References: ASG.RECORD
ASG.MAPSET _ Col 1: MAPSET Key Char(8)
HAS MAP
Col 2: MAP_ Key Char(8)
Primary Key: (MAPSET Key, MAP_Key)
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
Foreign Key: MAPKEY (MAP_Key)
References: ASG.MAP
ASG.MAPSET IN_ Col 1: MAPSET Key Char(8)
MBR
Col 2: MBR Key Char(8)
Primary Key: (MAPSET Key, MBR Key)
Foreign Key: MAPSTKEY (MAPSET Key)
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References: ASG.MAPSET
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.MAPSET _ Col 1: MAPSET Key Char(8)
USDBY_PGM
Col 2: PGM_Key Char(8)
Primary Key: (MAPSET Key, PGM_Key)
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.MBR HAS DBD Col I: MBR Key Char(8)
Col 2: DBD Key Char(8)
Primary Key: (MBR_Key, DBD Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: DBDKEY (DBD Key)
References: ASG.DBD
ASG.MBR_HAS Col 1: MBR_Key Char(8)
FCT
Col 2: FCT Key Char(8)
Primary Key: (MBR_Key, FCT Key)
Foreign Key: MBRKEY (MBR_Key)
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References: ASG.MEMBER
Foreign Key: FCTKEY (FCT_Key)

References: ASG.FCT

ASG.MBR _HAS Col 1: MBR Key Char(8)
FORMAT

Col 2: FORMAT Key Char(8)
Primary Key: (MBR_Key, FORMAT Key)

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

Foreign Key: FMTKEY (FORMAT Key)

References: ASG.FORMAT

ASG.MBR_HAS Col 1: MBR_ Key Char(8)
JOB

Col 2: JOB_Key Char(8)
Primary Key: (MBR_Key, JOB Key)

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

Foreign Key: JOBKEY (JOB_ Key)

References: ASG.JOB

ASG.MBR _HAS Col 1: MBR_Key Char(8)
LM

Col 2: LM Key Char(8)
Primary Key: (MBR Key, LM Key)

Foreign Key: MBRKEY (MBR Key)

298



Appendix E - Export Language Reference

Table name Contents

References: ASG.MEMBER
Foreign Key: LMKEY (LM_Key)
References: ASG.LOADMODULE
ASG.MBR HAS Col 1: MBR Key Char(8)
MAPSET
Col 2: MAPSET Key Char(8)
Primary Key: (MBR_Key, MAPSET Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
ASG.MBR HAS Col 1: MBR Key Char(8)
MDADB
Col 2: MDADB Key Char(8)
Primary Key: (MBR_Key, MDADB Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: MDADBKEY (MDADB_Key)
References: ASG.IMSDYNALLOC-
MACRO
ASG.MBR_HAS Col 1: MBR_Key Char(8)
PCT
Col 2: PCT Key Char(8)
Primary Key: (MBR_Key, PCT Key)
Foreign Key: MBRKEY (MBR Key)
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References: ASG.MEMBER
Foreign Key: PCTKEY (PCT_Key)

References: ASG.PCT

ASG.MBR _HAS Col 1: MBR Key Char(8)
PGM

Col 2: PGM_Key Char(8)
Primary Key: (MBR_Key, PGM_Key)

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.MBR_HAS Col 1: MBR_ Key Char(8)
PPT

Col 2: PPT Key Char(8)
Primary Key: (MBR_Key, PPT Key)

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

Foreign Key: PPTKEY (PPT Key)

References: ASG.PPT

ASG.MBR _HAS Col 1: MBR_Key Char(8)
PROC

Col 2: PROC Key Char(8)
Primary Key: (MBR_Key, PROC Key)

Foreign Key: MBRKEY (MBR Key)
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References: ASG.MEMBER

Foreign Key: PROCKEY (PROC Key)

References: ASG.PROC
ASG.MBR HAS Col 1: MBR Key Char(8)
PSB

Col 2: PSB Key Char(8)

Primary Key: (MBR_Key, PSB Key)

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

Foreign Key: PSBKEY (PSB_Key)

References: ASG.PSB
ASG.MBR IN Col 1: MEMBER Key Char(8)
DSN

Col 2: DSN_ Key Char(8)

Primary Key: (MBR_Key, LIBRARY Key)

Foreign Key: MEMBERKEY (DSN_Key)

References: ASG.MEMBER

Foreign Key: DSNKEY (DSN_Key)

References: ASG.DSN
ASG.MBR_IN Col 1: MBR_Key Char(8)
LIBRARY

Col 2: LIBRARY Key Char(8)

Primary Key: (MBR_Key, LIBRARY Key)

Foreign Key: MBRKEY (MBR Key)
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References: ASG.MEMBER
Foreign Key: LIBKEY (LIBRARY Key)
References: ASG.LIBRARY
ASG.MBR Col 1: MBR Key Char(8)
INCLIN_SOURCE
Col 2: SOURCE Key Char(8)
Primary Key: (MBR_Key, SOURCE Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.COPYMEMBER
Foreign Key: SRCKEY (SOURCE Key)
References: ASG.MEMBER
ASG.MBR IS Col 1: MBR Key Char(8)
COPYINCL
Col 2: COPYINCL Key Char(8)
Primary Key: (MBR_Key, COPYINCL Key)
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
Foreign Key: CPYMBKEY (COPYINCL Key)
References: ASG.COPYMEMBER
ASG.MDA DBIN MBR Col 1: MDA Key Char(8)
Col 2: MBR Key Char(8)
Primary Key: (MDA Key, MBR Key)
Foreign Key: MDAKEY (MDA Key)
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References: ASG.IMSDYNALLOC-MAC
RO
Foreign Key: KEY (MBR Key)
References: ASG.MEMBER
ASG.MDA HAS DD Col 1: MDA Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (MDA _Key, DD Key)
Foreign Key: MDAKEY (MDA Key)
References: ASG.IMSDYNALLOC-MAC
RO
Foreign Key: RECRDKEY (RECORDS Key)
References: ASG.RECORD
ASG.PCB_HAS Col 1: PCB_Key Char(8)
DBD
Col 2: DBD Key Char(8)
Primary Key: (PCB_Key, DBD Key)
Foreign Key: PCBKEY (PCB_Key)
References: ASG.PCB
Foreign Key: DBDKEY DBD_Key)
References: ASG.DBD
ASG.PCB_HAS _ Col 1: PCB_Key Char(8)
SENSEG
Col 2: SENSEG Key Char(8)
Primary Key: (PCB_Key, SENSEG Key)
Foreign Key: PCBKEY (PCB_Key)
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References: ASG.PCB
Foreign Key: SENSGKEY (SENSEG_Key)
References: ASG.SENSEG
ASG.PCB IN PSB Col 1: PCB Key Char(8)
Col 2: PSB Key Char(8)
Primary Key: (PCB_Key, PSB_Key)
Foreign Key: PCBKEY (PCB_Key)
References: ASG.PCB
Foreign Key: PSBKEY (PSB_Key)
References: ASG.PSB
ASG.PCT HAS Col 1: PCT Key Char(8)
CICSTRANS
Col 2: CICSTRANS Key Char(8)
Primary Key: (PCT_Key,CICSTRANS Key)
Foreign Key: PCTKEY (PCT Key)
References: ASG.PCT
Foreign Key: CTXNKEY (CICSTRANS Key)
References: ASG.CICSTXN
ASG.PCT_IN_ Col 1: PCT Key Char(8)
MBR
Col 2: MBR Key Char(8)
Primary Key: (PCT Key, MBR Key)
Foreign Key: PCTKEY (JOB Key)
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References: ASG.PCT
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.PGM CALLS Col 1: PGM_Key Char(8)
ENTRY
Col 2: Entry Key Char(8)
Primary Key: (PGM_Key, Entry Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: ENTRYKEY (Entry Key)
References: ASG.ENTRY
ASG.PGM_EXEC FMT Col 1: PGM Key Char(8)
Col 2: FMT Key Char(8)
Primary Key: (PGM_Key, FMT Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: FMTKEY (FMT Key)
References: ASG.FORMAT
ASG.PGM_EXEC _ Col 1: PGM_Key Char(8)
IMSTRANS
Col 2: IMSTRANS Key Char(8)
Primary Key: (PGM_Key, IMSTRANS Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: ITXNKEY (IMSTRANS Key)
References: ASG.IMSTXN
ASG.PGM_EXEC Col 1: PGM_Key Char(8)
TRANS
Col 2: TRANS Key Char(8)
Primary Key: (PGM_Key, TRANS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: TRANSKEY (TRANS Key)
References: ASG.CICSTXN
ASG.PGM Col 1: PGM_Key Char(8)
EXECBY_CICSTXN
Col 2: CICSTRANS Key Char(8)
Primary Key: (PGM_Key, CICSTRANS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CITXNKEY (CICSTRANS Key)
References: ASG.CICSTXN
ASG.PGM_HAS Col 1: PGM_Key Char(8)
AREAS
Col 2: AREA Key Char(8)
Primary Key: (PGM_Key, AREA Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM

Foreign Key: AREAKEY (AREA Key)

References: ASG.AREA
ASG.PGM HAS Col 1: PGM_Key Char(8)
COLUMNS

Col 2: COLUMN Key Char(8)

Primary Key: (PGM_Key, COLUMN_Key)

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

Foreign Key: COLKEY (COLUMN Key)

References: ASG.COLUMN
ASG.PGM HAS Col 1: PGM_Key Char(8)
CURSOR

Col 2: CURSOR Key Char(8)

Primary Key: (PGM_Key, CURSOR Key)

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

Foreign Key: CRSKEY (CURSOR Key)

References: ASG.CURSOR
ASG.PGM_HAS Col 1: PGM_Key Char(8)
DB

Col 2: DATABASE Key Char(8)

Primary Key: (PGM_Key, DATABASE Key)

Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: DBKEY (DATABASE Key)

References: ASG.DATABASE

ASG.PGM HAS Col 1: PGM_Key Char(8)
ENTRY

Col 2: Entry Key Char(8)
Primary Key: (PGM_Key, Entry Key)

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

Foreign Key: ENTRYKEY (Entry Key)

References: ASG.ENTRY

ASG.PGM HAS Col 1: PGM_Key Char(8)
FD

Col 2: FD Key Char(8)
Primary Key: (PGM_Key, FD Key)

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

Foreign Key: FDKEY (FD Key)

References: ASG.FD

ASG.PGM HAS_ Col 1: PGM Key Char(8)
IDMS

Col 2: IDMS Key Char(8)
Primary Key: (PGM_Key, IDMS Key)

Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: IDMSKEY (IDMS Key)
References: ASG.IDMS
ASG.PGM HAS Col 1: PGM_Key Char(8)
IDMSMAP
Col 2: IDMSMAP_Key Char(8)
Primary Key: (PGM_Key, IDMSMAP Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: IMAPKEY (IDMSMAP_ Key)
References: ASG.IDMSMAP
ASG.PGM HAS Col 1: PGM_Key Char(8)
IDMSREC
Col 2: IDMSREC Key Char(8)
Primary Key: (PGM_Key, IDMSREC Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: IRECKEY (IDMSREC Key)
References: ASG.IDMSRECORD
ASG.PGM_HAS Col 1: PGM_Key Char(8)
LREC
Col 2: LREC Key Char(8)
Primary Key: (PGM_Key, IDMS Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: LRECKEY (LREC Key)
References: ASG.LOGICALRECORD
ASG.PGM HAS Col 1: PGM_Key Char(8)
RECORDS
Col 2: RECORDS Key Char(8)
Primary Key: (PGM_Key, RECORDS Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: RECRDKEY (RECORDS Key)
References: ASG.RECORD
ASG.PGM HAS Col 1: PGM_Key Char(8)
SCHEMA
Col 2: SCHEMA Key Char(8)
Primary Key: (PGM_Key, SCHEMA Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: SCHKEY (SCHEMA Key)
References: ASG.SCHEMA
ASG.PGM_HAS Col 1: PGM_Key Char(8)
SQL
Col 2: SQL Key Char(8)
Primary Key: (PGM_Key, SQL Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: SQLKEY (SQL Key)
References: ASG.SQL
ASG.PGM HAS Col 1: PGM_Key Char(8)
STOGROU
Col 2: STOGROUP_Key Char(8)
Primary Key: (PGM_Key, STOGROUP_ Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: STGKEY (STRGROUP_Key)
References: ASG.STOGROUP
ASG.PGM HAS Col 1: PGM_Key Char(8)
SUBSCHEMA
Col 2: SUBSCHEMA Key Char(8)
Primary Key: (PGM_Key,SUBSCHEMA Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: SUBKEY (SUBSCHEMA Key)
References: ASG.SUBSCHEMA
ASG.PGM_HAS Col 1: PGM_Key Char(8)
TABLES
Col 2: TABLE Key Char(8)
Primary Key: (PGM_Key, TABLE Key)

Foreign Key:

PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: TABLEKEY (TABLE_ Key)

References: ASG.TABLE

ASG.PGM HAS Col 1: PGM_Key Char(8)
TBLSP

Col 2: TABLESPACE Key Char(8)

Primary Key: (PGM_Key,
TABLESPACE Key)

Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM

Foreign Key: TBLSPKEY
(TABLESPACE Key)

References: ASG.TABLESPACE

ASG.PGM HAS Col 1: PGM_Key Char(8)
VIEW

Col 2: VIEW_Key Char(8)
Primary Key: (PGM_Key,VIEW_ Key)

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

Foreign Key: VIEWKEY (VIEW Key)

References: ASG.VIEW

ASG.PGM IN Col 1: PGM Key Char(8)
MBR

Col 2: MBR Key Char(8)
Primary Key: (PGM_Key, MBR Key)

Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.PGM _INCL Col 1: PGM_Key Char(8)
COPYMBR
Col 2: COPYMBR Key Char(8)
Primary Key: (PGM_Key, COPYMBR Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CPYMBKEY (COPYMBR Key)
References: ASG.COPYMBR
ASG.PGM IS Col 1: PGM_Key Char(8)
CSECT
Col 2: CSECT Key Char(8)
Primary Key: (PGM_Key, CSECT Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CSECTKEY (CSECT Key)
References: ASG.CSECT
ASG.PGM_LINK PGM Col 1: PGM_Key Char(8)
Col 2: PGM2 Key Char(8)
Primary Key: (PGM_Key, PGM2 Key)
Foreign Key: PGMKEY PGM_Key)
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References: ASG.PROGRAM
Foreign Key: PGM2KEY (PGM2 Key)
References: ASG.PROGRAM
ASG.PGM Col 1: PGM_Key Char(8)
LINKEDBY PGM
Col 2: PGM2 Key Char(8)
Primary Key: (PGM_Key, PGM2 Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: PGM2KEY (PGM_Key)
References: ASG.PROGRAM
ASG.PGM_USES Col 1: PGM_Key Char(8)
CICSDD
Col 2: CICSDD_Key Char(8)
Primary Key: (PGM_Key, CICSDD_Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: CIDDKEY (CICSDD_ Key)
References: ASG.DD
ASG.PGM_USES MAP Col 1: PGM_Key Char(8)
Col 2: MAP_Key Char(8)
Primary Key: (PGM_Key, MAP Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: MAPKEY (MAP_Key)
References: ASG.MAP
ASG.PGM_USES Col 1: PGM_Key Char(8)
MAPSET
Col 2: MAPSET Key Char(8)
Primary Key: (PGM_Key, MAPSET Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: MAPSTKEY (MAPSET Key)
References: ASG.MAPSET
ASG.PGM USES PSB  Col 1: PGM Key Char(8)
Col 2: PSB_Key Char(8)
Primary Key: (PGM_Key, PSB Key)
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
Foreign Key: PSBKEY (PSB_Key)
References: ASG.PSB
ASG.PGM_USES Col 1: PGM_Key Char(8)
SEGMENT
Col 2: SEGMENT Key Char(8)
Primary Key: (PGM_Key, SEGMENT Key)
Foreign Key: PGMKEY (PGM_Key)
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References: ASG.PROGRAM
Foreign Key: SEGKEY (SEGMENT Key)
References: ASG.SEGMENT
ASG.PPT_IN_ Col 1: PPT Key Char(8)
MBR
Col 2: MBR_ Key Char(8)
Primary Key: (PPT Key, MBR Key)
Foreign Key: PPTKEY (PPT Key)
References: ASG.PPT
Foreign Key: MBRKEY (MBR Key)
References: ASG.MEMBER
ASG.PROC Col 1: PROC Key Char(8)
EXECBY_STEP
Col 2: STEP Key Char(8)
Primary Key: (PROC Key, STEP Key)
Foreign Key: PROCKEY (PROC Key)
References: ASG.PROC
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
ASG.PROC_HAS STEP Col 1: PROC_Key Char(8)
Col 2: STEP Key Char(8)
Primary Key: (PROC Key, STEP Key)
Foreign Key: PROCKEY (PROC Key)
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References: ASG.PROC

Foreign Key: STEPKEY (STEP_Key)

References: ASG.STEP
ASG.PROC IN Col 1: PROC Key Char(8)
MBR

Col 2: MBR_ Key

Primary Key: (PROC_Key, MBR Key)

Foreign Key: PROCKEY (REC_Key)

References: ASG.PROC

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER
ASG.PROGRAM_HAS  Col 1: PROGRAM_Key Char(8)
DATA

Col 2: DATA Key Char(8)

Primary Key: (PROGRAM Key,DATA Key)

Foreign Key: PGMKEY (PROGRAM Key)

References: ASG.PROGRAM

Foreign Key: DATAKEY (DATA Key)

References: ASG.DATAITEM
ASG.PSB_HAS _ Col 1: PSB_Key Char(8)
PCB

Col 2: PCB_Key Char(8)

Primary Key: (PSB_Key, PCB Key)

Foreign Key: PSBKEY (PSB_Key)
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References: ASG.PSB
Foreign Key: PCBKEY (PCB_Key)

References: ASG.PCB

ASG.PSB_IN Col 1: PSB Key Char(8)
MBR

Col 2: MBR_ Key Char(8)
Primary Key: (PSB_Key, MBR Key)

Foreign Key: PSBKEY (PGM_Key)

References: ASG.PSB

Foreign Key: MBRKEY (MBR Key)

References: ASG.MEMBER

ASG.PSB_USDBY Col 1: PSB Key Char(8)
PGM

Col 2: PGM_Key Char(8)
Primary Key: (PSB_Key, PGM_Key)

Foreign Key: PSBKEY (PSB Key)

References: ASG.PSB

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.REC HAS Col 1: REC Key Char(8)
DATAITEM

Col 2: DATA Key Char(8)
Primary Key: (REC Key, DATA Key)

Foreign Key: RECKEY (REC Key)
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References: ASG.RECORD
Foreign Key: DATAKEY (DATA_Key)
References: ASG.DATAITEM
ASG.REC REFBY Col 1: RECORD Key Char(8)
MAPREC
Col 2: MAPREC Key Char(8)
Primary Key: (RECORD_Key, MAPREC Key)
Foreign Key: RECRDKEY (RECORD_Key)
References: ASG.RECORD
Foreign Key: MAPRCKEY (MAPREC Key)
References: ASG.MAP
ASG.RECORD _IN Col 1: REC Key Char(8)
PGM
Col 2: PROGRAM Key Char(8)
Primary Key: (REC_Key, PROGRAM Key)
Foreign Key: RECKEY (REC Key)
References: ASG.RECORD
Foreign Key: PGMKEY (PROGRAM Key)
References: ASG.PROGRAM
ASG.RECORD _ Col 1: RECORD Key Char(8)
USDBY_FD
Col 2: FD Key Char(8)
Primary Key: (RECORD_Key, FD Key)
Foreign Key: RECRDKEY (RECORD_ Key)

319



ASG-Alliance User’s Guide

Table name Contents

References: ASG.RECORD

Foreign Key: FDKEY (FD_Key)

References: ASG.FD
ASG.RECORDS Col 1: RECORDS Key Char(8)
IN_AREA

Col 2: AREA Key Char(8)

Primary Key: (RECORDS Key, AREA Key)

Foreign Key: RECRDKEY (RECORDS Key)

References: ASG.RECORD

Foreign Key: AREAKEY (AREA Key)

References: ASG.AREA
ASG.RECORDS Col 1: RECORDS Key Char(8)
IN_LREC

Col 2: LREC Key Char(8)

Primary Key: (RECORDS Key, REC Key)

Foreign Key: RECRDKEY (RECORDS Key)

References: ASG.RECORD

Foreign Key: LRECKEY (LREC Key)

References: ASG.LOGICALRECORD
ASG.RECORDS _ Col 1: RECORDS_ Key Char(8)
IN_MAP

Col 2: MAP_Key Char(8)

Primary Key: (RECORDS Key, MAP_ Key)

Foreign Key: RECRDKEY (RECORDS Key)
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References: ASG.RECORD

Foreign Key: MAPKEY (MAP_Key)

References: ASG.MAP
ASG.SCHEMA _ Col 1: SCHEMA Key Char(8)
HAS SUBSCHM

Col 2: SUBSCHEMA Key Char(8)

Primary Key: (SCHEMA Key,

SUBSCHEMA Key)

Foreign Key: SCHEMKEY (SCHEMA Key)

References: ASG.SCHEMA

Foreign Key: SUBCKEY (SUBSCHEMA Key)

References: ASG.SUBSCHEMA
ASG.SCHEMA IN _ Col 1: SCHEMA Key Char(8)
PGM

Col 2: PGM_Key Char(8)

Primary Key: (SCHEMA Key, PGM_Key)

Foreign Key: SCHKEY (SCHEMA Key)

References: ASG.SCHEMA

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.SEGMENT HAS  Col 1: SEGMENT Key Char(8)
FIELD

Col 2: FIELD Key Char(8)

Primary Key: (SEGMENT Key, FIELD Key)

Foreign Key:

SEGMTKEY (SEGMENT Key)
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References: ASG.SEGMENT

Foreign Key: FIELDKEY (FIELD Key)

References: ASG.SEGFIELD
ASG.SEGMENT HAS  Col 1: SEGMENT Key Char(8)
SEGMNT

Col 2: SEGMENT2 Key Char(8)

Primary Key: (SEGMENT Key,

SEGMENT2 Key)

Foreign Key: SEGMTKEY (SEGMENT _Key)

References: ASG.SEGMENT

Foreign Key: SEGM2KEY (SEGMENT2 Key)

References: ASG.SEGMENT
ASG.SEGMENT _ Col 1: SEGMENT Key Char(8)
IN DBD

Col 2: DBD Key Char(8)

Primary Key: (SEGMENT Key, DBD Key)

Foreign Key: SEGMTKEY (SEGMENT Key)

References: ASG.SEGMENT

Foreign Key: DBDKEY (DBD Key)

References: ASG.DBD
ASG.SEGMENT _ Col 1: SEGMENT Key Char(8)
IN_SEGMENT

Col 2: SEGMENT2 Key Char(8)

Primary Key: (SEGMENT Key,

SEGMENT2 Key)
Foreign Key: SEGMTKEY (SEGMENT Key)
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References: ASG.SEGMENT
Foreign Key: SEGM2KEY (SEGMENT2 Key)
References: ASG.SEGMENT
ASG.SEGMENT _ Col 1: SEGMENT Key Char(8)
USDBY_PGM
Col 2: PGM_Key Char(8)
Primary Key: (SEGMENT Key, PGM_Key)
Foreign Key: SEGKEY (SEGMENT Key)
References: ASG.SEGMENT
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.SENFLD IN Col 1: SENFIELD Key Char(8)
SENSEG
Col 2: SENSEG Key Char(8)
Primary Key: (SENFIELD Key,
SENSEG_Key)
Foreign Key: SENFDKEY (SENFIELD Key)
References: ASG.SENFIELD
Foreign Key: SENSGKEY (SENSEG_ Key)
References: ASG.SENSEG
ASG.SENSEG _ Col 1: SENSEG_Key Char(8)
HAS_SENFLD
Col 2: SENFIELD Key Char(8)
Primary Key: (SENSEG Key,
SENFIELD Key)
Foreign Key: SENSG (SENSEG Key)
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References: ASG.SENSEG
Foreign Key: SENFDKEY (SENFIELD Key)
References: ASG.SENFIELD
ASG.SENSEG Col 1: SENSEG Key Char(8)
HAS SENSEG
Col 2: SENSEG2 Key Char(8)
Primary Key: (SENSEG Key,
SENSEG2 Key)
Foreign Key: SENSGKEY (SENSEG_Key)
References: ASG.SENSEG
Foreign Key: SENS2KEY (SENSEG2 Key)
References: ASG.SENSEG
ASG.SENSEG IN PCB Col 1: SENSEG_Key Char(8)
Col 2: PCB_Key Char(8)
Primary Key: (SENSEG_Key, PCB_Key)
Foreign Key: SENSGKEY (SENSEG_ Key)
References: ASG.SENSEG
Foreign Key: PCBKEY (PCB_Key)
References: ASG.PCB
ASG.SENSEG_IN Col 1: SENSEG_Key Char(8)
SENSEG
Col 2: SENSEG2 Key Char(8)
Primary Key: (SENSEG Key,
SENSEG2 Key)
Foreign Key: SENSGKEY (SENSEG_ Key)
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References: ASG.SENSEG
Foreign Key: SENS2KEY (SENSEG2 Key)
References: ASG.SENSEG
ASG.SOURCE INCL_ Col 1: SOURCE _ Key Char(8)
MEMBER
Col 2: MEMBER Key Char(8)
Primary Key: (SOURCE_Key, MEMBER Key)
Foreign Key: SRCKEY (SOURCE_Key)
References: ASG.MEMBER
Foreign Key: MBRKEY (MEMBER Key)
References: ASG.COPYMEMBER
ASG.SQL IN Col 1: SQL Key Char(8)
PGM
Col 2: PGM_Key Char(8)
Primary Key: (SQL_Key, PGM_Key)
Foreign Key: SQLKEY (SQL Key)
References: ASG.SQL
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.STEP_ Col 1: STEP Key Char(8)
EXECS LM
Col 2: LM Key Char(8)
Primary Key: (STEP Key, LM Key)
Foreign Key: STEPKEY (STEP_Key)
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References: ASG.STEP
Foreign Key: LMKEY (LM _Key)
References: ASG.LOADMODULE
ASG.STEP _ Col 1: STEP Key Char(8)
EXECS PROC
Col 2: PROC Key Char(8)
Primary Key: (STEP_Key, PROC Key)
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
Foreign Key: PROCKEY (PROC Key)
References: ASG.PROC
ASG.STEP_HAS DD Col 1: STEP Key Char(8)
Col 2: DD Key Char(8)
Primary Key: (STEP_Key, DD Key)
Foreign Key: STEPKEY (STEP Key)
References: ASG.STEP
Foreign Key: DDKEY (DD _Key)
References: ASG.DD
ASG.STEP_IN_ Col 1: STEP Key Char(8)
JOB
Col 2: JOB Key Char(8)
Primary Key: (STEP_ Key, JOB Key)
Foreign Key: STEPKEY (STEP_Key)
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References: ASG.STEP
Foreign Key: JOBKEY (JOB_Key)
References: ASG.JOB
ASG.STEP_IN_ Col 1: STEP Key Char(8)
PROC
Col 2: PROC Key Char(8)
Primary Key: (STEP_Key, PROC Key)
Foreign Key: STEPKEY (STEP_Key)
References: ASG.STEP
Foreign Key: PROCKEY (PROC Key)
References: ASG.PROC
ASG.STEP_USES Col 1: STEP Key Char(8)
CATALOG
Col 2: CATALOG Key Char(8)
Primary Key: (STEP_Key, CATALOG_ Key)
Foreign Key: STEPKEY (STEP Key)
References: ASG.STEP
Foreign Key: CATKEY (CATALOG Key)
References: ASG.CATALOG
ASG.STEP_USES Col 1: STEP Key Char(8)
LIBRARY
Col 2: LIBRARY Key Char(8)
Primary Key: (STEP Key, LIBRARY Key)
Foreign Key: STEPKEY (STEP_Key)
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References: ASG.STEP

Foreign Key: LIBKEY (LIBRARY Key)

References: ASG.LIBRARY
ASG.STOGP_HAS Col 1: STOGRP_Key Char(8)
DATABASE

Col 2: DATABASE Key Char(8)

Primary Key: (STOGRP_Key,

DATABASE Key)

Foreign Key: STOGPKEY (STOGRP_Key)

References: ASG.STOGROUP

Foreign Key: DBASEKEY (DATABASE Key)

References: ASG.DATABASE
ASG.STOGROUP _IN_ Col 1: STOGROUP_Key Char(8)
PGM

Col 2: PGM_Key Char(8)

Primary Key: (STOGROUP_ Key, PGM_Key)

Foreign Key: STGKEY (STOGROUP_ Key)

References: ASG.STOGROUP

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.SUBSCH_ Col 1: SUBSCHEMA_ Key Char(8)
HAS _AREAS

Col 2: AREA Key Char(8)

Primary Key: SUBSCHEMA Key,

AREA Key)
Foreign Key: SUBKEY (SUBSCHEMA Key)
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References: ASG.SUBSCHEMA

Foreign Key: AREAEKEY (AREA Key)

References: ASG.AREA
ASG.SUBSCHEMA _ Col 1: SUBSCHEMA_Key Char(8)
HAS LREC

Col 2: LREC Key Char(8)

Primary Key: (SUBSCHEMA Key,

LREC Key)
Foreign Key: SUBSCKEY
(SUBSCHEMA_Key)

References: ASG.SUBSCHEMA

Foreign Key: LRECKEY (LREC Key)

References: ASG.LOGICALRECORD
ASG.SUBSCHEMA Col 1: SUBSCHEMA Key Char(8)
_IN_PGM

Col 2: PGM_Key Char(8)

Primary Key: (SUBSCHEMA Key, PGM_Key)

Foreign Key: SUBKEY (SUBSCHEMA Key)

References: ASG.SUBSCHEMA

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
ASG.SUBSCHM _ Col 1: SUBSCHEMA Key Char(8)
IN_SCHEMA

Col 2: SCHEMA Key Char(8)
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Primary Key: (SUBSCHEMA Key,
SCHEMA Key)
Foreign Key: SUBSCKEY
(SUBSCHEMA_Key)

References: ASG.SUBSCHEMA

Foreign Key: SCHEMKEY (SCHEMA Key)

References: ASG.SCHEMA
ASG.TABLE _HAS Col 1: TABLE Key Char(8)
COLUMNS

Col 2: COLUMNS Key Char(8)

Primary Key: (TABLE Key, COLUMNS Key)

Foreign Key: TABLEKEY (TABLE Key)

References: ASG.TABLE

Foreign Key: COLUMKEY (COLUMNS Key)

References: ASG.COLUMN
ASG.TABLES IN PGM Col 1: TABLE Key Char(8)

Col 2: PGM_Key Char(8)

Primary Key: (TABLE Key, PGM_Key)

Foreign Key: TABLEKEY (TABLE Key)

References: ASG.TABLE

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM
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ASG.TABLES_IN_
TBLSP

Col 1:

Col 2:

Primary Key:

Foreign Key:

References:

Foreign Key:

References:

TABLES Key Char(8)

TBLSP Key Char(8)
(TABLES_ Key, TBLSP Key)
TABLEKEY (TABLES Key)
ASG.TABLE

TBLSPKEY (TBLSP Key)

ASG.TABLESPACE

ASG.TBLSP_HAS_
TABLES

Col 1:

Col 2:

Primary Key:

Foreign Key:

References:

Foreign Key:

References:

TBLSP Key Char(8)

TABLES Key Char(8)
(TBLSP_Key, TABLES Key)
TBLSPKEY (TBLSP_Key)
ASG.TABLESPACE

TABLEKEY (TABLES Key)

ASG.TABLE

ASG.TBLSP HAS_
VIEWS

Col 1:

Col 2:

Primary Key:

Foreign Key:

References:

Foreign Key:

References:

TBLSP_Key Char(8)

VIEWS Key Char(8)
(TBLSP_Key, TBLSP Key)
TBLSPKEY (TBLSP_Key)

ASG.TABLESPACE

VIEWSKEY (VIEWS Key)

ASG.VIEW
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ASG.TBLSP_IN Col 1: TBLSP_Key Char(8)
DATABASE
Col 2: DATABASE Key Char(8)
Primary Key: (TBLSP Key,
DATABASE Key)
Foreign Key: TBLSPKEY (TBLSP Key)
References: ASG.TABLESPACE
Foreign Key: DBASEKEY (DATABASE Key)
References: ASG.DATABASE
ASG.TBLSP_IN_ Col 1: TBLSP_Key Char(8)
PGM
Col 2: PGM_Key Char(8)
Primary Key: (TBLSP_Key, PGM_Key)
Foreign Key: TBLSPKEY (TBLSP Key)
References: ASG.TABLESPACE
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
ASG.TRANS Col 1: TRANS Key Char(8)
EXECBY PGM
Col 2: PGM Key Char(8)
Primary Key: (TRANS Key, PGM_Key)
Foreign Key: TRANSKEY (TRANS Key)
References: ASG.CICSTXN
Foreign Key: PGMKEY (PGM_Key)
References: ASG.PROGRAM
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ASG.VIEW_HAS Col 1: VIEW_Key Char(8)
COLUMNS

Col 2: COLUMNS Key Char(8)
Primary Key: (VIEW_Key, COLUMNS Key)

Foreign Key: VIEWKEY (VIEW_ Key)

References: ASG.VIEW

Foreign Key: COLUMKEY (COLUMNS Key)

References: ASG.COLUMN

ASG.VIEWS_IN_ Col 1: VIEW Key Char(8)
PGM

Col 2: PGM_Key Char(8)
Primary Key: (VIEW_Key, PGM_Key)

Foreign Key: VIEWKEY (VIEW_ Key)

References: ASG.VIEW

Foreign Key: PGMKEY (PGM_Key)

References: ASG.PROGRAM

ASG.VIEWS IN Col 1: VIEWS Key Char(8)
TBLSP

Col 2: TBLSP Key Char(8)
Primary Key: (VIEWS Key, TBLSP Key)

Foreign Key: VIEWSKEY (VIEWS Key)

References: ASG.VIEW

Foreign Key: TBLSPKEY (TBLSP Key)

References: ASG.TABLESPACE
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Exporting to Transition Enablement Facility (TEF)

334

Alliance has optional TEF export feature you can use to export a defined and analyzed
application to Texas Instruments Transition Enablement Facility (TI-TEF).

To export to TEF

1

The application (that is, a group of programs and associated components) is created
and stored in the AKR. The application components and attributes are defined.
Review and edit the defined application online.

For more information on these procedures see the ASG-Application Definition and
Analysis User’s Guide.

The defined application is analyzed. Then, you can review the results of the analyze.

For more information on these procedures see the ASG-Application Definition and
Analysis User’s Guide.

Export the analyzed information (including data model and control flow model)
exported to TEF; a batch job is submitted to build the input for TEF. The information
is exported into three output files (Object, Association, and Properties) that are
suitable for TEF Release 2.0. TEF manipulates this information into a loadable
model format for use in Texas Instruments Composer Release 5.3 (for example, an
Information Engineering Facility product).

These concepts and procedures are described in this section:

TEF objects (see <Superscript>)

Data model (see <Superscript>)

Control flow model (see <Superscript>)

Program control flow analysis (see <Superscript>)

Online export to TEF (see <Superscript>)

For additional information on these terms, see the Texas Instruments TEF and Composer

documentation:

Attribute (ATTRUSR) Entity type (HLENT)
Business system Expected effects

Common action block Function

CRUD Procedure (BUSPROC)
Dialog flow (DLGFLOW) Procedure step (BUSPRST)
Elementary process Subject area (SUBJ)
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When you create TEF objects to represent information in the AKR and the TEF object
has a name property the actual name of the object is used. You may modify the name with
descriptive text, but the name itself is that of the entity found in the AKR and derived
from the application. All other TEF properties are fully populated, except as noted.

Data Model

The TEF Export option provides you with data model information that is based on the
data structures and database activity within programs.

Record Analysis

When CRUD (Create, Read, Update, Delete) activity is identified, TEF objects and
relationships are created to represent local records and database entities involved in
the activity.

TEF objects and relationships are created to represent the CRUD activity itself and
its association to the program.

Any remaining data structures defined to the program are also represented.

The TEF Export option includes detailed information on COBOL programs. A complete
analysis of COBOL records is performed that includes REDEFINES and OCCURS
clauses.

To determine file layout, you apply the buffering analysis to each record involved in
CRUD activity. The buffering analysis is performed when CRUD activity determines that
a TEF entity type should be created for a record.

Buffering analysis checks each record for a single field element. A single field
element can be a single description at the record level, for example, "01 XYZREC
PIC X (132)".Ifthe record has a single field, direct assignments to and from the
record are processed and evaluated. This process continues until a multi-component
record is found or no other direct assignments are found.

TEF objects are created for multi-component records. When multiple TEF entity
types are created for a record, each entity type is linked to the same TEF subject
area. If no multi-component records are found, TEF objects are created for the
original record involved in the CRUD activity.

Exported field information for COBOL records includes this data:

Name

Length (memory size)
Number of decimal places
Domain

Permitted values (VALUE clause)
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Database Entities

The TEF Export option creates a complete representation of DB (database) entities
involved in CRUD activity. These database models are supported:

o IMS (except IMS GSAM DB) « DB2
. CICS . COBOL file operations
« IDMS

CRUD Activity/Expected Effects

IMS
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CRUD activity is generated for all supported DB entities: IMS segments, CICS files,
IDMS records, DB2 tables, and COBOL files.

. All programs encountered cause a function and elementary process TEF object to
be created.

. Only programs with CRUD activity generate expected effects.

. An expected effect is created for each unique DB entity when CRUD activity is
detected within the program.

. Each expected effect is linked to the appropriate function and elementary process
TEF objects.

The database instructions that determine CRUD activity/expected effects are outlined in
these tables for IMS, CICS, IDMS, DB2, and COBOL.:

Database Instruction CRUD Activity
INSERT CREATE

GET READ
REPLACE UPDATE
DELETE DELETE




CICS

IDMS

DB2

Appendix E - Export Language Reference

WRITE CREATE
READ, READNEXT, READPREV READ

REWRITE UPDATE
DELETE DELETE

STORE, MODIFY CREATE
GET, OBTAIN, MODIFY, FIND READ

STORE UPDATE
ERASE DELETE

INSERT CREATE
SELECT, FETCH READ
UPDATE UPDATE

DELETE, DROP DELETE
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COBOL
WRITE CREATE
READ READ
REWRITE UPDATE
DELETE DELETE

ASSEMBLER Language Option

READ READ

PUT CREATE (UPDATE)*
GET READ (UPDATE)*
PUTX CREATE (UPDATE)*
WRITE CREATE (UPDATE)*

*  For these activities, the CREATE attribute is set, unless the open macro indicates that
the CRUD information should be UPDATE instead. The open parameters, indicating
UPDATE instead of CREATE, are INOUT and UPDATE.

Data Model Description

IMS Data Model Within the program, CRUD activity involving IMS entities is
detected. TEF objects are created for both the IMS entities
and local records. Expected effects are generated for the
entity type created for the IMS segment.

CICS Data Model Within the program, CRUD activity involving CICS files is
detected. TEF objects are created for both CICS entities and
local records. Expected effects are generated for entity types
that are created for local records.
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IDMS Data Model Within the program, CRUD activity on IDMS records and
logical records is detected. When logical records are used,
the component records are resolved and used as the actual
record(s) of reference. TEF objects are created for both
IDMS records and local records. Expected effects are
generated for the entity types created for IDMS records or
logical records.

DB2 Data Model Within the program, CRUD activity involving DB2 Tables is
detected. TEF objects are created for both the DB2 entities
and local records. Expected effects are generated for the
entity types created for DB2.

COBOL File Operations  Within the program, CRUD activity involving COBOL file

Data Model operations is detected. TEF objects are created for both the
file and the records. Expected effects are generated for the
entity types created for local records.

Control Flow Model The TEF Export option provides control flow model
information for both batch and online processes. Batch
information is determined by JCL jobs, JCL procedures, and
JCL steps. Online information is determined by transactions
and screens. When analysis reaches the program level,
program control flow is established (see "Program Control
Flow" on page 343).

For each exported application, three business systems are created to represent the control
flow model:

BATCH JOB <application name>. This business system is a representation of the
batch jobs defined in the application.

BATCH PROC <application name>. This Business System is a representation of the
JCL procedures executed by the jobs defined in the application.

ON-LINE <application name>. This Business System is a representation of the IMS,
CICS, and IDMS online activities defined in the application.

Note:
IMS BMP applications fall under the appropriate representation for batch activities.
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Batch Control Flow
Batch control flow starts with each JCL job defined to the application.

To establish Batch control flow

1

From the JCL job, control flow goes to each of the JCL steps. A procedure is created
for the JCL job.

From each JCL step, control flow goes to the executed program or executed JCL
procedure.

. A procedure step is created for the program executed by the JCL step; the
procedure step is associated to the procedure created for the JCL job.

. Appropriate TEF objects are created for the program, as determined by the
program control flow (see "Program Control Flow" on page 343).

. If the step executes a JCL procedure, a dialog flow object is created to the
procedure step that was created for the JCL procedure.

From each JCL procedure, the control flow goes to each step within the procedure.
A procedure and procedure step are created for the JCL procedure.

From each procedure step, the control flow goes to the executed program or executed
JCL procedure. Control flow at the program level is covered in Program Control
Flow. The steps within the JCL procedure are processed in the same manner as steps
for a JCL job, except that the procedure steps created are associated to the procedure
created for the JCL procedure.

This process is repeated until all control flow paths are represented.

Online Control Flow
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Online control flow starts with either transactions or screens. TEF objects are created to
represent the physical screen display.

To establish online control flow

1

2

From a transaction, control flow goes to the executed program.
From a screen, control flow goes to other screens and to transactions.

From a program, control flow goes to transactions and screens invoked by the
program (see "Program Control Flow" on page 343).
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Screens Supported
These are the screens supported by the TEF Export option:

. BMS maps (CICS)
. IMS formats
. IDMS maps

For all screens (except IDMS Maps), information on the physical display attributes of the
fields is generated. This field information is supplied in TEF Screen Literal objects. It

includes:
. Row . Color
. Column . Intensity
. Literal value (if any) . Highlight

. Field length

Invoking a Screen From Multiple Programs

When a screen is invoked by a program, a procedure step (TEF object) is created to
represent the screen. The procedure step is linked to the procedure that contains the
invoking entity.

* A procedure step can be linked to only one procedure.
. If the screen is used by more than one procedure:
—  One procedure and one procedure step are created for the screen.

—  All procedures using the screen have dialog flows created from their
respective procedure steps to the procedure step created for the screen.

. This information applies to these subsections:
—  IMS online control flow
—  CICS online control flow

—  IDMS online control flow

IMS Online Control Flow

IMS formats are referenced generically within programs, but can have multiple device
definitions (with multiple pages) for each device. Because of the multiple device
definitions with multiple pages, a series of procedure steps are created for each IMS
format.
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To format IMS online control flow

1

IMS Control Flow

Each MOD (Message Output Description) within the format is represented by a
procedure and procedure step. The procedure step created for the MOD is the origin
or destination for all control flows represented by dialog flows.

Within the MOD definitions, each DOF (Device Output Format) is searched for
device definitions.

A procedure step represents each page within the device definitions. The DFLD
(Defined Field) definitions within the device definition are used to create the screen
literal information.

Pages are associated to the procedure created for the MOD. Each device/page is
given a name in this format:

<device> "PAGE" <page number>

IMS control flow is controlled by the formats and transactions defined to the application.
Control flow is generated on these relationships:

Note:

IMS-FORMAT EXECUTES IMS-TRANSACTION
IMS-FORMAT EXECUTES IMS-FORMAT
IMS-TRANSACTION (relationship) PROGRAM
PROGRAM EXECUTES IMS-FORMAT

PROGRAM EXECUTES IMS TRANSACTION

The (relationship) in the AKR is:
IMS-TRANSACTION EXECUTES LOADMODULE
LOADMODULE HAS CSECT

CSECT IS PROGRAM
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IMS transactions and formats (as listed above) are represented by procedures.

The program executed by the IMS transaction becomes the procedure step for the
transaction (except in cases explained in Program Control Flow).

The relationships listed above and the program control flow analysis are used to
establish links between procedure steps.
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CICS Online Control Flow

CICS online control flow is based on BMS map invocation, transaction execution on the
program level, and on the transactions defined to the application.

. Each transaction is represented by a procedure.
. The program executed by the transaction:
—  Becomes the procedure step, unless it invokes a BMS map.

—  Ifthe program executed invokes a BMS map, the BMS map is represented
by a procedure step and the program is represented by a Common Action
Block.

. A CALLs association is established to link the procedure step for the BMS map to
the Common Action Block for the program.

Program control flow is followed to establish links between procedure steps.

IDMS Online Control Flow

IDMS online control flow is based solely on IDMS map invocation.

. Program control flow, if transferred to other programs using the IDMS map, creates
a dialog flow object.

. The dialog flow object links the procedure steps created for the IDMS map.

Program Control Flow

When any form of control flow (that is, batch or online) reaches a program, detailed
external control flow analysis of the program is represented by TEF objects and
relationships. Control flow from the program to screens, transactions, and other programs
is established.

TEF Objects Created for Programs

Depending on the activity of the program represented, the TEF object created may be a
procedure, procedure step, or Common Action Block.

Procedure Step and Procedure

. Procedure steps are always created for programs that contain these activities:
PROGRAM EXECUTES CICS-TRANSACTION
PROGRAM EXECUTES IMS-TRANSACTION

PROGRAM EXECUTES IMS-FORMAT
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. Procedure steps are always created for programs that are the zarget of these
activities.

CICS-TRANSACTION EXECUTES PROGRAM
IMS-TRANSACTION (EXECUTES) PROGRAM
JCL STEP (EXECUTES) PROGRAM

Note:

The (EXECUTES) relationship in the AKR is:
<ENTITY> EXECUTES LOADMODULE
LOADMODULE HAS CSECT

CSECT IS PROGRAM

. The procedure step created is linked to the procedure that initiated the control flow
path to the program, unless more than one control flow path reaches the program.

. If more than one control flow path reaches the program, a procedure is also created
for the program.

—  The procedure step created for the program is associated to the procedure
created for the program.

— Dialog flow is established from the procedure steps, in all invoking
control flow paths, to the procedure step created for the program.

Common Action Block

All other known program activities (including batch execution) create a Common Action
Block to represent the program. Invoking TEF objects have a CALLSs association to the
Common Action Block created for the program.

Procedure Step Links

You can execute several programs from a procedure step object before another procedure
step object is encountered.

. Each intermediate program is represented by a Common Action Block with CALLs
association to subsequent programs.

. When a procedure step object is encountered, a dialog flow is created from the
encountered procedure step to the procedure step of origin.
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Program Control Flow Path

These control flow paths are evaluated with program control flow analysis:

PROGRAM EXECUTES IMS-TRANSACTION IDMS DC RETURN
PROGRAM EXECUTES CICS-TRANSACTION IDMS TRANSFER CONTROL

EXEC CICS XCTL BMS MAP INVOCATION
EXEC CICS LINK IDMS MAP INVOCATION
COBOL CALL PROGRAM EXECUTES IMS-FORMAT

Online TEF Export Procedure

To export application data to TEF

1

2

Start Alliance using the procedure defined for your site.

Select File » Open application and press Enter. The AMF panel displays as the
default.

Select File » Export application and press Enter.

Select File - Export Definition pop-up » Export Data and press Enter. The
Data Export pop-up (see Figure 93) displays.

Figure 93 » Data Export Pop-up

Data EMport
CoHHand ===

Ipecify options and jobcard information. Then press PF ke for action.

WARNING! =electing "Edit JCL" oF "SubHit JOL" wWill delete any edisting
export files created under this userid.

Export Twpe __ 1. Flat Files DE2 Subsysted: ____
DEZ Load
Z. COOLIGen Ewport

Job staterent infordation:

~~NAAE JOE [ACCOUNT ], NAHE,

o HEGCLASE=A

“~t  INZERT *'-#ROUTE PRINT WODE.UZER® HERE IF MWEEDED.
ok

PFA4=COOLIGen Export Options PFS=E4it JCL  PFE=:ubmit JCL

In the Export Type field of the Data Export pop-up, type 3 to select TI-Export.
Under Job statement information, enter the information required for your site.

To edit the generated JCL file before submitting the export job, press the Edit JCL
key.
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8  Add export parameters to the parm string specified for the extract step, as required
(Exec Pgm = VIABTIEF). For a definition of the available export parameters, see
"TEF Export Parameters" on page 346. Add these parameters after the existing
application parameter. Include export parameters in any order, as shown:

PARM= ('APPL=<application
name>, NOWORKSET, NOPERMVAL, NOBSD, LEN254 ")

9  After editing the JCL, submit the job using the TSO/ISPF SUBMIT command.

10 To execute the export request without editing the generated JCL, press the Submit
JCL key.

Note:
If an unresolvable entity is detected during the export, a message is sent to the VIALOG
file. You should review the VIALOG file after each export to identify any entities not
represented with corresponding TEF objects.

TEF Export Parameters

Add these TEF export parameters to the parm string specified for extract step
(Exec Pgm = VIABTIEF):

Parameter Description

NOWORKSET Suppresses the generation of data model information,
SUBJECT, HLENT, ATTRIBUTE, etc., for records that are
not involved in CRUD activity.

NOPERMVAL Suppresses the generation of the permitted values property for
attributes.
NOBSD Suppresses the generation of the control flow model

information, such as Business System Design (BSD).

LEN254 Specifies a maximum length of 254 bytes, for any textual field
in the model.
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